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Preface

How to Use This Guide

About the System  The guides listed below are shipped with the Applied Biosystems 7500 and 7500 Fast

Documentation

Real-Time PCR Systems.

Guide Purpose and Audience PN
Applied Biosystems 7500/7500 Fast Real- | Explains how to perform experiments on the 7500/7500 Fast 4387784
Time PCR System Getting Started Guide system. Each Getting Started Guide functions as both a:
for Genotyping Experiments e Tutorial, using example experiment data provided with the
; : Applied Biosystems 7500/7500 Fast Real-Time PCR
Applied Biosystems 7500/7500 Fast Real- 4387785
Time PCR System Getting Started Guide Software (7500/7500 Fast‘ software).
for Presence/Absence Experiments ¢ Guide for your own experiments.
. . Intended for laboratory staff and principal investigators who
Applied Biosystems 7500/7500 Fast Real- . - 4387783
Time PCR System Getting Started Guide perform experiments using the 7500/7500 Fast system.
for Relative Standard Curve and
Comparative C; Experiments
Applied Biosystems 7500/7500 Fast Real- 4387779
Time PCR System Getting Started Guide
for Standard Curve Experiments
Applied Biosystems 7500/7500 Fast Real- | Explains how to install and maintain the 7500/7500 Fast system. | 4387777
Time PCR System Maintenance Guide Intended for laboratory staff responsible for the installation and
Applied Biosystems 7500/7500 Fast Real- | Maintenance of the 7500/7500 Fast system. 4387778
Time PCR System Installation Quick
Reference Card
Real Time PCR System Reagent Guide Provides information about the reagents you can use on the 4387787
7500/7500 Fast system, including:
¢ An introduction to TagMan® and SYBR® Green reagents.
¢ Descriptions and design guidelines for the following
experiment types:
— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who
perform experiments using the 7500/7500 Fast system.
Applied Biosystems 7500/7500 Fast Real- | Explains how to prepare your site to receive and install the 4387776

Time PCR System Site Preparation Guide

7500/7500 Fast system.

Intended for personnel who schedule, manage, and perform the
tasks required to prepare your site for installation of the
7500/7500 Fast system.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve

and Comparative C; Experiments
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Preface
How to Use This Guide

Guide Purpose and Audience PN

Applied Biosystems 7500/7500 Fast Real- | Explains how to use the 7500/7500 Fast software to: NA

Time PCR Software v2.0 Help e Set up, run, and analyze experiments using the 7500/7500

Fast system.
e Calibrate a 7500/7500 Fast instrument.

¢ Verify the performance of a 7500/7500 Fast instrument with
an RNase P run.

Intended for:

* Laboratory staff and principal investigators who perform
experiments using the 7500/7500 Fast system.

e Laboratory staff responsible for the installation and
maintenance of the 7500/7500 Fast system.

Assumptions This guide assumes that you:
+ Are familiar with the Microsoft Windows® XP operating system.
* Are familiar with the Internet and Internet browsers.
* Know how to handle DNA and/or RNA samples and prepare them for PCR.
» Understand data storage, file transfer, and copying and pasting.

» Have networking experience, if you plan to integrate the 7500/7500 Fast system into
your existing laboratory data flow.

Text Conventions  This guide uses the following conventions:
* Bold text indicates user action. For example:
Enter 0, then press Enter for each of the remaining fields.
* [talic text indicates new or important words and is also used for emphasis. For example:
Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down list or shortcut menu. For example:

Select File » Open.

User Attention  Two user attention words appear in Applied Biosystems user documentation. Each word
Words implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate reagent kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection, you need a valid user ID.

viii Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments
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How to Obtain More Information

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words  Alert Words” on page xii.

How to Obtain More Information

Related Documents Related to Genotyping Experiments
Documentation

Document PN

Allelic Discrimination Pre-Developed TagMan® Assay Reagents Quick Reference 4312212

Card

Custom TagMan® Genomic Assays Protocol Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204

Performing a Custom TagMan® SNP Genotyping Assay for 96-Well Plates Quick 4371394
Reference Card

Performing a TagMan® Drug Metabolism Genotyping Assay for 96-Well Plates 4367636
Quick Reference Card

Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
TagMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® SNP Genotyping Assays Protocol 4332856

Documents Related to Presence/Absence Experiments

Document PN
DNA Isolation from Fresh and Frozen Blood, Tissue Culture Cells, and Buccal 4343586
Swabs Protocol
NucPrep® Chemistry: Isolation of Genomic DNA from Animal and Plant Tissue 4333959
Protocol

Documents Related to Relative Standard Curve and Comparative C; Experiments

Document PN
Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05
Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve ix

and Comparative C; Experiments
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How to Obtain More Information

Documents Related to Standard Curve Experiments

Document PN

Amplification Efficiency of TagMan® Gene Expression Assays Application Note 127AP05

Custom TagMan® Gene Expression Assays Protocol 4334429
Primer Express® Software Version 3.0 Getting Started Guide 4362460
TagMan® Gene Expression Assays Protocol 4333458
User Bulletin #2: Relative Quantitation of Gene Expression 4303859

Documents Related to the Reagent Guide

Document PN

Applied Biosystems High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
Custom TagMan® Gene Expression Assays Protocol 4334429
Custom TaqgMan® Genomic Assays Protocol: Submission Guidelines 4367671
Custom TagMan® SNP Genotyping Assays Protocol 4334431
Power SYBR® Green PCR Master Mix and RT-PCR Protocol 4367218
Pre-Developed TagMan® Assay Reagents Allelic Discrimination Protocol 4312214
Primer Express® Software Version 3.0 Getting Started Guide 4362460
SYBR® Green PCR and RT-PCR Reagents Protocol 4304965
SYBR® Green PCR Master Mix and RT-PCR Reagents Protocol 4310251
TaqMan® Drug Metabolism Genotyping Assays Protocol 4362038
TagMan® Exogenous Internal Positive Control Reagents Protocol 4308335
TagMan® Fast Universal PCR Master Mix (2.X) Protocol 4351891
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® Genotyping Master Mix Protocol 4371131
TagMan® SNP Genotyping Assays Protocol 4332856
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous Control 127AP08
for Experimental Studies Application Note

Note: For more documentation, see “How to Obtain Support” on page xi.

X Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments
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Preface
How to Obtain Support

The 7500 Software Help describes how to use each feature of the touchscreen. Open the
Help from within the software by doing one of the following:

¢ Press F1.
e Click @ in the toolbar.
» Select Help » 7500 Software Help.

To find topics of interest in the Help:
» Review the table of contents.
» Search for a specific topic.

» Search the alphabetized index.

Applied Biosystems welcomes your comments and suggestions for improving its user
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to http://www.appliedbiosystems.com, then click the
link for Support. (See “How to Obtain Support” on page xi).

How to Obtain Support

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click the link for Support.
At the Support page, you can:

» Search through frequently asked questions (FAQs).

* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents.

* Download PDF documents.
* Obtain information about customer training.
+ Download software updates and patches.

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.

IMPORTANT! When directed to do so by this guide, or when you need to schedule
maintenance for your 7500/7500 Fast instrument (such as annual planned maintenance
or temperature verification/calibration), contact the Applied Biosystems Care Center. To
obtain a phone number for or to send an e-mail to the center, go to
http://www.appliedbiosystems.com/support/contact.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve Xi
and Comparative C; Experiments



Preface

Safety Conventions Used in This Document

Safety Conventions Used in This Document

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—-IMPORTANT, CAUTION, WARNING, DANGER-implies a particular level of
observation or action, as defined below.

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

A (O.\I[e]\] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

A \WLGIINed — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A prNeldi] — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is to be limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard icons that are affixed to Applied Biosystems
instruments (see “Safety Symbols” on page xiii).

Examples

The following examples show the use of safety alert words:

IMPORTANT! Wear powder-free gloves when you handle the halogen lamp.

A (\I{el] The lamp is extremely hot. Do not touch the lamp until it has cooled to

room temperature.

A WWLGNINe] CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor.

Exposure causes eye, skin, and respiratory tract irritation and may cause central nervous
system depression and liver damage. Read the MSDS, and follow the handling instructions.
Wear appropriate protective eyewear, clothing, and gloves.

A PL\[e]13:] ELECTRICAL HAZARD. Failure to ground the instrument properly

can lead to an electrical shock. Ground the instrument according to the provided instructions.

Xii Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
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Symbols on Instruments

Symbols on Instruments

Electrical
Symbols on
Instruments

Safety Symbols

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve

The following table describes the electrical symbols that may be displayed on
Applied Biosystems instruments.

Symbol Description Symbol Description
Indicates the On position of the I Indicates a terminal that may be
main power switch. — connected to the signal ground

reference of another instrument.
This is not a protected ground
terminal.

main power switch. terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.

Indicates the Off position of the @ Indicates a protective grounding

C O

Indicates a standby switch by Indicates a terminal that can
which the instrument is switched receive or supply alternating
on to the Standby condition. current or voltage.
Hazardous voltage may be
present if this switch is on
standby.

S

Indicates the On/Off position of a pr— Indicates a terminal that can
push-push main power switch. L receive or supply alternating or
direct current or voltage.

The following table describes the safety symbols that may be displayed on

Applied Biosystems instruments. Each symbol may appear by itself or in combination
with text that explains the relevant hazard (see “Safety Labels on Instruments” on
page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in the text of this and other product-support documents.

Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and
to proceed with appropriate caution.

> BB

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

and Comparative C; Experiments
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Safety Labels on Instruments

Environmental
Symbols on
Instruments

The following symbol applies to all Applied Biosystems electrical and electronic
products placed on the European market after August 13, 2005.

Symbol Description
Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
== environmental impact of waste electrical and electronic equipment (WEEE).
\ 7 I European Union customers:
Call your local Applied Biosystems Customer Service office for equipment
—@ pick-up and recycling. See http://www.appliedbiosystems.com for a list of
customer service offices in the European Union.
[

Safety Labels on Instruments

Xiv

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the

preceding section.

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Sheets (MSDSs) before
handling.

ATTENTION Produits chimiques dangeureux.
Lire les fiches techniques de sreté de
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Refer to
MSDS(s) and local regulations for handling
and disposal.

ATTENTION Déchets dangereux. Lire les
fiches techniques de sireté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

WARNING Hot lamp.

AVERTISSEMENT Lampe brilante.

WARNING Hot. Replace lamp with an
Applied Biosystems lamp.

CAUTION Hot surface.

AVERTISSEMENT Composants br(lants.
Remplacer la lampe par une lampe
Applied Biosystems.

ATTENTION Surface brilante.

DANGER High voltage.

DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.
Refer servicing to Applied Biosystems
qualified service personnel.

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts.

ATTENTION Parties mobiles.

WARNING This instrument is designed for
12V, 75 W Halogen lamps only.

AVERTISSEMENT Cet instrument est congu
pour des lampes d'halogene de 12 Vet 75 W
seulement.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
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Safety Labels on Instruments

Locations of The Applied Biosystems 7500/7500 Fast Real-Time PCR System contains warnings at
Warnings the locations shown below.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve XV
and Comparative Cy Experiments
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General Instrument Safety

General Instrument Safety

AWARNING PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and A (.\I[e){] PHYSICAL INJURY HAZARD. The instrument is to be moved

Lifting the and positioned only by the personnel or vendor specified in the applicable site
Instrument  preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

Moving and AWARNING Do not attempt to lift or move the computer or the monitor without

Lifting Stand-  the assistance of others. Depending on the weight of the computer and/or the monitor,
Alone Computers moving them may require two or more people.
and Monitors

Things to consider before lifting the computer and/or the monitor:
» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

» Keep your spine in a good neutral position while lifting with your legs.

» Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the Ensure that anyone who operates the instrument has:

Instrument * Received instructions in both general safety practices for laboratories and specific

safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xvii.

AWARNING PHYSICAL INJURY HAZARD. Use this instrument as specified

by Applied Biosystems. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Cleaning or A (oZ\{o]\] Before using a cleaning or decontamination method other than those

Decontaminating recommended by the manufacturer, verify with the manufacturer that the proposed
the Instrument  method will not damage the equipment.

XVi Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments
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Chemical Safety

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

A LGN el CHEMICAL HAZARD. All chemicals in the instrument, including

liquid in the lines, are potentially hazardous. Always determine what chemicals have
been used in the instrument before changing reagents or instrument components. Wear
appropriate eyewear, protective clothing, and gloves when working on the instrument.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining MSDSs The MSDS for any chemical supplied by Applied Biosystems is available to you free
24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:
* Open — To view the document
* Print Target — To print the document
» Save Target As — To download a PDF version of the document to a destination
that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve xvii
and Comparative C; Experiments
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Chemical Safety

Chemical Safety = To minimize the hazards of chemicals:

Xviii

Guidelines .

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xvii.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended on the MSDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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Chemical Waste Safety

Chemical Waste A (X1[e]f] HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a

glass container because of the risk of breaking or shattering. Reagent and waste bottles can
crack and leak. Each waste bottle should be secured in a low-density polyethylene safety
container with the cover fastened and the handles locked in the upright position. Wear
appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines * Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

* Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Handle chemical wastes in a fume hood.
» After emptying the waste container, seal it with the cap provided.

+ Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

* Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

* Ensure the health and safety of all personnel in your laboratory.

* Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.
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Electrical Safety

Fuses

Power

Overvoltage
Rating

A PEW[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the Applied Biosystems 7500/7500 Fast Real-Time PCR System
without its instrument panels in place. Do not remove instrument panels. High-voltage
contacts are exposed when instrument panels are removed from the instrument.

AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

A pW[el33] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A pNel3i] ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

A PLW[e]33] ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

The Applied Biosystems 7500/7500 Fast Real-Time PCR System has an installation
(overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts

XX

éWARNING PHYSICAL INJURY HAZARD. Moving parts can crush and cut.

Keep hands clear of moving parts while operating the instrument. Disconnect power
before servicing the instrument.
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Biological Hazard Safety

General
Biohazard

&WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
conducted in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
bmbl.od.nih.gov).

* Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR
§1910.1030; www.access.gpo.gov/nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

A (o7 1[o)\] MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and
Canadian Safety
Standards

c(UL)us

Canadian EMC
Standard

European Safety
and EMC
Standards

C€

Australian EMC
Standards

C

XXii

This section provides information on:
* U.S. and Canadian Safety Standards
* Canadian EMC Standard
* European Safety and EMC Standards
* Australian EMC Standards

This instrument has been tested to and complies with standard UL 61010A-1, “Safety
Requirements for Electrical Equipment for Laboratory Use, Part 1: General
Requirements” and with standard UL 61010-2-010, “Particular Requirements for
Laboratory Equipment for the Heating of Materials.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use,
Part 1: General Requirements.”

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial,
Scientific, and Medical Radio Frequency Generators.

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards EN 61010-
1:2001, “Safety Requirements for Electrical Equipment for Measurement, Control and
Laboratory Use, Part 1: General Requirements” and EN 61010-2-010, “Particular
Requirements for Laboratory Equipment for the Heating of Materials,” and with
standard EN 61010-2-081:2002+A1:2003 “Particular Requirements for Automatic and
Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits
and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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n Get Started

This chapter covers:

B About the 7500/7500 Fast System . ............. ... 2
B Supported Consumables . . ........... it 4
B About Relative Standard Curve and Comparative C; Experiments............. 7
B HowtoUseThisGuide. . ... ... ... 12
B About the Example Experiments . ............ .. .. .. . ... 14
B Example Experiment Workflow . ........ ... .. ... ... .. ... ... ... .. ... ... 17

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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About the 7500/7500 Fast System

The Applied Biosystems 7500/7500 Fast Real-Time PCR System is a 96-well, five-color
platform that uses fluorescence-based polymerase chain reaction (PCR) reagents to provide:
* Quantitative detection of nucleic acid sequences using real-time analysis.

* Qualitative detection of nucleic acid sequences using end-point and dissociation-
curve analysis.

The Applied Biosystems 7500 Fast Real-Time PCR System enables you to perform
high-speed thermal cycling with run times for quantitative real-time PCR applications
(such as relative quantitation) of fewer than 40 minutes.

About Data The 7500/7500 Fast system collects raw fluorescence data at different points during a
Collection PCR, depending on the type of run that the instrument performs:

Run Type Data Collection Point
Real-time Standard curve The instrument collects data after each extension step of
runs | the PCR.
Relative standard
curve

Comparative Cy

(AAGy)
Post-PCR | Genotyping The instrument collects data:
ﬁr:gpomt) Presence/absence | ° Before the PCR. (For presence/absence experiments,

data collection before the PCR is optional but
recommended.)

e (Optional) During the PCR. The instrument can collect
data during the run (real-time); collecting data during
the run can be helpful for troubleshooting.

e After the PCR.

Regardless of the run type, a data collection point or read on the 7500/7500 Fast
instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate within the
instrument, exciting the fluorophores in each reaction.

2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image collected by the device consists only
of light that corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval. The 7500 software stores the raw
fluorescence image for analysis.

After a run, the 7500 software uses region of interest (ROI), optical, dye, and background
calibrations to determine the location and intensity of the fluorescence in each read, the
dye associated with each fluorescent signal, and the significance of the signals.

Notes
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About the 7500/7500 Fast System

About the Filters The 7500/7500 Fast system uses the following filters:

Filter 1 2 3 4 S
e FAM™ dye e JOE™dye ¢ TAMRA™dye | ® ROX™dye | Cy5®dye
Dye e SYBR®Green | o VIC®dye | e NED"dye ¢ Texas Red®
dye e Cy3®dye dye

For More For information on:

Information * The 7500/7500 Fast system — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR Software Help.

Note: To open the Help, select Help » 7500 Software Help in the 7500 software.

* Genotyping experiments — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Genotyping Experiments.

* Presence/absence experiments — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Presence/Absence Experiments.

» Standard curve experiments — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Standard Curve and Experiments.

Notes
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Supported Consumables

7500 System  The 7500 system supports the consumables listed below.

Consumable Part Number
¢ MicroAmp® Optical 96-Well Reaction Plate with Barcode, 0.2-mL e 4306737
e MicroAmp™ Optical Adhesive Film e 4311971
¢ MicroAmp™ Optical 8-Tube Strip, 0.2-mL * 4316567
¢ MicroAmp™ Optical 8-Cap Strip e 4323032
¢ MicroAmp® Optical Tube without Cap, 0.2-mL e N8010933
¢ MicroAmp® Reaction Tube with Cap, 0.2-mL ¢ N8010540
¢ Microamp® Splash Free Support Base e N8010531
e MicroAmp™ Adhesive Film Applicator e 4333183
¢ MicroAmp® Cap Installing Tool (Handle) e 4330015
¢ MicroAmp™ Multi-Removal Tool e 4313950

# Consumable # Consumable

A | MicroAmp® Optical 96-Well Reaction Plate, E | MicroAmp™ Optical 8-Tube Strip
0.2-mL
Microamp® Splash Free Support Base F | MicroAmp® Optical Tube without Cap

C | MicroAmp™ Optical 8-Cap Strip, 0.2-mL G | MicroAmp™ Optical Adhesive Film
MicroAmp® Reaction Tube with Cap, 0.2-mL

Notes
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Supported Consumables

7500 Fast System  The 7500 Fast system supports the consumables listed below.

IMPORTANT! Use only Fast consumables (reaction plates, tube strips, and tubes) with
the 7500 Fast system, even when performing an experiment with standard reagents.

Consumable Part Number
¢ MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1-mL e 4346906
¢ MicroAmp™ Optical Adhesive Film e 4311971
e MicroAmp™ Fast 8-Tube Strip, 0.1-mL e 4358293
e MicroAmp™ Optical 8-Cap Strip e 4323032
¢ Microamp® Splash Free Support Base e N8010531
¢ MicroAmp™ Adhesive Film Applicator e 4333183
e MicroAmp® Cap Installing Tool (Handle) e 4330015
¢ MicroAmp™ Multi-Removal Tool e 4313950

# Consumable
A | MicroAmp™ Fast Optical 96-Well Reaction Plate, 0.1-mL
B | Microamp® Splash Free Support Base
C | MicroAmp™ Optical 8-Cap Strip
| D | MicroAmp™ Fast 8-Tube Strip
E | MicroAmp™ Optical Adhesive Film

Notes
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Standard versus Make sure that you use the correct reaction plate for your system:
Fast Reaction
Plates and Tubes System Reaction Plate

7500 system e MicroAmp® Optical 96-Well Reaction Plate (PN 4306737, also called
standard reaction plates)

¢ MicroAmp® Optical Tubes without Caps, 0.2-mL (PN N8010933, also
called standard reaction tubes)

¢ MicroAmp® Reaction Tubes with Caps, 0.2-mL (PN N2070540)
e MicroAmp™ Optical 8-Tube Strip, 0.2-mL (PN 4316567, also called
standard reaction tube strips)

IMPORTANT! Fast reaction plates and tubes do not fit into the standard
sample block correctly and will result in loss of data.

7500 Fast e MicroAmp™ Fast Optical 96-Well Reaction Plate, (PN 43469086, also called

system Fast reaction plates)

¢ MicroAmp™ Fast 8-Tube Strip, 0.1-mL (PN 4358293, also called Fast
reaction tube strips)

IMPORTANT! Standard reaction plates and tube strips will not function
properly and might be crushed when using the Fast sample block.

Fast Reaction Plates Standard Reaction Plates
(PN 4346906) (PN 4306737)

‘— Notch at top-right
i corner by A12

A1

Notch at—
top-left
corner
by A1
80-uL — [T T T 100-pL
maximum (AT R WA T WA T PN T Jodu Y maximum
reaction reaction
volume volume
Notes
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About Relative Standard Curve and Comparative C; Experiments

Real-Time PCR Relative standard curve and comparative C (AAC;) experiments are real-time PCR
Experiments experiments. In real-time PCR experiments:

* The instrument monitors the progress of the PCR as it occurs.
» Data are collected throughout the PCR process.

» Reactions are characterized by the point in time during cycling when amplification
of a target is first detected.

Note: In this guide, the term experiment refers to the entire process of performing a run
using the 7500/7500 Fast system, including setup, run, and analysis.

About Relative The relative standard curve method is used to determine relative target quantity in samples.
Standard Curve  With the relative standard curve method, the 7500 software measures amplification of the
Experiments target and of the endogenous control in samples, in a reference sample, and in a standard
dilution series. Measurements are normalized using the endogenous control. Data from the
standard dilution series are used to generate the standard curve. Using the standard curve,
the software interpolates target quantity in the samples and in the reference sample. The
software determines the relative quantity of target in each sample by comparing target
quantity in each sample to target quantity in the reference sample.

Relative standard curve experiments are commonly used to:
» Compare expression levels of a gene in different tissues.

* Compare expression levels of a gene in a treated sample vs. an untreated sample.
» Compare expression levels of wild-type alleles with those of mutated alleles.

Components

The following components are required when setting up PCR reactions for relative
standard curve experiments:

* Sample — The sample in which the quantity of the target is unknown.

* Reference sample — The sample used as the basis for relative quantitation results.
For example, in a study of drug effects on gene expression, an untreated control
would be an appropriate reference sample. Also called calibrator.

» Standard — A sample that contains known standard quantities; used in quantitation
experiments to generate standard curves.

+ Standard dilution series — A set of standards containing a range of known
quantities. The standard dilution series is prepared by serially diluting standards.

* Endogenous control — A target or gene that should be expressed at similar levels in
all samples you are testing. The endogenous control is used to normalize
fluorescence for the target you are quantifying. Housekeeping genes can be used as
endogenous controls.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

Notes
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About

Comparative Ct

Notes

Experiments

* Negative Controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.

The comparative C; (AACt) method is used to determine the relative target quantity in
samples. With the comparative C; method, the 7500 software measures amplification of
the target and of the endogenous control in samples and in a reference sample.
Measurements are normalized using the endogenous control. The software determines
the relative quantity of target in each sample by comparing normalized target quantity in
each sample to normalized target quantity in the reference sample.

Comparative C experiments are commonly used to:
» Compare expression levels of a gene in different tissues.

» Compare expression levels of a gene in a treated sample vs. an untreated sample.

* Compare expression levels of wild-type alleles with those of mutated alleles.

Components

The following components are required when setting up PCR reactions for comparative
C experiments:

* Sample — The sample in which the quantity of the target is unknown.

* Reference sample — The sample used as the basis for relative quantitation results.
For example, in a study of drug effects on gene expression, an untreated control
would be an appropriate reference sample. Also called calibrator.

* Endogenous control — A target or gene that should be expressed at similar levels in
all samples you are testing. The endogenous control is used to normalize
fluorescence for the target you are quantifying. Housekeeping genes can be used as
endogenous controls.

* Replicates — The total number of identical reactions containing identical samples,
components, and volumes.

* Negative Controls — Wells that contain water or buffer instead of sample template.
No amplification of the target should occur in negative control wells.
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About Relative Standard Curve and Comparative C Experiments

Relative Standard Consider the following when choosing between relative standard curve and comparative

Curve vs.
Comparative C;
Experiments

Description

C experiments:

Comparative Cy (AACy)
Experiment

Uses arithmetic formulas to determine
the change in expression of a target in a
sample relative to the same target in a
reference sample. Best for high-
throughput measurements of relative
gene expression of many genes in many
samples.

Relative Standard Curve
Experiment

Uses a standard curve to determine the
change in expression of a target in a
sample relative to the same target in a
reference sample. Best for assays that
have suboptimal PCR efficiency.

Advantage

¢ Relative levels of target in samples
can be determined without the use
of a standard curve, if the PCR
efficiencies of the target and
endogenous control are relatively
equivalent.

¢ Reduced reagent usage.

e More space available in the reaction
plate.

Requires the least amount of validation
because the PCR efficiencies of the
target and endogenous control do not
need to be equivalent.

Limitation

e Suboptimal (low PCR efficiency)
assays may produce inaccurate
results.

¢ Before you use the comparative C;
method, Applied Biosystems
recommends that you determine that
the PCR efficiencies for the target
assay and the endogenous control
assay are approximately equal.

A standard curve must be constructed
for each target, which requires more
reagents and more space in the
reaction plate.

Notes
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PCR Options When performing real-time PCR, choose between:

Notes

10

» Singleplex and multiplex PCR (below)
and
* l-step and 2-step RT-PCR (below)

Singleplex vs. Multiplex PCR

You can perform a PCR reaction using either:

 Singleplex PCR — In singleplex PCR, a single primer set is present in the reaction
tube or well. Only one target or endogenous control can be amplified per reaction.

or

* Multiplex PCR — In multiplex PCR, two or more primer sets are present in the
reaction tube or well. Each set amplifies a specific target or endogenous control.
Typically, a probe labeled with FAM™ dye detects the target and a probe labeled
with VIC® dye detects the endogenous control.

IMPORTANT! SYBR® Green reagents cannot be used for multiplex PCR.

u O nm [ Target Primer Set
=
N 3 ©o (O Endogenous Control
T Primer Set
. ~~ cDNA
Singleplex PCR Multiplex PCR

1- vs. 2-Step RT-PCR

You can perform reverse transcription (RT) and PCR in a single reaction (1-step) or in
separate reactions (2-step). The reagent configuration you use depends on whether you
are performing 1- or 2-step RT-PCR:

* In 1-step RT-PCR, RT and PCR take place in one buffer system, which provides the
convenience of a single-tube preparation for RT and PCR amplification. However,
you cannot use Fast PCR Master Mix or the carryover prevention enzyme,
AmpErase® UNG (uracil-N-glycosylase), to perform 1-step RT-PCR.

» 2-step RT-PCR is performed in two separate reactions: First, total RNA is reverse-
transcribed into cDNA, then the cDNA is amplified by PCR. This method is useful
for detecting multiple transcripts from a single cDNA template or for storing cDNA
aliquots for later use. The AmpErase® UNG enzyme can be used to prevent
carryover contamination.

Note: For more information on AmpErase® UNG, refer to the Real Time PCR System
Reagent Guide.
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Supported TagMan® and SYBR® Green Reagents
Reagents Applied Biosystems offers TagMan® and SYBR® Green reagents for use on the
7500/7500 Fast system. Both reagent types are briefly described in the table below.
Note: If you use TagMan® or SYBR® Green reagents, the 7500 software automatically
calculates reaction volumes in the Reaction Setup screen.
Reagent Type Process
TagMan® reagents or kits PCR and Detection of cDNA
Description a. Assay Components .
WC
TagMan reagents use a fluorogenic probe to enable o O e ittt

detection of a specific PCR product as it accumulates
during PCR cycles.
Advantages

¢ Increased specificity with the addition of a
fluorogenic probe.
¢ Provides multiplex capability.

e Preformulated assays, optimized to run under
universal thermal cycling conditions, are available.

¢ Can be used for either 1- or 2-step RT-PCR.

Limitations

CDNA Template

3

b. Denatured Template and Annealing of Assay Components

s N
Reverse primer

T

Forward primer \

T LU R R R
e
Probe /7
CHrrmrrrrr—

3

, , |
Requires synthesis of a unique fluorogenic probe. o Sonal Generaton .
| TR TR TR
Ay Revarsopimer
. Forvard prmer 7@"%* - ucs
T L Ao e
3 5'
LEGEND
b FAM™ dye (mes 'E‘;"Iin“ge'er‘m === Probe Template

@ auencher

AmpliTag Gold®

DNA Polymerase Extended Primer

im==== Primer

SYBR® Green reagents
Description

SYBR Green reagents use SYBR® Green | dye, a
double-stranded DNA binding dye, to detect PCR

analysis.

Step 1: Reaction setup
The SYBR® Green | dye
fluoresces when bound to
double-stranded DNA.

. ® ) Step 2: Denaturation
products as they accumulate during PCR cycles. ® o When the DNA is denatured into
Advantages single-stranded DNA, the
) SYBR® Green | dye is released and
e Economical (no probe needed). the fluorescence is drastically reduced.
¢ Allows for melt curve analysis to measure the Tm s o Step 3: Polymerization
of all PCR pl’OdUCtS. -@- During extension, primers
¢ Can be used for either 1- or 2-step RT-PCR. d ® anneal and PCR product
o ® — O is generated.
Limitations
Binds nonspecifically to all double-stranded DNA . Polvmerizati |
sequences. To avoid false-positive signals, check for | @—9- € -0 @ Step 4® olymerization completed
nonspecific product formation using melt curve or gel | &6 & &= SYBR™ Green | dye binds to the
A double-stranded product,

resulting in a net increase in
fluorescence detected by the
instrument.

Notes
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Other Reagents

If you use fluorescence-based reagents other than TagMan® reagents, you must design
your experiment using Advanced Setup instead of the Design Wizard (see “Advanced
Setup Workflow” on page 204).

For More For more information on real-time PCR experiments, PCR options, and reagents, refer to
Information the Real Time PCR System Reagent Guide.

How to Use This Guide

This guide functions as both a tutorial and as a guide for performing your own
experiments.

Using This Guide Using the example experiment data provided with the 7500 software, you can use this
as a Tutorial guide as a tutorial for performing a relative standard curve or comparative C experiment
on a 7500/7500 Fast system. Follow the procedures in the appropriate chapters shown in

the table below:
Chapter
P
Relative Comparative rocedure
Standard Curve Cr

2 6 Design the experiment using the Design Wizard in the
7500 software.

3 7 Prepare the experiment using the reagents and
volumes calculated by the Design Wizard in Chapter 2
(relative standard curve experiment) or Chapter 6
(comparative C; experiment).

4 8 Run the experiment on a 7500/7500 Fast instrument.

5 9 Analyze the results of an example experiment.

For more information, see “About the Example Experiments” on page 14.

Notes
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How to Use This Guide

Using This Guide After completing the tutorial exercises in Chapters 2 through 9, you can use this guide to
with Your Own lead you through your own relative standard curve or comparative C; experiments. Each
Experiments procedure in Chapters 2 through 9 includes a set of guidelines that you can use to
perform your own experiments.

Additionally, you can use one of the other workflows provided in the 7500 software to
perform your experiments. The table below summarizes the available workflows.

Workflow Description See...
Design Wizard | Set up a new experiment with guidance from the 7500 Chapter 2 or
software. The Design Wizard guides you through best Chapter 6

practices as you create your own experiment. The Design
Wizard is recommended for new users.

Note: Design options are more limited in the Design
Wizard than in Advanced Setup.

Advanced Set up a new experiment using advanced options. page 204
Setup Advanced Setup allows design flexibility as you create
your own experiment. Advanced Setup is recommended
for experienced users.

QuickStart Run a new experiment with no reaction plate setup page 206
information. If desired, you can add design parameters
after the run.

Template Set up a new experiment using setup information from a page 208
template.
Export/Import Import experiment designs from ASCII text files that page 210

contain experiment setup information.

Notes
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About the Example Experiments

About the Example Experiments

About the

The objective of the relative standard curve example experiment is to compare the

Relative Standard
Curve Example
Experiment

expression levels of the c-myc transcriptional factor (an oncoprotein that activates the
transcription of growth-associated genes) in liver and kidney tissues.

In the relative standard curve example experiment:

The samples are cDNA prepared from total RNA isolated from liver and kidney tissues.
The target is human c-myc.

The endogenous control is human glyceraldehyde-3-phosphate dehydrogenase (GAPDH).
The reference sample is RNA isolated from kidney tissue.

One standard curve is set up for c-myc (target). The standard used for the standard
dilution series is a cDNA sample of known quantity prepared from RNA isolated from
lung tissue.

One standard curve is set up for GAPDH (endogenous control). The standard used for the
standard dilution series is a cDNA sample of known quantity prepared from RNA isolated
from lung tissue.

The experiment is designed for singleplex PCR, where the target (c-myc) and endogenous
control (GAPDH) assays are performed in separate wells.

Reactions are set up for 2-step RT-PCR. The High-Capacity cDNA Reverse Transcription
Kit is used for reverse transcription; the TagMan® Universal PCR Master Mix is used for
PCR.

Primer/probe sets are selected from the Applied Biosystems TagMan® Gene Expression
Assays product line:
— For the target assay (c-myc), the assay ID is Hs00153408_m1 (RefSeq NM_002467.3).

— For the endogenous control assay (GAPDH), the assay ID is Hs99999905_m1
(RefSeq NM_002046.3).

Reaction Plate Layout

The 7500 software displays the 96-well plate layout, as shown below.
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About the Example Experiments

About the The objective of the comparative C example experiment is to compare the expression of
Comparative CT EGR3, MAOB, OGDH, OSGEP, and SERPINGT in brain, liver, kidney, and universal tissues.
(AACy) Example

p In the comparative C example experiment:
Experiment p T ple exp

* The samples are cDNA prepared from total RNA isolated from brain, liver, kidney,
and universal tissues.

* The targets are EGR3, MAOB, OGDH, OSGEP, and SERPINGI.
* The reference sample is brain.
» The endogenous control is human 18S.

* The experiment is designed for singleplex PCR, where the targets (EGR3, MAOB,
OGDH, OSGEP, and SERPING1) and endogenous control (18S) assays are
performed in separate wells.

» Reactions are set up for 2-step RT-PCR. The High-Capacity cDNA Reverse
Transcription Kit is used for reverse transcription; the TagMan® Universal PCR
Master Mix is used for PCR.

* Primer/probe sets are selected from the Applied Biosystems TagMan® Gene
Expression Assays product line:

— For the target assays:
* EGR3 Assay Mix: Hs00231780_m1 (RefSeq NM_004430.2)
* MAOB Assay Mix: Hs00168533_m1 (RefSeq NM_000898.3)
* OGDH Assay Mix: Mm00803121_m1 (RefSeq NM_010956.3)
* OSGEP Assay Mix: Hs00215099_m1 (RefSeq NM_017807.2)

» SERPINGI1 Assay Mix: Hs00163781_m1 (RefSeq NM_001032295.1/
NM_000062.2)

— For the endogenous control assay (18S), the 18S Assay Mix: Hs99999901_sl1.

Reaction Plate Layout

The 7500 software displays the 96-well plate layout as shown below.
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Chapter 1 Get Started

About the Example Experiments

About the In this getting started guide, you use five files:

Example .

Experiment Data

Notes

16

In Chapter 2, you create a relative standard curve example experiment that contains
setup data, then you save the file to your computer.

In Chapter 5, you view results in a relative standard curve example experiment file
that contains run data. The data file for the example experiments is installed with the
7500 software. You can find the data file for the example experiment on your
computer at:

<drive>\Applied Biosystems\<software name>\experiments\
Relative Standard Curve Example.eds

In Chapter 6, you create a comparative C example experiment that contains setup
data, then you save the file to your computer.

In Chapter 9, you view results in a comparative C; example experiment file that
contains run data and in a comparative C example study file that contains the data
from multiple comparative C experiments. The data files install with the 7500
software, and are on your computer at:

— <drive>:\Applied Biosystems\<software name>\experiments\
Comparative Ct Example.eds

— <drive>:\Applied Biosystems\<software name>\experiments\
Comparative Ct Study Example.edm

where:

— <drive> is the computer hard drive on which the 7500 software is installed.

— <software name> is the current version of the 7500 software.

Example Files in the Experiments Folder

The experiments folder of the 7500 software contains several example files that you can
reference when analyzing your own data. The following example files install with the
7500 software:

Comparative Ct Example.eds

Comparative Ct Study Example.edm
Comparative Ct Study (Biological Groups).edm
Genotyping Example.eds

Presence Absence Example.eds

Relative Standard Curve Example.eds

Standard Curve Example.eds

Note: Be sure to use the Comparative Ct Example.eds, Relative Standard Curve
Example.eds, and Comparative Ct Study Example.edm files when you perform the
procedures in this guide.
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Example Experiment Workflow

Chapter 1 Get Started n

Example Experiment Workflow

This section shows the workflow for the relative standard curve and comparative C;

example experiments.

Start Relative Standard Curve Experiment

v

Design the Experiment (Chapter 2)
Create a new experiment.
Define the experiment properties.
Define the methods and materials.
Set up the targets.
Set up the standards.
Set up the samples.
Set up the relative quantitation.
Set up the run method.
9. Review the reaction setup.

© N AN~

10.0Order materials for the experiment.
11.Finish the Design Wizard.

Start Comparative C; (AACt) Experiment
v

v

Design the Experiment (Chapter 6)
1. Create a new experiment.
2. Define the experiment properties.
3. Define the methods and materials.
4. Set up the targets.
5. Set up the samples.
6. Set up the relative quantitation.
7. Set up the run method.
8. Review the reaction setup.
9. Order materials for the experiment.
10.Finish the Design Wizard.

Prepare the Reactions (Chapter 3)
Prepare the template.
Prepare the sample dilutions.
Prepare the standard dilution series.

o~ n

Prepare the reaction plate.

v

Prepare the reaction mix for each target assay.

h 4

Prepare the Reactions (Chapter 7)
. Prepare the template.
. Prepare the sample dilutions.
. Prepare the reaction mix for each target assay.
. Prepare the reaction plate.

AW N =2

Run the Experiment (Chapter 4)
Prepare for the run.
Enable the notification settings (Optional).
Start the run.
Monitor the run.

o r 0N~

Unload the instrument.

v

v
(continued on page 18)

Notes

Run the Experiment (Chapter 8)
. Prepare for the run.
. Enable the notification settings (Optional).
. Start the run.
. Monitor the run.

a b~ WON =

. Unload the instrument.

v
(continued on page 18)

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve

and Comparative C; Experiments




— Chapter 1 Get Started

Example Experiment Workflow

Relative Standard Curve Experiment
(continued from page 17)

v

ISP

o~ 0N

Analyze the Experiment (Chapter 5)

Section 1, Review Results:

Analyze.

View the Standard Curve Plot.

View the Amplification Plot.

View the Gene Expression Plot/well table.
Publish the data.

Section 2, Troubleshoot (If Needed):
. View the analysis settings; adjust the

baseline/threshold.

View the quality summary.
Omit wells.

View the Multicomponent Plot.
View the Raw Data Plot.

Comparative Gy (AAC;) Experiment
(continued from page 17)

v

A 4
End Experiment

Notes

18
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Analyze the Experiment (Chapter 9)

Section 1, Review Results:

1.
2.
3.
4.

Analyze.

View the Gene Expression Plot/well table.
View the Amplification Plot.

Publish the data.

Section 2, Troubleshoot (If Needed):

1.

g~ W N

S

© 0 N O O~ W N =2

View the analysis settings; adjust the
baseline/threshold.

. View the quality summary.
. Omit wells.
. View the Multicomponent Plot.

View the Raw Data Plot.

ection 3, Create a Study:

. Create a study.

. Define replicates.

. Analyze.

. View the Gene Expression Plot.
. View the experiment data.

. View the Multicomponent Data.
. View multiple plots.

. View the quality summary.

. Publish the data.

v
End Experiment




Chapter 2

m Design the Relative Standard
Curve Experiment

This chapter covers:

B Chapter OVEIVIBW . . . o\ttt ettt e e e e e e e e ettt 20
B Createa New Experiment. .. ............. .t 21
B Define the Experiment Properties ............. .. ... .. .. ... 22
B Define the Methods and Materials . . ........ ... ... .. .. ... ... ....... 24
B SetUpthe Targets. . . . ..ottt e e 26
B SetUpthe Standards. . ........ ... . . . 29
B SetUpthe Samples. . ... e 31
B Set Up the Relative Quantitation Settings . ..............c.ccvinininrnan.. 34
B SetUpthe RunMethod ........ ... ... ... . . . . i 35
B Reviewthe Reaction Setup. ... ...t 36
B Order Materials for the Experiment .. ............ .. .. .. .. .. ... ... 43
B Finish the Design Wizard . .. ...... ... ... . . . 46

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

Example
Experiment
Workflow

Notes

This chapter explains how to use the Design Wizard in the 7500 software to set up the
relative standard curve example experiment. The Design Wizard guides you through
Applied Biosystems recommended best practices as you enter design parameters for the

example experiment.

Note: When you design your own experiments, you can select alternate workflows (see
“Using This Guide with Your Own Experiments” on page 13).

Start Relative Standard Curve Experiment
v

o N o o~ WOWDN =

. Create a new experiment.

. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.

. Set up the standards.

. Set up the samples.

. Set up the relative quantitation.

. Set up the run method.

9.
10. Order materials for the experiment.
11. Finish the Design Wizard.

Design the Experiment (Chapter 2)

Review the reaction setup.

v
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)
4

End Experiment
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Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the 7500 software.

Create an 1. Double-click g (7500 software) or select Start » All Programs »
Experiment Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Inthe Home screen, click | [[\] Design Wizard to open the Design Wizard.

® 7500 Software v2.0 3=

File Edit Instrument Analysis Tools Help

[ New Experiment » 5 open.. [l 5ave - BN Close | 4B Ewot - B PrintReport
Analyze
QuickStart Analyze Experiment
2
Advanced Setup
[ 7500 : connected I
Notes
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Define the Experiment Properties

Define the Experiment Properties

In the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the relative standard curve example experiment:

£ Exa_lmplci * The experiment is identified as an example.
Xperimen * The instrument that is selected to run the experiment is the 7500 instrument.
+ A MicroAmp® Optical 96-Well Reaction Plate is used.

* The experiment type is quantitation.

Complete the 1. Click the Experiment Name field, then enter Relative Standard Curve Example.

Experiment
Properties Screen Note: The experiment header is updated with the experiment name that you enter.

2. Leave the Barcode field empty.
3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Example Experiment for the Relative
Standard Curve Getting Started Guide.

5. Select 7500 (96 Wells).
6. Select Quantitation for the experiment type.

7. Click Next.

1A. Define: Experiment Properties Experiment Properties Help @.

u Instructions: Enter an experiment name, select the instrument type, then select the type of experiment to design

How do you want to identify this experiment? = Required
1 T Experment Name ‘ Relative Standard Curve Example |
2 parcoae {upunanai); i |
3 User e opnonay. | Example Experiment |
4 Comments (Ontinnal [Example Experiment for the Relative Standard Curve Getting Started Guide L |
>
Which instrument are you using to run the experiment?
5 [
1 v/ 7600 (96 Wells) 7600 Fast (96 Wells)
Setup, run, and analyze an experiment using a 4- or 5-color, 96-well system.
What type of experiment do you want to design?
6 [ + Guantitation ] [ Genotyping J [ Presence / Absence ]
Design a gene quantitation experimentto determine the amount oftarget nucleic acid sequence ina sample.
Notes
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Define the Experiment Properties

Design  When you design your own relative standard curve experiment, you:

Guidelines » Enter an experiment name that is descriptive and easy to remember. You can enter
up to 100 characters in the Experiment Name field. You cannot use the following
characters in the Experiment Name field: /\><*?"|:;

Note: The experiment name is used as the default file name.

* (Optional) Enter a barcode to identify the barcode on the PCR reaction plate. You
can enter up to 100 characters in the Barcode field.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

* (Optional) Enter comments to describe the experiment. You can enter up to
1000 characters in the Comments field.

* Select the instrument you are using to run the experiment:
— 7500 (96 Wells)
— 7500 Fast (96 Wells)

Note: You canuse 7500 software v2.0 to design experiments for the 7500/7500 Fast
instrument.

IMPORTANT! To set the default instrument type, select Tools » Preferences, then
select the Defaults tab (default). In the Instrument Type drop-down list, select the
appropriate instrument.

®

?__] Preferences

[[Defaulls | Stariup |

q Enter a default sample volume for your experiments, selectyour default folders, and
selectthe type of instrument for the software to use by default.

Sample Reaction Vol | 50 uL

Diata Folder: Cispplied Biosystems\F500\experiments |
Import Folder Capplied Biosystemns\7500lexperiments |

Export Folder: CiApplisd Biosystems\7500\experiments |

Instrument Type:

OK || Cancel

For More For more information on:

Information * Completing the Experiment Properties screen — Open the 7500 Software Help by
clicking @) or pressing F1.

* Consumables — See “Supported Consumables” on page 4.
* Quantitation experiments — Refer to the Real Time PCR System Reagent Guide.

Notes
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Define the Methods and Materials

Define the Methods and Materials

In the Methods and Materials screen, select the quantitation method, reagents, ramp
speed, and PCR template to use for the experiment.

About the In the relative standard curve example experiment:
Example .

) The relative standard curve quantitation method is used.
Experiment

+ TagMan® reagents are used.
* The standard ramp speed is used in the instrument run.
* cDNA (prepared from total RNA isolated from liver and kidney tissues) is the

template type.You must first perform reverse transcription to convert the RNA to
cDNA (see “Prepare the Template” on page 51).

Complete the 1. In the Methods and Materials screen, select Relative Standard Curve as the
Methods and quantitation method.

Materials Screen
2. Select TagMan® Reagents for the reagents.

IMPORTANT! Fast runs cannot be performed on a 7500 system.

3. Select Standard (~ 2 hours to complete a run) for the ramp speed.
4. Select cDNA (complementary DNA) for the template type.
5. Click Next.

1B. Define: Methods & Materials Methods & Materials Help @

a Instructions: Selectthe quantitation method, reagents, ramp speed, and type of template for the real-time PCR reactions.

Which guantitation method are you using?

[ Standard Curve } [ + Relative StFnuaru Curve } [ Comparative CT (AACT) }
1 |
With the relative standard curve method, you use standards, a reference sample, and an endogenous control to determine the relative quantity of target sequence in a sample.
Which reagents do you want to use to detect the target sequence?
2 [ + TagMan® Reagents } [ SYBR® Green Reagents }
These real-time PCR reactions contain two primers and a TagMan® probe. The primers are designed to amplify the target sequence. The TagMan probe is designed to hybridize to the
target sequence and generate fluorescence signal when the target sequence is amplified
Which ramp speed do you want to include in the instrument run?
3 [.’ Standard (~ 2 hours to complete a run)}
For optimal results using the standard ramp speed, Applied Biosystems recommends standard reagents for your realtime PCR reactions.
What type of template do you want to use in the real-time PCR reactions?
4 f + cONA (complementary DRA RIMA DA (genomic DNA)
I p ry gd ]
ou are adding cDNA to the real-time PCR reactions. You have already performed reverse transeription to convert the RNAto cDNA,
Notes
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Define the Methods and Materials

Design  When you design your own relative standard curve experiment, you:

Guidelines » Select Relative Standard Curve as the quantitation method. The relative standard
curve method is used to determine relative target quantity in samples. When setting
up your reaction plate, the relative standard curve method requires targets,
standards, samples, a reference sample, and an endogenous control.

* Select the reagents you want to use:

— Select TagMan® Reagents if you want to use TagMan reagents to detect
amplification and quantify the amount of target in the samples. TagMan reagents
consist of two primers and a TagMan® probe. The primers are designed to
amplify the target. The TagMan probe is designed to hybridize to the target and
fluoresce when the target is amplified.

— Select SYBR® Green Reagents if you want to use SYBR Green reagents to
detect amplification and quantify the amount of target in the samples. SYBR
Green reagents consist of two primers and SYBR Green dye. The primers are
designed to amplify the target. The SYBR Green dye fluoresces when it binds to
double-stranded DNA. SYBR Green dye is often part of the SYBR Green master
mix added to the reaction. If you use SYBR Green dye, select the Include Melt
Curve check box to perform melt-curve analysis of the amplified target.

IMPORTANT! Although you can use other fluorescence-based reagents on the
7500/7500 Fast system, you must design your experiment using Advanced Setup
instead of the Design Wizard.

» Select the appropriate ramp speed for the instrument run:

IMPORTANT! Select a Fast run only if you use a 7500 Fast system. Fast runs cannot
be performed on a 7500 system.

— Select Fast (~ 40 minutes to complete a run) if you are using Fast reagents for
the PCR reactions.

— Select Standard (~ 2 hours to complete a run) if you are using standard
reagents for the PCR reactions.

* Select the appropriate PCR template:

— Select cDNA (complementary DNA) if you are performing 2-step RT-PCR, and
you have already performed reverse transcription to convert the RNA to cDNA.
You are adding complementary DNA to the PCR reactions.

— Select RNA if you are performing 1-step RT-PCR. You are adding total RNA or
mRNA to the PCR reactions.

IMPORTANT! To use the Fast ramp speed with RNA templates, you must
design your experiment using Advanced Setup instead of the Design Wizard.

— Select gDNA (genomic DNA) if you have already extracted the gDNA from
tissue or sample. You are adding purified genomic DNA to the PCR reactions.

Notes
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Set Up the Targets

For More For more information on:

Information

Completing the Methods and Materials screen — Open the 7500 Software Help by
clicking @) or pressing F1.

Using Advanced Setup — See “Advanced Setup Workflow” on page 204.

Using the comparative C quantitation method — See Chapters 6 to 9 of this guide.

Using the standard curve quantitation method — Refer to the Applied Biosystems
7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
Experiments.

TagMan and SYBR Green reagents — Refer to the Real Time PCR System Reagent
Guide.

PCR, including singleplex vs. multiplex PCR and 1-step vs. 2-step RT PCR — Refer
to the Real Time PCR System Reagent Guide.

Set Up the Targets

About the
Example
Experiment

Complete the
Targets Screen

Notes

In the Targets screen, enter the number of targets that you want to quantify in the PCR
reaction plate, then set up the experiment for each target.

In the relative standard curve example experiment:

Two targets are quantified in the reaction plate.

The Set Up Standards check box is selected. When this check box is selected, the
software automatically displays the Standards screen after you complete the Targets
screen. In the Standards screen, you can set up a standard curve for each target assay
(see “Set Up the Standards™ on page 29).

The Target 1 experiment is set up for the target you are studying. For the example
experiment, the target is human c-myc (an oncoprotein that activates the
transcription of growth-associated genes).

The Target 2 experiment is set up for the endogenous control. For the example
experiment, the endogenous control is human glyceraldehyde-3-phosphate
(GAPDH). GAPDH is the endogenous control because its expression levels tend to
be relatively stable.

. In the Targets screen, click the How many targets do you want to quantify in the

reaction plate? field, then enter 2.

Note: The number of rows in the target assays table is updated with the number you
entered.

Select the Set Up Standards check box to set up standards for both target assays.

Note: The Set Up Standards check box is selected by default.

26 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
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Set Up the Targets

3. Set up the Target 1 experiment:
a. Click the Enter Target Name cell, then enter c-mye.
b. In the Reporter drop-down list, select FAM (default).
c. In the Quencher drop-down list, select NFQ-MGB (default).
d. In the Color field, leave the default.

4. Set up the Target 2 experiment:

a. Click the Enter Target Name cell, then enter GAPDH.

b. In the Reporter drop-down list, select FAM (default).

c. In the Quencher drop-down list, select NFQ-MGB (default).
d. In the Color field, leave the default.

5. Click Next.
Note: For all targets, leave blank the (Optional) Enter Gene Name field. You can search

for the gene/assay ID when you order your materials (see “Order Materials for the
Experiment” on page 43).

2A_Set Up: Targets Targets Help @‘,

a Instructions: Enter the number oftargets to quantify in the reaction plate, then set up the assay for each targst.

Set Up Targets = Required

1 * How many targets do you wantto quantify in the reaction plate? ‘2
Foreach target assay in the reaction plate, select whether to set up standards, enter a target name, select the reporter and guencher to use to detect the target, and select a target
color, (Optional) Enter a gene name, find Applied Biosystems gene expression assays, then selectan assay to fillinthe Assay 1D,
SetUp Standar. * Enter Target Mame Reporter Quencher Color | Assay D (Optional) Enter Gene Name and Click "Fi ‘
il
2 (Jlemye | [Fam v|nwFomes v v 1 e 3
([[eaPoH | tram VINFO-MGB v v i e 4
Notes
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Notes

28

Set Up the Targets

Design
Guidelines

When you design your own relative standard curve experiment:

» Select the Set Up Standards check box. Applied Biosystems recommends that you

set up a standard curve for each target assay in the reaction plate.

Identify each target assay with a unique name and color. You can enter up to
100 characters in the Target Name field.

Select an endogenous control for each sample. The endogenous control is a target
that is in all samples under investigation. It should be expressed equally in all
sample types, regardless of treatment or tissue origin (examples of endogenous
controls are B-actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The
endogenous control is used to normalize the PCR results; the endogenous control
corrects for variable sample mass, nucleic acid extraction efficiency, reverse
transcription efficiency, and pipette calibration errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple tissues)
requires an endogenous control.

— If samples are on multiple plates, each reaction plate must have an endogenous
control. Additionally, every plate must include an endogenous control for every
sample type on the reaction plate.

Select the reporter dye used in the target assay. In the Methods and Materials screen
on page 24, if you selected:

— TagMan® Reagents — Select the dye attached to the 5" end of the TagMan probe.
— SYBR® Green Reagents — Select SYBR.

Select the quencher used in the target assay. In the Methods and Materials screen on

page 24, if you selected:

— TagMan® Reagents — Select the quencher attached to the 3’ end of the TagMan
probe.

— SYBR® Green Reagents — Select None.

For More For more information on:

Information

+ Completing the Targets screen — Open the 7500 Software Help by clicking @) or

pressing F1.

+ Selecting an endogenous control — See the Application Note Using TagMan®

Endogenous Control Assays to Select an Endogenous Control for Experimental
Studies.
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Set Up the Standards

In the Standards screen, enter the number of points and replicates for all standard curves
in the reaction plate. For each standard curve, enter the starting quantity and select the
serial factor.

About the In the relative standard curve example experiment:

Exa_lmple * One standard curve is set up for the target (c-myc). The standard used for the
Experiment standard dilution series is a cDNA sample of known quantity prepared from RNA
isolated from lung tissue.

* One standard curve is set up for the endogenous control (GAPDH). The standard
used for the standard dilution series is a cDNA sample of known quantity prepared
from RNA isolated from lung tissue.

* For each standard curve:
— Five points are used in the standard curve.

— Three replicates are used for each point. Replicates are identical reactions,
containing identical reaction components and volumes.

— The starting quantity is 200 ng, and the serial factor is 1:10.

Complete the 1. In the Standards screen, click the How many points do you need for each
Standards Screen standard curve? field, then enter 5.

2. Click the How many replicates do you need for each point? field, then enter 3.

3. Define the range of standard quantities for the c-myc assay:
a. Click the Enter Starting Quantity field, then enter 200.0.

b. In the Select Serial Factor drop-down list, select 1:10.

4. Define the range of standard quantities for the GAPDH assay:
a. Click the Enter Starting Quantity field, then enter 200.0.

b. In the Select Serial Factor drop-down list, select 1:10.

5. Review the Standard Curve Preview pane for each assay. The standard curves have
the following points: 200, 20, 2, 0.2, and 0.02.

6. Click Next.

Notes
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2B. Set Up: Standards Standards Help 0}

a Instructions: Enter the number of points and replicates for all standard curves in the reaction plate. For each standard curve, enter the starting quantity and selectthe serial factar.

Set Up Standards = Required : View Plate Layout
1 * How many points do you need for each standard curve? s FlEE Flla el Gee
2 1 Howmany eplicates do you need for each point?
For each standard curve, define the range of standard quantities by entering the starting | @SHOW‘" Wells ¥ | (] View Legend | E | @ |
guantity and serial factor,
Dafine the standard curve so thatthe range of standard quantiiss spans the 1273 [a[s 6788 [m[n
range of quantities for the unknowns Sam.. Sam.. Sam.. Sam..|Sam.. Sam..
Target Name Enter Starting Quantity Select Serial Factor A D D D D D D m m
a -
o eemye ‘ 200.0 110 = Sam... Sam... Sam...|Sam..|Sam.. Sam
—| | =
—_— = e | g 388888
) GAPDH 200.0 1:10 ‘ N @ l'!l EI I!'l l'!l EI I!'l ann |ann (aan [an [an  an
. 3a (3b | lc18-8- 8 B8 8888
Standard Curve Preview N i - - - L L P e P e PP PP P
Standard C P for @0 c-my
andar urve Freview for 9 c-myc o D D D D D D D D D
an an an s . . nn |mn nn |nae |nae nae
2E2
2E1 E
5 2ED -
2E-1 :
2E-2
G
M 12 - unknown  [5]30 - Standard [ 6 - Negative Contral 48 - Emipty H
If needed, use the scroll bar to view GAPDH,
then perform steps 4a and 4b.
Design  When you design your own relative standard curve experiment:
Guidelines

Notes

» Set up a standard curve for each target in the reaction plate. The targets are

previously defined in the Targets screen (“Set Up the Targets” on page 26).

Enter the number of points for each standard curve in the reaction plate. Applied
Biosystems recommends at least five dilution points for each standard curve.

Enter the number of identical reactions (replicates) for each point in the standard
curve. Applied Biosystems recommends three replicates for each point.

Because the range of standard quantities affects the amplification efficiency
calculations, carefully consider the appropriate range of standard quantities for your
assay:

— For more accurate measurements of amplification efficiency, use a broad range of
standard quantities, such as between 10° and 10°. If you specify a broad range of
quantities for the standards, you need to use a PCR product or a highly
concentrated template, such as a cDNA clone.

— Ifyou have a limited amount of cDNA template and/or if the target is a low-copy
number transcript, or known to occur within a specified range, a narrow range of
standard quantities may be necessary.

The serial factor is used to calculate the quantities in all points of the standard curve.
If your starting quantity is the highest quantity, select a serial factor such as 1:2, 1:3,
and so on. If your starting quantity is the lowest quantity, select a concentration
factor such as 2X, 3X, and so on.

30
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For More For more information on:

Information * Completing the Standards screen — Open the 7500 Software Help by clicking ) or

pressing F1.

+ Amplification efficiency — Refer to the Amplification Efficiency of TagMan® Gene
Expression Assays Application Note.

Set Up the Samples

In the Samples screen, enter the number of samples, replicates, and negative controls to
include in the reaction plate, enter the sample names, then select the sample/target
reactions to set up.

About the In the relative standard curve example experiment:

Exa_lmple » Two samples are used: cDNA prepared from total RNA isolated from liver and
Experiment kidney tissues. The samples contain unknown quantities of the c-myc gene (target)
and GAPDH gene (endogenous control).

» Three replicates are used. The replicates are identical reactions, containing identical
reaction components and volumes.

» Three negative controls are used. The negative control reactions contain water
instead of sample and should not amplify.

Complete the 1. In the Samples screen, click the How many samples do you want to test in the
Samples Screen reaction plate? field, then enter 2.

Note: The number of rows in the samples table is updated with the number you
entered.
2. Click the How many replicates do you need? field, then enter 3.

3. Click the How many negative controls do you need for each target assay? ficld,
then enter 3.

4. Setup Sample 1:
a. Click the Enter Sample Name field, then enter Liver.
b. In the Color field, leave the default.

5. Set up Sample 2:
a. Click the Enter Sample Name field, then enter Kidney.
b. In the Color field, leave the default.

6. Sclect No Biological Replicates.

7. Select All Sample/Target Reactions to test all targets in all samples.

Notes
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8. In the Well Count pane, verify that there are:
* 12 Unknown wells [T
» 30 Standard wells [5]
* 6 Negative control wells []
* 48 Empty wells
9. In the View Plate Layout tab:
a. In the Arrange Plate by drop-down list, select Rows (default).

b. In the Place Negative Controls in drop-down list, select Upper Left (default).

10. Click Next.

2C. Set Up: Samples Samples Help @

ﬂ Instructions: ETEr the number of samples to testin the reaction plate, enter the number of samplefarget reaction replicates, enter the number of negative controls, enter sample
" names, associate the samples with biological replicate groups, then selectthe sampleftarget reactions to set up.

SetUp samples - Requred EIN ewras o B

1 Howmany samples ¢o youwanto testin the rsaction plats” Arrange Plate by: Place Negative Controls in 79b
2 Howmany replicates do you need?
Shi Wells v
3 —* How many negative controls do you need for each target assay? | @ owin Els | ‘ | m|
For each sample in the reaction plate, enter a sample name and selecta sample 1 ‘ 2 | 3 | 4 ‘ 9 | g | ! ‘ 8 | 4 |1U ‘ " |12 |
color. Sam.. Sam.. Sam... Sam... Sam..| Sam..
* Enter Sample Name Color A DD D D DD III III
4 {Liver | v B
L Sam.. Sam.. Sam... Sam.. Sam.. Sam
Blm- m- m.B-8-8-83- 3-8
5 o B HLEL S B S B S b
s B8B83 883 888 88
i - - - An mn mA AmA AnAa (AnAn aan ana | Ann
Rl B- BRI N5 BI-B-Bl-
an [an [an | A - An  an Aa Amn ARa Aan
6 [ < No B Replicates ][ Specify Biological Replicate Groups ] N
E
A
77% + All Sample/Target Reactions ][ Specify Sample/Target Reactions ] I
G
8 | [M12-unknown [30- Standard [ 6 - Negative Control 48 - Empty H
v

Design  When you design your own relative standard curve experiment:

Guidelines * Identify each sample with a unique name and color. You can enter up to 100 characters

in the Sample Name field.

+ Enter the number of replicates (identical reactions) to set up. Applied Biosystems
recommends three replicates for each sample reaction.

+ Enter the number of negative control reactions to set up. Applied Biosystems
recommends three negative control reactions for each target assay.

+ Set up biological replicate groups (see “Set Up Biological Replicate Groups” on
page 33).
Biological replicates allow you to assess the representative nature of your results as
they relate to the population being studied. Inclusion of biological replicates can
give insight into any natural variation that is present within the population.

Notes
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* Select which targets to test in the samples:
— Select All Sample/Target Reactions to test all targets in all samples.

— Select Specify Sample/Target Reactions to specify the targets to test in each
sample.

IMPORTANT! When you use the Design Wizard to set up a relative standard curve
experiment, you can set up only singleplex reactions (amplification and detection of
one target per well). If you want to set up a relative standard curve experiment with
multiplex reactions (amplification and detection of two or more targets per well),
design your experiment using Advanced Setup instead of the Design Wizard.

Set Up Biological Replicate Groups
1. Select Specify Biological Replicate Groups.

2. Enter the number of biological replicate groups that you want to test in the reaction
plate.

3. For each biological replicate group, click the cell in the Biological Group Name
column, then enter a name for the biological group.

4. Assign the biological replicate group(s) to the reaction plate:

a. Select wells in the plate layout that contain samples associated with the
biological replicate group.

b. In the Assign column, select the check box of the appropriate biological
replicate group.

IMPORTANT! A sample cannot belong to more than one biological group.

Set Up Biological Replicate Groups

l INo Biological Replicates J| + Specify Biological Replicate Groups ~|» 1
* How many Biological Replicate Groups do you want to testin the reaction plate? E— 2
Selectwell(s) in the plate layout, then assign a hiological replicate group from the list.
Assign Biological Group Mame Color Comments
4b H——[ |Bi0|0gica| Replicate Group 1 | v | |
F |Bi0|0gica| Replicate Group 2 | R | |
3 i

For More For more information on:

Information * Completing the Samples screen — Open the 7500 Software Help by clicking @) or
pressing F1.

» Using Advanced Setup — See “Advanced Setup Workflow” on page 204.

Notes
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Set Up the Relative Quantitation Settings

In the Relative Quantitation Settings screen, select the reference sample and the
endogenous control to perform relative quantitation.

About the In the relative standard curve example experiment:

Example » Kidney is used as the reference sample.

Experiment * GAPDH is used as the endogenous control.

Complete the 1. Inthe Relative Quantitation Settings screen, select Kidney in the Which sample do
Relative you want to use as the reference sample? drop-down list.

Quantitation . _
Settings Screen 2. Select GAPDH in the Which target do you want to use as the endogenous control?

drop-down list.

3. Click Next.

2C. Set Up: Relative Quantitation Settings Relative Cuartitation Settings Help 9/
a Instructions: Select the reference sample and the endogenous control to perform relative guantitation

1 Which sample doyou wantto use as the reference sample? |Kidney %

2 ‘Which target do you want to use as the endogenous control? |GAPDH o

Design  When you design your own relative standard curve experiment:

Guidelines » Select a reference sample from your previously created samples (“Set Up the
Samples” on page 31). Amplification results from the samples are compared to the
amplification results from the reference sample to determine relative expression.

» Select an endogenous control from your previously created target assays (“Set Up
the Targets” on page 26). Amplification results from the endogenous control are
used to normalize the amplification results from the target for differences in the
amount of template added to each reaction.

For More For more information on:
Information * Completing the Relative Quantitation Settings screen — Open the 7500 Software
Help by clicking @) or pressing F1.
» Reference samples (also known as calibrators) and endogenous controls — Refer to
User Bulletin #2: Relative Quantitation of Gene Expression (PN 4303859B).

Notes
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Set Up the Run Method

In the Run Method screen, review the reaction volume and the thermal profile for the
default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the In the relative standard curve example experiment, the default run method is used
Example without edits.
Experiment

Review the Run 1. In the Run Method screen, select either the Graphical View tab (default) or
Method Screen Tabular View tab.

2. Make sure the Reaction Volume Per Well field displays 50 uL.

3. Make sure the thermal profile displays the holding and cycling stages shown below.
If necessary, click a temperature or time setting, then change it.

4. Click Next.

2E. Set Up: Run Method Fun Method Help ()
a Instructions: Review the reaction volume and the thermal profile for the default run method. If needed, edit the default run method or select a run method from the library.
1 S s Graphical View T Tabular View ]
2 - Reaction Volume Per Well L []ExpertMode | |
Add Stage ¥ | Add Step ¥ | Delete Selectad | Undo "Set Hold Time" | \| GCollect Data ¥ | |‘ Open Run Methad | Save Run Method ‘ El
Holding Stage Haolding Stage Cycling Stage
MNumber of Cycles
[[] Enable AutoDelta
starting Cycle: [ |
100 — G50°C §950°C
10:00 100% 0001
3 78 Toogs
00% 60.0°C
50.0°C 01:00
80 —| —
02:00
100%
25 —|
0
Step 1 Step 1 Step 1 Step 2
< >

Legend

Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off

Notes
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Review the Reaction Setup

Design  When you design your own relative standard curve experiment:
Guidelines * Enter a number from 10 to 100 for the reaction volume/well. The 7500 system

supports reaction volumes from 20 to 100 uL. The 7500 Fast system supports
reaction volumes from 10 to 30 uL.

Review the thermal profile:
— Make sure the thermal profile is appropriate for your reagents.
— If you are performing 1-step RT-PCR, include a reverse-transcription step.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the 7500 software.

For More For more information on:

Information .

The Run Method library or on completing the Run Method screen — Open the
7500 Software Help by clicking @) or pressing F1.

Using Advanced Setup — See “Advanced Setup Workflow” on page 204.

Review the Reaction Setup

Notes

36

In the Reaction Setup screen, select the assay type (if using TagMan reagents), then
review the calculated volumes for preparing the PCR reactions, standard dilution series,
and sample dilutions. If needed, you can edit the reaction volume, excess reaction
volume, component concentrations, standard concentration, and/or diluted sample
concentration.

About the In the relative standard curve example experiment:

Example .
Experiment

Applied Biosystems TagMan® Gene Expression Assays are used.

* The reaction volume per well is 50 uL.

The excess reaction volume is 10%.

The reaction components are:

TagMan® Universal PCR Master Mix (2X)

— c-myc Assay Mix (20X)

— GAPDH Assay Mix (20X)

— Sample or standard

— Water

The standard concentration (stock) is 100 ng/uL.

The diluted sample concentration is 50 ng/uL.

The sample stock concentration is 100 ng/pL.
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Complete the To complete the Reaction Mix Calculations tab for the c-myc assay:
Reaction Setup
Screen  |MPORTANT! Perform the following steps for each target assay in the reaction plate.

—
.

In the Reaction Setup Screen, select the Reaction Mix Calculations tab (default).
In the Select Target pane, select c-mye.

In the Assay Type drop-down list, select Inventoried/Made to Order.

Make sure the Reaction Volume Per Well field displays 50 pL.

Make sure the Excess Reaction Volume field displays 10%.

o o 0 D

In the Reactions for c-myc pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.

c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction

Master Mix (2.0X) 25.0

Assay Mix (20.0X) 2.50

Sample (10X) or Standard 5.0%

H20 17.50

Total Volume 50.0

I The sample or standard volume is limited to 10% of the total reaction volume.

3 4 5

2F. Set Up: Reaction Setup Reaction Setup Help @

For each target assay in the reaction plate, selectthe assay type (if using Ti{gMan reagents), then review the calculat|:d volumes for preparing the standard dilution series,
a Instructions: samples, and PGR reactions. If neeced, edit the reaction volume, excess re/action volume, component concentrationfs, andlor stock concentrations. Click "Print Reaction
Setup” to print instructions on how to jprepare the PCR reactions.

1 L' Reaction Mix Calculations T Sampli Dilution Calculations ]
Select Tar -
2 S Assay Type |Inventoried/Made to Order | Reaction Volume Per Well 50 | UL Excess Reaction YWolume: 10 % | print Reaction Setup
6a
6b Mastar Mix Concentration x Assay Mix Concentration: | 20.0 | X
|
_ | I Component Wolume (L) for 1 Reaction
Master Mix (2.0:) 25.00
250
6c 5.00
17.50 F
Total Volume 50.00
Notes
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7. In the Standard Dilution Series for c-myc pane:
a. Click the Standard Concentration in Stock field, then enter 100.0.
b. In the units drop-down list, select ng per uL (default).

c. Review the calculated volumes for preparing the standard dilution series:

_— . Source Volume | Diluent Volume Total Volume Standard Concentration
Dilution Point Source
Haton ot ! (uL) (WL) (uL) (ng/uL)

1 (200) Stock 8.07 12.10 20.17 40.0

2 (20) Dilution 1 2.02 18.15 20.17 4.0

34 Dilution 2 2.02 18.15 20.17 0.4

4(0.2) Dilution 3 2.02 18.15 20.17 0.04

5(0.02) Dilution 4 2.02 18.15 20.17 0.004

7a ! 100.0

7b Stzjmdard C?ncentratmn in Stack: ng ‘ “w peruL . .
|| Dilution Paint Source Source Volume (pL) DiluentVolume (L) Total Volume (L) Standard Concentratio
1 (200) Stock 8.07 12.10 2017 40.0
2 (20) Dilution 1 2.02 18.15 20.17| 4.0

7C 3 (2 Dilution 2 2.02 18.15 2017 0.4
4(0.2) Dilution 3 2.02 18.15 20.17| 0.0
5(0.02) Dilution 4 2.02 18.15 2017 0.0

To complete the Reaction Mix Calculations tab for the GAPDH assay:
1. Inthe Reaction Setup screen, select the Reaction Mix Calculations tab (default).
2. In the Select Target pane, select GAPDH.
3. In the Assay Type drop-down list, select Inventoried/Made to Order.
4. Make sure the Reaction Volume Per Well field displays 50 pL.
5. Make sure the Excess Reaction Volume field displays 10%.
6. Inthe Reactions for GAPDH pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.
Notes
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c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction
Master Mix (2.0X) 25.0
Assay Mix (20.0X) 2.50
Sample (10X) or Standard 5.0%
H20 17.50
Total Volume 50.0

I The sample or standard volume is limited to 10% of the total reaction volume.

3 4 5

Reaction Setup Help @

2F. Set Up: Reaction Setup

i For each target assay in the reaction p|ate, selectthe assay type (if using TzgMan reagents), then review the caleulatpd volumes for preparing the standard dilution series,
a Instructions: samples, and PCR reactions. If neede(d, editthe reaction volume, excess refaction volume, companent coneentration|s, and/or stock concentrations. Click "Print Reaction
Setup"to print instructions on how to plepare the PCR reactions.

1 Reaction Mix Calculations T Sarnple Pilution Calculations ]
szlect far Assay Type |InventoriediMade to Order |» Reaction Volume Per Well 50 | UL Excess Reaction Volume: 10| % | Print Reaction Setup
22 Master Mix Concentration Ijl X Assay Mix Concentration @ X
Il Component Walume (UL far 1 Reaction
Master Mix (2.0x) 25.00
2.50
6¢c 500
17.50 3
Total Volume 50.00
7. In the Standard Dilution Series for GAPDH pane:
a. Click the Standard Concentration in Stock ficld, then enter 100.0.
b. In the units drop-down list, select ng per uL (default).
c. Review the calculated volumes for preparing the standard dilution series:
Dilution Source Diluent Total Standard
Point Source Volume Volume Volume Concentration
(uL) (uL) (uL) (ng/pL)
1 (200) Stock 8.07 12.10 20.17 40.0
2 (20) Dilution 1 2.02 18.15 20.17 4.0
32 Dilution 2 2.02 18.15 20.17 0.4
4(0.2) Dilution 3 2.02 18.15 20.17 0.04
5(0.02) Dilution 4 2.02 18.15 20.17 0.004
Notes
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Standard Dilution Series for GAPDH
e

7a
7b Standard Concentration in Stock: 100.0 ‘ng ) v| per pL
| Dilution Paint Source Source Volume (L) Diluent Valume (UL) Total Valume (UL} Standard Concentratio
1(200) Stock 8.07 1210 2017 400
2 (20) Dilution 1 2.02 1815 2017 40 7
7c 3(2) Dilution 2 2.02 1814 2017 0.4
4(0.2) Dilution 3 2.02 1815 2017 0.0
5(0.02) Dilution 4 2.02 1815 2017 0.0

|l

To complete the Sample Dilution Calculations tab:

1. In the Reaction Setup screen, select the Sample Dilution Calculations tab.

2. Click the Diluted Sample Concentration (10X for Reaction Mix) field, then
enter 50.

3. In the unit drop-down list, select ng/uL (default).

4. Review the calculated volumes for the sample dilutions:

Stock Concentration | Sample Volume | Diluent Volume | Total Volume of Diluted Sample
Sample Name /uL L L L
(ng/pL) (uL) (L) (uL)

Liver 100.0 17.00 17.00 34.00
Kidney 100.0 17.00 17.00 34.00

2F. Set Up: Reaction Setup Reaction Setup Help @

For each target assay in the reaction plate, selectthe assay type (if using TagMan reagents), then review the calculated volumes for preparing the standard dilution series,

n Instructions: samples, and PCR reactions. If needed, editthe reaction volume, excess reaction volume, component concentrations, and/or stock concentrations. Click "Print Reaction
1 Qetin' tn nrintinstrictinne nn how tn nrapare the PCR reactions

[ Reaction Mix Calculations | Sample Dilution Calculations
2

|
Diluted Sample Concentration (10X for Reaction Mix) ng/pL, (¥

.

Notes

| Print Reaction Setup
Sample Name Stock Concentration (naiul) Sample Volume (uL) Diluent Valume (uL) Total Volume of Diluted Sample (...
Liver [100.0 | 17.00 17.00 34.00
Kidney [100.0 | 17.00 17.00 34.00

40
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You can print detailed reaction setup instructions, then save the instructions for
Chapter 3, “Prepare the Relative Standard Curve Reactions.”

To print Reaction Setup instructions:

1. Click Print Reaction Setup.

Reaction Setup Help @

= (ifusing TagMan reagents), then review the ealculated volumes for preparing the standard dilution series,
1e, excess reaction volume, component concentrations, andfor stock coneentrations. Click "Print Reaction

5.

s
z| | Prirt Reaction Setup : 1
ple Wolume (ul) Diluentolume (uL) Total Valume of Diluted Sample (.

17.00 17.00 34.00

17.00 17.00 34.00

2. In the Print Reaction Setup Instructions dialog box, select:
* Detailed Reaction Setup Instructions
* Include Plate Layout
* Use sample color

3. Click Print.

Print Reaction Setup Instructions El
G Selectthe type of instructions to print

() Summary Reaction Setup Instructions

4@

Setup Instructions

Plate Layout Print Options
(& Use sample color

(O Use task color

Preview ‘ | Print | ‘ Cancel

4. Click Next.

Notes
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Review the Reaction Setup

Design  When you design your own relative standard curve experiment:

Guidelines .

If you are using TagMan reagents, select the type of assay you are using:

— Select Inventoried/Made to Order if you are using Applied Biosystems
TagMan® Gene Expression Assays (Inventoried or Made to Order) or Applied
Biosystems Custom TagMan® Gene Expression Assays.

— Select Custom if you are designing your own assays with Primer Express®

software.

Enter a number from 10 to 100 for the reaction volume/well. The 7500 system
supports reaction volumes from 20 to 100 puL. The 7500 Fast system supports
reaction volumes from 10 to 30 uL.

Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

Review the reaction mix concentrations for each target: If needed:

— For TagMan reagents, edit the master mix and assay mix concentrations.

— For SYBR Green reagents, edit the master mix, forward primer, and reverse
primer concentrations.

— For 1-step RT-PCR, edit the reverse transcriptase concentration.

Review the reaction mix components for each target:

— If you are running Fast PCR reactions, make sure you use Fast master mix in the
PCR reactions.

— If you are running standard PCR reactions, make sure you use standard master
mix in the PCR reactions.

— For 1-step RT-PCR, make sure you include reverse transcriptase in the PCR
reactions and use a specific buffer.

Review the standard dilution series calculations for each target. If needed, edit the
Standard Concentration in Stock field (including units).

Note: For the Standard Concentration in Stock field, you can select ng or ig in the
drop-down list or you can enter another unit in the field (for example, copies, IU,
[International Units], nmol, pg, and so on). The table is updated according to your
entry.

Review the sample dilution calculations for each sample. If needed, edit the diluted
sample concentration (including units) and stock concentration.

For More For more information on:

Information .

Completing the Reaction Setup screen — Open the 7500 Software Help by clicking
@) or pressing F1.

Applied Biosystems assays — Refer to the:

— TagMan® Gene Expression Assays Protocol

— Custom TagMan® Gene Expression Assays Protocol
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Order Materials for the Experiment

Order Materials for the Experiment

In the Materials List screen, review the list of materials recommended to prepare the PCR
reaction plate. You can print the materials list, create a shopping list, then order the
recommended materials from the Applied Biosystems Store.

Note: Product availability and pricing might vary according to your region or country.
Online ordering through the Applied Biosystems Store is not available in all countries.
Contact your local Applied Biosystems representative for help.

Note: The 7500 software recommends the materials to order based on your experiment
design. It is assumed that you will design your experiment, order your materials, then
prepare (Chapter 3) and run (Chapter 4) the reaction plate when your materials arrive.

About the In the relative standard curve example experiment, the recommended materials are:
Exa_tmple + MicroAmp® Optical 96-Well Reaction Plate
Experiment + MicroAmp™™ Optical Adhesive Film
+ MicroAmp® Splash Free Support Base
+ TagMan® Universal PCR Master Mix (2X), No AmpErase® UNG
e c-myc Assay Mix: Hs00153408_m1 (RefSeq NM_002467.3)
* GAPDH Assay Mix: Hs99999905_m1 (RefSeq NM_002046.3)

Complete the 1. Find the target assay in the Applied Biosystems Store:
Materi aISrSdce;‘ggg a. Click the Enter Gene Name field, enter c-myec, then click Find Assay.
b. In the Find Assay Results dialog box, select the Hs00153408_m1 row, then

click Apply Assay Selection.

& Find Assay Results ®
21 Assays Found. Clickthe Assay ID 1o vigw the assay in the Applizd Biosystems Store. Selectan assay to detect and quantify the target sequence. c-myc
Avallahility Assay D Gene Symbal Gene Name RefSeq
: MYC v-mye myslacytamatosis viral onc...  NM_002467.3 ~
1b Pre mads Hs00153408 m1 IS -
[ hCG15a17 Gene hCG15917 Celera Annotation
N P myelocytomatosis viral oncogene .. NM_012603.2
rce59927 Gene rCG59927 Celera Annotation
Made to Order  Dm01843706 mt  9m LI EESLEIE
s to Ordsr Mm004a7804 it ™C myelocytomatosis oncogene ) NM_010849.4
mCG1625 Gene mCG1625 Celera Annotation
ore mads umoodezeea m M myslocytomatosis ancogzne NM_010849.4
mCG1625 Gene mCG1625 Celera Annotation
s o Order Hsasgag003 mi "Y€ v-myc myelocylomatosis viral onc...  NM_002467.3
hCG15917 Gene hCG15817 Celera Annotation
I P ——EE v-myc myelocylomatosis viral onc
hCG15917 Gene hCG15917 Celera Annotation
nve e mla s mana nis szl ans i
[ Il 10f1 | Mext» | | Last | | Apply Assay Selection | | Cancel

c. Click the Enter Gene Name field, enter GAPDH, then click Find Assay.

Notes
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Notes
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Order Materials for the Experiment

d. In the Find Assay Results dialog box, select the Hs99999905_m1 row, then
click Apply Assay Selection.

&) Find Assay Results

21 Assays Found. Clickthe Assay 1D to vigw the assay in the Applizd Biosystems Store. Selzctan assay to detectand quantify the target sequence. GAPDH
Availanility Assay D Gene Symbol Gene Name RefSeq
mCG115100 Gene mCG115100 Celera Annota. [ |
mCG115979 Gene mCG115374 Celera Annota
mCG116755 Gene MCG116755 Celera Annota.
mCG1217 Gene mCG1217 Celera Annotation
mCG125819 Gene mCG125819 Celera Annota
mCG134295 Gene MCG134295 Celera Annota.
mCG142399 Gene mCG142308 Celera Annota.
1d W ! Lisaunass0s mi | CAPOH alyceraldehyde-3-phosphate dehy...  NM_002046.3
H hCG2005673 Gene hCG2005673 Celera Annot...
IN— Lspo7sgaat g OAPCH glyceraldehyde-3-phosphate dehy.. NM_002046.3
hCG2005673 Gene hCG2005873 Celera Annot.
bre made 02786624 gt GAPDH B glvcela\uehvue-a:ﬂhosnhale dehy... NM_002046.3
hCG2005673 Gene hCG2005673 Celera Annot.
GAPDH alyceraldehyde-3-phosphate dehy...  NM_002046.3 v
| || 1071 | Next> | | Last | | Apply Assay Selection | | Cancel

2. In the Display drop-down list, select All Items (default), then review the
recommended materials.

Note: For more information on a specific item, click the part number link. You are
connected to the product information page at the Applied Biosystems Store.

3. (Optional) Click Print Materials List to send the materials list to your printer.

4. (Optional) Create a shopping list:

a. Select the check box next to each of the following items:
MicroAmp® Optical 96-Well Reaction Plate
MicroAmp'" Optical Adhesive Film
MicroAmp® Splash Free Support Base

TagMan® Universal PCR Master Mix (2X), No AmpErase® UNG

Hs00153408_m1 (c-myc Assay Mix)

Hs99999905_m1 (GAPDH Assay Mix)
b. Click Add Selected Items to Shopping List.

5. (Optional) Create a shopping basket at the Applied Biosystems Store. Product
availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries.
Contact your local Applied Biosystems representative for help.
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Order Materials for the Experiment

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

3A. Order: Materials List (Optional) Waterials List Help @

u Instructions: F2VI2w the list of materials recommended to prepare the PCR reaction plate. To create a shopping basket on the Applizd Biosystems Store, add items to the shopping list,
" entera name for the shopping baskst, click "Order Materials in List" then log in

Enter Gene Name | GAPDH ‘ |m] Enter a gene name, then click "Find Assay' to search the Applied Biosystems Store for a gene expression
1a,1c i h assay.
ExReimEnEaterials List —————————————————————————— s
4k dd Selected kems to Shopping List | Display Al tems v Crrinthaterias st - 3
[ Check Al tern Part Humber Description
TITCTUTE ST RS TS REVETSE TTAMSTIPEsE, RINEsE [TITOTOT, O TE WO, F
[l TagWan® Reverse Transcriptase Reagents 8080234 Oligo d(T)1 6, Random Hexamers, 10X RT Buffer, MaCI2 Solution. Sufficientfor |—
200 Reverse Transcriptase reactions at 10 WL reaction valume
4a Hs00153408_mi Hs00153408 m1  |Assayfor e-myc
Hs98999905_m1 Hs99999905 m1 | Assayfor GAPDH =
| Remove Selected tems from Shopping List | Shopping Basket Name | Relative Slandard Gurve E Basket || order weterials in List 5a
O check Al ftern Part Mumber Quantity
O Hs00153408_m1 HsD0153408 m1 1 |
O Hs59999905_m1 Hs35999505 m1 1 |
O MicroAmp™ Cptical Adhesive Film (25 films) 4360954 |1 |
b. In the Order Materials — Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Log In and Submit.
Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.
. Order Materials - Log In E|
Log into the Applied Biosysterns Store to place the selected items in your shopping basket. fyou do not
have a user name and password, click "Register Now to create a new account.
Store Log In OR Register
To log into the Applisd Biosystems Store, enter your user Ifyou do not have
name and password then click"Log In and Submit'. an Applied
— Biosystemns
User Mame: | ‘ account, click the
link below to
5p — | Password: | ‘ Zﬁag‘l?n? e
| Log In and Submit | Cancel
T Register Now
[] Remember my user name and passward for future orders
c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.
6. Go to “Finish the Design Wizard” on page 46.
Notes
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve 45

and Comparative C; Experiments



m Chapter 2 Design the Relative Standard Curve Experiment
Finish the Design Wizard

Design  When you design your own relative standard curve experiment:

Guidelines Select all the materials that you require for your experiment, then add them to your

shopping list.
» To access and use the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Use the following Applied Biosystems-recommended browsers and versions of

Adobe® Acrobat® Reader:
Desktop ® Microsoft® . ® Adobe®
Operating '\rl\leat\?iczrt)gr Internet Ma;;r};??h Acrobat®
System 9 Explorer Reader
Windows® v6.x or later v6.x or later Not applicable v4.0 or later
2000/NT/XP/Vista
Macintosh® Not supported | Not supported | v2.0.4 or later v4.0 or later

OS 9+ or later

IMPORTANT! Make sure that cookies and JavaScript are turned on.

For More For more information on completing the Materials List screen, open the 7500 Software
Information  Help by clicking @) or pressing F1.

Finish the Design Wizard
Finish the Design Wizard, review the plate layout, then select an exit option.

About the The 7500 software automatically selects locations for the wells in the reaction plate. In
Example the relative standard curve example experiment:

Experiment » The wells are arranged as shown below.

1 2 3 4 ] fi 7 ] ] 10 11 12

Live Liver e Liver Liver Liver
cem, cem, cem, GAPDH GAPDH GAPDH [ =-m: M cm [T] GAPDH | J GAFDH |[J GAPDH
PRI N BN BN | [N [N me™ m™ mem O U U
7.39 8.13 0.47 0.44 0.43
Kidney Kidney Kidney Kidney Kidney Kidney g g g g g g
c-mys c-mys c-mys c-mys c-mys c-mys
Iy = Iy = Iy = [T] GAPDH | J GAFDH |[J GAPDH
g|Ms™ @™ me ulSEl : :

532 41 376 0.44 0.43 0.43 200 200 200 a a a

EHeme Feme [Eeme Geme [Feme [Feme  [Feme  [eme  [Feme  [[SAFMH [ GAPH 5] 5AF0H
Gl 5 -

02 02 02 0.02 0.02 0.02 200 200 200

o}

D GAPDH GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH
20 2 2 2 02

20 20 2 02 02 0.02 0.02 0.02

* The experiment is saved as is and closed.

Note: For the example experiment, do not perform the run at this time.

Notes

46 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments



Chapter 2 Design the Relative Standard Curve Experiment n
Finish the Design Wizard

Finishthe 1. At the bottom of the 7500 software screen, click Finish Designing Experiment.
Design Wizard ‘ _ . .
2. In the Review Plate Layout for Experiment window, review the plate layout. Make
sure there are:

e 12 Unknown wells [T

* 30 Standard wells [5]

* 6 Negative control wells [
* 48 Empty wells

Note: If the plate layout is incorrect, click Return to the Wizard and check your
entered values.

3. Click Save Experiment.

B Review Plate Layout for Experiment “Relative Standard Curve Example”

G Review the plate layout, then select what you want to do next.

| . : Create Another Experiment
3 | Save Experiment ‘ Start Run for This Experiment ‘ Edit Plate Layout ‘ Using the Design Wizard ‘ Return to the Wizard ‘
Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Cantinue designing this
experiment. startthe run. Make sure the the plate layout. experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard.
the instrument. Design Wizard
| ﬁshuwin Wells ¥ | ] View Legend | | @ | N |
[z [ 3 [ 4 ] s | & [ 7 [ & [ & [ 10 [ 11 [ 12 |

Liver Liver Liver Liver Liver Liver
A D c-myc Dc-myc D c-myc D GAPDH D GAPDH D GAPDH

m c-myc m o-myc m c-mye m GAPDH m GAPDH m GAPDH

Kidney Kidney Kidney Kidney Kidney Kidney . ’ " . ” 9
B [Mem= o™= [[eme [ SAPDH [I] SAPDH [T] GAPDH g~ A= d=~ H°-~ 8- B3
an

ann ann ann an an

c eme [ Jeme Feme [Geme  [Feme G eme Geme  [Feme [Feme  [F]SAF0H [ 8AR0H [ sarDk
a na

2 a LK LE nna nna LIGE ann ann ann

o DGAPDH DGAPDH D GAPDH DGAPDH DGAPDH D GAPDH DGAPDH DGAPDH D GAPDH DGAPDH DGAPDH D GAPDH
an an an 2 a a

2 | nn na nn e n e g
E
F
G
H
4. Inthe Save Experiment dialog box, enter Relative Standard Curve Example
Setup.eds in the File name drop-down list, then click Save. The example experiment
is saved and closed, and you are returned to the Home screen.
IMPORTANT! Do not save the experiment using the default file name. Doing so will
overwrite the example experiment already present in the experiments folder.
Note: By default, the example experiment is saved to the
<drive>:\Applied Biosystems\<software name>\experiments folder.
Notes
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Finish the Design Wizard

Design  When you design your own relative standard curve experiment:

Guidelines * In the Review Plate Layout for Experiment window, select the appropriate exit option:
Click To...
Save Experiment Save and close the experiment without making any

further changes or starting the run.

Start Run for This Experiment | Save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

Edit Plate Layout Use advanced setup to edit the plate layout.

Create Another Experiment Save and close the current experiment, then create

Using the Design Wizard another experiment using the Design Wizard.

Return to the Wizard Return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to:
<drive>:\Applied Biosystems\<software name>\experiments
To change the:

— Save location for a specific experiment — Navigate to the desired location using
the Save Experiment dialog box.

— Default save location — Select Tools » Preferences, then select the Defaults tab.
In the Data Folder field, browse to then select the desired location.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on
Information page 204.

Notes
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Chapter 3

Prepare the Relative Standard
Curve Reactions

This chapter covers:

B Chapter OVEIVIBW . . . o\ttt ettt e e e e e e e e ettt 50
B Prepare the Template. .. .. ... i i e 51
B Prepare the Sample Dilutions . . .......... ... ... .. 53
B Prepare the Standard Dilution Series . .......... .. .. . i, 55
B Prepare the Reaction MixX .. ... ... 58
B Prepare the ReactionPlate .. ........ ... ... .. .. .. ... . . . . i, 60

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to prepare the PCR reactions for the relative standard curve
example experiment.

Example Start Relative Standard Curve Experiment
Experiment v
Workflow Design the Experiment (Chapter 2)

v
Prepare the Reactions (Chapter 3)

Prepare the template.

Prepare the sample dilutions.
Prepare the standard dilution series.

Prepare the reaction mix for each target assay.

A A

Prepare the reaction plate.

v
Run the Experiment (Chapter 4)
v
Analyze the Experiment (Chapter 5)

End Experiment

Notes
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Prepare the Template

Prepare the Template

You prepare the template for the PCR reactions (both samples and standards) using the
High-Capacity cDNA Reverse Transcription Kit.

IMPORTANT! Applied Biosystems recommends that you use the High-Capacity cDNA
Reverse Transcription Kit to reverse-transcribe cDNA from total RNA. The TagMan® Gene
Expression Assays are compatible with the High-Capacity cDNA Reverse Transcription Kit;
other protocols have not been tested for use with the TagMan Gene Expression Assays.

About the For the relative standard curve example experiment, the template for the PCR reactions is
Example cDNA reverse-transcribed from total RNA samples using the High-Capacity cDNA
Experiment Reverse Transcription Kit. K]
Required * One of the following Ambion® starter packs for RNA isolation:
Materials
Ambion
Kit Contents Catalog
Number
gRT-PCR RNA/ater® Tissue Collection: RNA Stabilization Solution AM7020
Starter Pack
RNaseZap® Wipes AMO786
RT-PCR Grade Water (nuclease-free) AM9935
Silencer® Validated siRNA, Std Purity AM51331
One of the following RNA sample preparation products:
¢ RNAqueous®-4PCR Kit AM1914
Note: Recommended if you are isolating RNA from cells
or tissues that may be difficult to disrupt or have high
RNase activity.
¢ RiboPure™ Kit AM1924
Note: Recommended if you are:
— Isolating RNA from all tissues, including those that
may be difficult to disrupt, are rich in lipids, or have
high RNase activity
or
— Labeling and amplifying RNA for use on microarrays.
e TURBO DNA-free™ AM1907
Note: Recommended if you are using SYBR® Green
reagents. If you are using SYBR Green reagents, use
TURBO DNA-free with the RiboPure Kit.
PCR Starter RT-PCR Grade Water (nuclease-free) AM9935
Pack
DNAZap™ AM9890
Choice of RNA sample preparation products, as listed See above
above under the qRT-PCR Starter Pack.
Notes
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Prepare the Template

Ambion
Kit Contents Catalog
Number
High RNAJater® Tissue Collection: RNA Stabilization Solution AM7020
Capacity
cDNA Kit RNaseZap® Wipes AMO9786
Choice of RNA sample preparation products, as listed See above
above under the qRT-PCR Starter Pack.
miRNA Pre-miR™ miRNA Starter Kit AM1540
Starter Pack

* For the samples, total RNA isolated from liver and kidney tissues
* For the standards, total RNA isolated from lung tissue

Note: Be sure to prepare template for both your samples and your standards.

* One of the following Applied Biosystems High-Capacity cDNA Reverse
Transcription Kits:

Kit Part Number
High-Capacity cDNA Reverse Transcription Kit (200 reactions) 4368814
High-Capacity cDNA Reverse Transcription Kit (1000 reactions) 4368813
High-Capacity cDNA Reverse Transcription Kit with RNase Inhibitor 4374966
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit with RNase Inhibitor 4374967
(1000 reactions)

Note: The High-Capacity cDNA Reverse Transcription Kit was formerly called the
High-Capacity cDNA Archive Kit.

Prepare the Use the High-Capacity cDNA Reverse Transcription Kit to reverse-transcribe cDNA
Template from the total RNA samples. Follow the procedures in the Applied Biosystems High-
Capacity cDNA Reverse Transcription Kits Protocol to:

1. Prepare the RT master mix.

I (oZ.\1[e]{] CHEMICAL HAZARD. 10X RT Buffer may cause eye, skin,

and respiratory tract irritation. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Notes
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Prepare the Sample Dilutions

Preparation When you prepare your own relative standard curve experiment, Applied Biosystems
Guidelines recommends:
» That you first extract DNA or RNA from the tissue or sample.
* The following templates:
— Complementary DNA (¢DNA) — cDNA reverse-transcribed from total RNA
samples using a High-Capacity cDNA Reverse Transcription Kit.
— RNA - Purified total RNA or mRNA extracted from tissue or sample.

— Genomic DNA (gDNA) — Purified gDNA already extracted from tissue or
sample.

For More For more information on:

Information » Preparing cDNA templates — Refer to the Applied Biosystems High-Capacity cDNA 3
Reverse Transcription Kits Protocol. The protocol is not shipped with the High-
Capacity cDNA Reverse Transcription Kits. You can download the protocol from:

http://docs.appliedbiosystems.com/search.taf

» Preparing RNA or gDNA templates — Refer to the protocol for the purification
reagents that you select. To locate Applied Biosystems purification reagents, visit:

http://www.appliedbiosystems.com/

Prepare the Sample Dilutions

Perform sample dilutions before adding the samples to the final reaction mix. Dilute the
samples using the volumes that were calculated by the 7500 software (“To complete the
Sample Dilution Calculations tab:” on page 40).

About the For the relative standard curve example experiment:

Exe_tmple » Sample dilutions are necessary because the sample volume is limited to 10% of the
Experiment total reaction volume in the 7500 software. Because the total reaction volume is
50 uL/reaction, the sample volume is 5 uL/reaction.

* The stock sample concentration is 100 ng/uL. After diluting the sample according to
the Sample Dilutions Calculations table, the sample has a concentration of
50 ng/uL. Adding 17 uL at this concentration to the final reaction mix volume of
34 uL yields a 1X concentration in the final reaction.

¢ The volumes calculated in the software are:

Stock Sample Diluent Total Volume
Sample Name Concentration of Diluted
(ng/pL) Volume (pL) | Volume (L) Sample (uL)
Liver 100.0 17.0 17.0 34.0
Kidney 100.0 17.0 17.0 34.0
Notes
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Prepare the Sample Dilutions

Required + Water (to dilute the sample)
Materials + Microcentrifuge tubes

* Pipettors

* Pipette tips

* Sample stock

* Vortexer

* Centrifuge

—
.

Prepare the Label a separate microcentrifuge tube for each diluted sample:
Sample Dilutions o Liver

* Kidney

2. Add the required volume of water (diluent) to each empty tube:

Diluent Volume

Tube Sample Name
P (bL)
1 Liver 17.0
2 Kidney 17.0

3. Add the required volume of sample stock to each tube:

Sample Volume

Tube Sample Name

“ P (bL)
1 Liver 17.0
2 Kidney 17.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Preparation When you prepare your own relative standard curve experiment:

Guidelines » Sample dilutions may be necessary because the sample volume is limited to 10% of
the total reaction volume in the 7500 software. You must perform the sample
dilutions before adding the samples to the final reaction mix.

+ For optimal performance of TagMan® Gene Expression Assays or Custom TagMan®
Gene Expression Assays, use 10 to 100 ng of cDNA template per 20-uL reaction.

» Use TE buffer or water to dilute the sample.

For More For more information on Applied Biosystems assays, refer to the:
Information » TagMan® Gene Expression Assays Protocol

» Custom TagMan® Gene Expression Assays Protocol.

Notes
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Prepare the Standard Dilution Series

Prepare the Standard Dilution Series

You prepare the standard dilution series using the volumes that were calculated by the 7500
software (“To complete the Reaction Mix Calculations tab for the c-myc assay” on page 37
and “To complete the Reaction Mix Calculations tab for the GAPDH assay” on page 38):

About the For the relative standard curve example experiment:
Exa_lmple * The standard (stock) concentration is 100 ng/uL.
Experiment * The volumes calculated in the software for both the c-myc and GAPDH assays are:
Dilution Point Source Source Volume Diluent Volume Total Volume Standard Concentration
(Factor) (uL) (L) (uL) (ng/pL)
1 (200) Stock 8.07 12.10 20.17 40.0 2
2 (20) Dilution 1 2.02 18.15 20.17 4.0
3@ Dilution 2 | 2.02 18.15 20.17 0.4
4(0.2) Dilution 3 2.02 18.15 20.17 0.04
5(0.02) Dilution 4 2.02 18.15 20.17 0.004
Required Water (to dilute the standards)
Materials Microcentrifuge tubes
Pipettors
Pipette tips
Standard stock
Vortexer
Centrifuge
Prepare the 1. Label a separate microcentrifuge tube for each standard:
Standar_d Dilution e c-myc Std. 1
i?:%scfxgégs e c-myc Std. 2
* c-myc Std. 3
* c-myc Std. 4
e c-myc Std. 5
Notes
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Prepare the Standard Dilution Series

2. Add the required volume of water (diluent) to each empty tube:

Tube Standard Name Volume of Diluent to Add (pL)
1 c-myc Std. 1 12.10
2 | c-myc Std. 2 | 18.15
3 c-myc Std. 3 | 18.15
4 c-myc Std. 4 18.15
5 c-myc Std. 5 18.15

3. Inthe c-myc Std. 1 tube:
a. Vortex the stock for 3 to 5 seconds, then centrifuge the tube briefly.
b. Using a new pipette tip, add 8.07 puL of stock to the c-myc Std. 1 tube.
c. Vortex Std. 1 for 3 to 5 seconds, then centrifuge the tube briefly.
4. In the c-myc Std. 2 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 1 to the c-myc Std. 2 tube.
b. Vortex Std. 2 for 3 to 5 seconds, then centrifuge the tube briefly.
5. In the c-myc Std. 3 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 2 to the c-myc Std. 3 tube.
b. Vortex Std. 3 for 3 to 5 seconds, then centrifuge the tube briefly.
6. Inthe c-myc Std. 4 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 3 to the c-myc Std. 4 tube.
b. Vortex Std. 4 for 3 to 5 seconds, then centrifuge the tube briefly.
7. Inthe c-myc Std. 5 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 4 to the c-myc Std. 5 tube.

b. Vortex Std. 5 for 3 to 5 seconds, then centrifuge the tube briefly.

8. Place the standards on ice until you prepare the reaction plate.

Prepare the 1. Label a separate microcentrifuge tube for each standard:
Standard Dilution « GAPDH Std. 1

GAPDH Assay
e GAPDH Std. 3
e GAPDH Std. 4
e GAPDH Std. 5
Notes
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Prepare the Standard Dilution Series

2. Add the required volume of water (diluent) to each empty tube:

Tube Standard Name Volume of Diluent to Add (uL)

1 GAPDH Std. 1 12.10
2 | GAPDH Std. 2 | 18.15
3 GAPDH Std. 3 | 18.15
4 GAPDH Std. 4 18.15
5 GAPDH Std. 5 18.15

3. In the GAPDH Std. 1 tube:

a. Vortex the stock for 3 to 5 seconds, then centrifuge the tube briefly. 3

b. Using a new pipette tip, add 8.07 puL of stock to the GAPDH Std. 1 tube.
c. Vortex Std. 1 for 3 to 5 seconds, then centrifuge the tube briefly.

4. Inthe GAPDH Std. 2 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 1 to GAPDH Std. 2 tube.

b. Vortex Std. 2 for 3 to 5 seconds, then centrifuge the tube briefly.

5. In the GAPDH Std. 3 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 2 to the GAPDH Std. 3 tube.
b. Vortex Std. 3 for 3 to 5 seconds, then centrifuge the tube briefly.

6. Inthe GAPDH Std. 4 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 3 to the GAPDH Std. 4 tube.

b. Vortex Std. 4 for 3 to 5 seconds, then centrifuge the tube briefly.

7. In the GAPDH Std. 5 tube:
a. Using a new pipette tip, add 2.02 pL of dilution 4 to the GAPDH Std. 5 tube.
b. Vortex Std. 5 for 3 to 5 seconds, then centrifuge the tube briefly.

8. Place the standards on ice until you prepare the reaction plate.

Preparation When you prepare your own relative standard curve experiment:
Guidelines » Standards are critical for accurate analysis of run data.

* Any mistakes or inaccuracies in making the dilutions directly affect the quality of
results.

* The quality of pipettors and tips and the care used in measuring and mixing
dilutions affect accuracy.

* Use TE buffer or water to dilute the standards.

Notes
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Prepare the Reaction Mix

You prepare the reaction mix using the components and volumes that were calculated by
the 7500 software (“To complete the Reaction Mix Calculations tab for the c-myc assay”
on page 37 and “To complete the Reaction Mix Calculations tab for the GAPDH assay”
on page 38).

Note: The software calculates the volumes for all components for the PCR reactions.
However, when you prepare the reaction mix in this section, include only the master mix,
assay mix, and water. Add the sample or standard when you prepare the reaction plate
(see “Prepare the Reaction Plate” on page 60).

About the For the relative standard curve example experiment:
Exa_mple * The reaction mix components are:
Experiment — TaqMan® Universal PCR Master Mix (2X)
— c-myc Assay Mix (20X)
— GAPDH Assay Mix (20X)
— Water
* The volumes calculated in the software for both target assays are:

Component Vo‘:ug; Zg:—o)r:or
Master Mix (2.0X) | 25.0
Assay Mix (20.0X) 25
Water 17.5
Total Volume 45.0

Note: The sample or standard is not added at this time.

Required * Microcentrifuge tubes
Materials . Pipettors

* Pipette tips
» Reaction mix components (listed above)
* Centrifuge

Notes

58 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments



Chapter 3 Prepare the Relative Standard Curve Reactions m
Prepare the Reaction Mix

Prepare the IMPORTANT! Prepare the reaction mix for each target assay separately.

Reaction Mix
A (JX111[e]{] CHEMICAL HAZARD. TagMan® Universal PCR Master Mix

may cause eye and skin irritation. Exposure may cause discomfort if swallowed or
inhaled. Read the MSDS, and follow the handling instructions. Wear appropriate
protective eyewear, clothing, and gloves.

1. Label an appropriately sized tube for each reaction mix:
* c-myc Reaction Mix
* GAPDH Reaction Mix

2. For the c-myc assay, add the required volumes of each component to the c-myc 3
Reaction Mix tube:
Volume (uL) for 24
Component f;'O:uFTeZg:g n Reactions

Plus 10% Excess

TagMan® Universal PCR Master Mix (2X) 25.0 660.0

c-myc Assay Mix (20X) 2.5 66.0

Water 17.5 462.0

Total Reaction Mix Volume 45.0 1188.0

3. For the GAPDH assay, add the required volumes of each component to the GAPDH
Reaction Mix tube:

Component fc:io:u';'; eac(:%:gn Volu;:;g;:g:g ra

Plus 10% Excess
| TagMan® Universal PCR Master Mix (2X) 25.0 660.0
GAPDH Assay Mix (20X) 25 66.0
Water 17.5 462.0
Total Reaction Mix Volume 45.0 1188.0

4. Mix the reaction mix in each tube by gently pipetting up and down, then cap each
tube.

5. Centrifuge the tubes briefly to remove air bubbles.

6. Place the reaction mixes on ice until you prepare the reaction plate.

Notes
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Preparation When you prepare your own relative standard curve experiment:

Guidelines » If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.

* Include excess volume in your calculations to provide excess volume for the loss
that occurs during reagent transfers. Applied Biosystems recommends an excess
volume of at least 10%.

* Include all required components.
* Prepare the reagents according to the manufacturer’s instructions.

» Keep the assay mix protected from light (in the freezer) until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.

* Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When the samples are thawed,
resuspend the samples by vortexing, then centrifuge the tubes briefly.

For More For more information on preparing the reaction mix, refer to the protocol appropriate for
Information the reagents you are using in the PCR reactions:

» TagMan® Gene Expression Assays Protocol

 Custom TagMan® Gene Expression Assays Protocol

Prepare the Reaction Plate

You prepare the reactions for each replicate group, then transfer them to the reaction plate
using the plate layout displayed in the 7500 software.

About the For the relative standard curve example experiment:

Exa_lmple + A MicroAmp® Optical 96-Well Reaction Plate is used.
Experiment * The reaction volume is 50 pL/well.
» The reaction plate contains:

— 12 Unknown wells

— 30 Standard wells [

— 6 Negative control wells []

— 48 Empty wells

» The plate layout that is automatically generated by the 7500 software is used:

Notes
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2 ]z [ o« [ s [ s [ 7 [ e [ & [ 10 [ 11 [ 1z |

Civer Civer o Civer Civer Civer
o [eme  [eme [eme [JBAPDH [[]GAPDH [ GAPDH [fjeme [ cme meme [ e2FoH [ eFor [ eart
7.39 8.13 0.47 0.44 0.43
Kidney Kidney Kidney Kidney Kidney Kidney g~ |@=~ g~ |ge~ |gem |gem
y n . GAPDH GAPDH GAPDH
gl@em @em~ @~ m m m ]

5.32 41 3.76 0.44 0.43 0.43 200 200 200 20 20 20

c-mye c-mye c-mye c-mye c-mye c-mye c-mye c-mye c-mye GAPDH GAPDH GAPDH
S| S| S| S| S| S| S| S| S| S| S| S|

5 5 5

2 2 2

0.2 0.2 0.2 0.02 0.02 0.02 200 200 200

D GAPDH GAPDH GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH D GAPDH
4 4 4
2 2 2

20 20 20 0.2 0.2 0.2 0.02 0.02 0.02

wells: [ 12 Unknown [ 30 Standard [1] 6 Negative Control 48 Empty

Required  Microcentrifuge tubes
Materials « Pipettors
* Pipette tips
* c-myc reaction mix (from page 59)
* GAPDH reaction mix (from page 59)
* Water
* c-myc standards (from page 55)
* GAPDH standards (from page 56)
o Samples (from page 54)
+ MicroAmp® Optical 96-Well Reaction Plate
+ MicroAmp"" Optical Adhesive Film
* Centrifuge

Prepare the 1. For each target, prepare the negative control reactions:

Reaction Plate a. To an appropriately sized tube, add the volumes of reaction mix and water

listed below.
. . Reaction Mix | Water Volume
Tube Reaction Mix Volume (L) (uL)
1 c-myc reaction mix 59.4 6.6

2 GAPDH reaction mix 59.4 6.6

b. Mix the reaction by gently pipetting up and down, then cap the tube.
c. Centrifuge the tube briefly to remove air bubbles.

d. Add 50 pL of the negative control reaction to the appropriate wells in the
reaction plate.

Notes
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2. For each replicate group, prepare the standard reactions:

a. To appropriately sized tubes, add the volumes of reaction mix and standard

listed below.

Tube @ Standard Reaction Reaction Mix Reaction Mix Volume (uL) Standard Standa(fl-;lolume
1 c-myc Std 1 c-myc reaction mix 148.5 c-myc Std 1 16.5
2 c-myc Std 2 c-myc reaction mix 148.5 c-myc Std 2 16.5
3 c-myc Std 3 c-myc reaction mix 148.5 c-myc Std 3 16.5
4 c-myc Std 4 c-myc reaction mix 148.5 c-myc Std 4 16.5
5 c-myc Std 5 c-myc reaction mix 148.5 c-myc Std 5 16.5
6 GAPDH Std 1 GAPDH reaction mix 148.5 GAPDH Std 1 16.5
GAPDH Std 2 GAPDH reaction mix 148.5 GAPDH Std 2 16.5
8 GAPDH Std 3 GAPDH reaction mix 148.5 GAPDH Std 3 16.5
9 GAPDH Std 4 GAPDH reaction mix 148.5 GAPDH Std 4 16.5
10 GAPDH Std 5 GAPDH reaction mix 148.5 GAPDH Std 5 16.5
b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.
d. Add 50 pL of the standard reaction to the appropriate wells in the reaction plate.
3. For each replicate group, prepare the reactions for the unknowns:
a. To appropriately sized tubes, add the volumes of reaction mix and sample listed
below.
Tube | Unknown Reaction Reaction Mix Reaction Mix Volume (uL) Sample Sample Volume (uL)
1 c-myc Liver c-myc reaction mix 148.5 Liver 16.5
2 c-myc Kidney c-myc reaction mix 148.5 Kidney 16.5
3 GAPDH Liver GAPDH reaction mix 148.5 Liver 16.5
4 GAPDH Kidney GAPDH reaction mix 148.5 Kidney 16.5
b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.
d. Add 50 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.
4. Seal the reaction plate with optical adhesive film.
Notes
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Prepare the Reaction Plate

5. Centrifuge the reaction plate briefly to remove air bubbles.

6. Verify that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block and cause an abnormally high background signal.

Correct Incorrect

' ‘ :
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. | o Not centrifuged for enough time

7. Until you are ready to perform the run, place the reaction plate on ice in the dark.

Preparation When you prepare your own relative standard curve experiment:
Guidelines * Make sure you use the appropriate consumables.

» Make sure the arrangement of the PCR reactions matches the plate layout displayed
in the 7500 software. You can either:

— Accept the plate layout automatically generated by the software.
or
— Use Advanced Setup to change the plate layout in the software.
+ If you use optical adhesive film, seal each reaction plate as follows:

a. Place the reaction plate onto the center of the 96-well base.
b. Load the reaction plate as desired.

c. Remove a single optical adhesive film (film) from the box.

Fold back one of the end-tabs. Hold the film with its
backing side up.

d. In one continuous movement, peel back the white
protective backing from the center sealing surface. Do not
touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may result in
haziness, but does not affect results. Haziness disappears when the film comes
into contact with the heated cover in the instrument.

Notes
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e. While holding the film by the end-tabs, lower the film onto
the reaction plate (adhesive side facing the reaction plate). .
Be sure the film completely covers all wells of the reaction o
plate.

f.  While applying firm pressure, move the applicator slowly _
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the
reaction plate.

g. While using the applicator to hold the edge of the film in
place, grasp one end of the end-tab and pull up and away -
sharply. Repeat for the other end-tab. S

h. Repeat step fto ensure a tight, evaporation-free seal. While
applying firm pressure, run the edge of the applicator
along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight seal.

i. Inspect the reaction plate to be sure all wells are sealed. You should see an
imprint of all wells on the surface of the film.

For More For more information on:
Information * Preparing the reaction plate — Refer to the protocol appropriate for the reagents you
are using in the PCR reactions:
— TagMan® Gene Expression Assays Protocol
— Custom TagMan® Gene Expression Assays Protocol
* Consumables — See “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout — See “Advanced Setup
Workflow” on page 204.

Notes
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n Run the Relative Standard Curve
Experiment

This chapter covers:

B Chapter OVEIVIBW . . . o\ttt ettt e e e e e e e e ettt 66
B Prepareforthe Run....... ... ... ... . . . . . 67
B Enable the Notification Settings (Optional) . . ........... ... ... ovi... 69
B Startthe Run........ ... ... . 71
B Monitorthe Run .. ... ... ... . . 72
B Unloadthe Instrument . .............. . . . .. i, 74

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems 7500/7500 Fast
Real-Time PCR System.

Example Start Relative Standard Curve Experiment
Experiment v
Workflow i i
or Design the Experiment (Chapter 2)
h 4
Prepare the Experiment (Chapter 3)
h 4

Run the Experiment (Chapter 4)
. Prepare for the run.
. (Optional) Enable the notification settings.
. Start the run.

. Monitor the run.

a W N =

. Unload the instrument.

h 4
Analyze the Experiment (Chapter 5)

v
End Experiment

Notes
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Prepare for the Run

Prepare for the Run

You prepare for the run by opening the example experiment file you created in Chapter 2,
then loading the sealed reaction plate into the 7500/7500 Fast instrument.

Open the 1. Double-click g (7500 software) or select Start » All Programs »
Example Applied Biosystems » 7500 Software » <software name>

Experiment where <software name> is the current version of the 7500 software.

2. In the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default) at:

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click the example experiment file that you created in Chapter 2.

& 7500 Software v2.0
File Edit Instrument Analysis Tools Help

2 TR - BN Close | 4@ Expoit. - B PrintReport

Run Analyze

Design Wizard QuickStart Analyze Experiment

Advanced Setup Create Study

Template

[ 7500 : connected I

Notes
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Prepare for the Run

Load the AWARNING PHYSICAL INJURY HAZARD. During operation, the sample

Reaction Plate block can be heated to 100 °C. Before performing the following procedure, be sure to
into the  wait until the sample block reaches room temperature.
Instrument

(gg‘-. E'"‘\ﬁ‘j IMPORTANT! Wear powder-free gloves when you handle the reaction plate.

1

';, =
-‘\" )
\%ﬁﬁ 1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

7500 system 7500 Fast system

Load standard plates with Load Fast plates with the
the notched A12 position at notched A1 position at the
the top-right of the tray. top-left of the tray.

3. Place the reactions in the precision plate holder (PPH). If you use:

* A reaction plate — Place the reaction plate in the PPH with well A1 at the
back-left corner.

* Reaction tube strips — Place the tube strips in the PPH for tube strips.

Note: Fast Reaction 8-tube strips can be used only on the 7500 Fast system.
For the 7500 system, use MicroAmp® Optical 8-Tube Strips.

Notes
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Enable the Notification Settings (Optional)

¢ Reaction tubes — Place the tubes in the PPH.

Note: MicroAmp® Fast Reaction Tubes (PN 4358297) cannot be used in the
7500 Fast system.

IMPORTANT! For optimal performance with partial loads:

For a 7500 Instrument

Load at least 16 tubes, arranging them first in the center columns of the
instrument system (columns 6 and 7). Move outward towards columns 1 and 12
as you add more tubes.

For a 7500 Fast Instrument

* Place empty tube strips in columns 1 and 12 to prevent crushing of tubes
containing samples.

* Place tube strips with samples in the PPH vertically, starting in columns 6
and 7 and moving outward.

* A maximum of 6 tube strips can be used in the 7500 Fast system. Leave
columns 2, 3, 10, and 11 empty.

4. Close the tray door. Apply pressure to the right side of the tray and at an angle.

Enable the Notification Settings (Optional)

Enable the notification settings so that the 7500 software alerts you by email when the
7500/7500 Fast instrument begins and completes a run, or if an error occurs during a run.
Enabling the notifications settings is optional and does not affect the performance of the
7500/7500 Fast system or the duration of the run.

IMPORTANT! The notification settings feature is available only if the computer that you are
using is running the 7500/7500 Fast instrument and is connected to an Ethernet network.

About the In the example experiment:

Exa_lmple » The 7500 software is set up to send notifications to three users (scientist, supervisor,
Experiment and technician at mycompany.com) when the 7500/7500 Fast system ends the run
and if it encounters any errors during operation.
* The example SMTP server (smtp.mycompany.com) is set up for secure sockets layer
(SSL) encryption and requires authentication for use.
Notes
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7a

7b
7c

Notes

Set Up the 1. Inthe 7500 software, click
Notification
Settings

Enable the Notification Settings (Optional)

Run in the navigation pane.
Click [Z Notification Settings.

Select Yes for Enable Notifications.

0N

Select the events that will generate notifications:
a. Select Instrument Error.

b. Select Run Completed.

5. In the Enter e-mail addresses for notifications field, enter:
scientist@mycompany.com, supervisor@mycompany.com,
technician@mycompany.com.

6. In the Outgoing Mail Server (SMTP) field, enter smtp.mycompany.com.

7. Set the authentication settings:
a. Select Yes for Server requires authentication.
b. In the User Name field, enter Example User.

c. In the Password field, enter password.

Notification Settings

| ——
Enable Motifications: @& ¥es O No

’7 Selectthe events to generate notifications: Instrument Error

[]Run Started
L [¥] Run Completed

Enter e-mail addresses for notifications:  scientist@mycompany com, superisor@mycompany.com, technician@rmycompany com
Separate e-mail addresses with commas
For examnple: jane_smith@mydomain.com,awona@bigmailhost. com

Outgoing Mail Server (SMTP) ‘ smtp.mycompany.com
Forexample: smtp.mycompany.com

Server requires an encrypted connection? Cves (@ No

Server requires authentication? (l)Yes O No

(Semnver Authentication) User Name ‘ Example User ‘

(Server Authentication) Passwoard \ ““““““““ \

70
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Start the Run

Run Guidelines When you set up the 7500/7500 Fast system for automatic notification:

* Your system must be set up for network use. Refer to the Applied Biosystems 7500/7500
Fast Real-Time PCR System Maintenance Guide.

» Select the events for which you want to receive e-mail notifications. Select:

— Instrument Error — To notify recipients by email of all errors encountered by
the instrument during each run.

— Run Started — To notify recipients by email when the instrument starts a run.

— Run Completed — To notify recipients by email when the instrument completes a
run.

* Obtain e-mail addresses of those whom you want to be notified.

IMPORTANT! Separate addresses with a comma (,).

* Contact your systems administrator or information technology department if you
need:

— The e-mail addresses of users who will receive notifications

— A network address for a simple mail transfer protocol (SMTP) server on the local
area network (LAN)

— A user name and password for the server, if required for access
— The Secure Sockets Layer (SSL) setting of the server (on or off)

Start the Run

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not create
experiments, perform maintenance, or allow the computer to run antivirus software or to
enter hibernation mode. Performing such activities while the instrument is running an
experiment will cause gaps in data collection.

To start your 7500/7500 Fast instrument:
1. In the 7500 software, click T’iﬁ Run in the navigation pane.

2. Click START RUN .

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve (4
and Comparative C; Experiments




n Chapter 4 Run the Relative Standard Curve Experiment
Monitor the Run

Monitor the Run

You can view the progress of the run in real time as described below. During the run,
periodically view all three available plots from the 7500 software for potential problems.

To... Action

Stop the run 1. In the 7500 software, click STOP RUN.

2. In the Stop Run dialog box, click one of the following:
— Stop Immediately to stop the run immediately.

— Stop after Current Cycle/Hold to stop the run after the
current cycle or hold.

— Cancel to continue the run.

View amplification data | Select M Ampilification Plot.

in real time See “About the Amplification Plot Screen” on page 72.

View progress of the Select |: Run Method.

run in the Run Method See “About the Run Method Screen” on page 73.
screen

Enable/disable the Select or deselect Enable Notifications.

Notification Settings See “Enable the Notification Settings (Optional)” on page 69.

About the Amplification Plot Screen

This screen displays sample amplification as your instrument collects fluorescence data
during a run. If a method is set up to collect real-time data, the Amplification Plot screen
displays the data for the wells selected in the View Plate Layout tab. The plot displays
normalized dye fluorescence (ARn) as a function of cycle number. The figure below
shows the Amplification Plot screen as it appears during the example experiment.

To view data in the Amplification Plot screen, select the wells that you want to view in
the View Plate Layout tab.

Notes
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Monitor the Run
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The Amplification Plot screen helps you identify and examine abnormal amplification.
Abnormal amplification can include:

* Increased fluorescence in negative control wells.

» Absence of detectable fluorescence at an expected cycle (determined from previous
similar experiments that were run using the same reagents under the same
conditions).

If you notice abnormal amplification or a complete absence of florescence, troubleshoot
the error as explained in the 7500 Software Help (click @ or press F1).
About the Run Method Screen

This screen displays the method for the run in progress. The software updates the Run
Status field throughout the run. The figure below shows the Run Method screen as it
appears in the example experiment.

To... Action
A | Change the number of cycles In the Number of Cycles field, enter a number.
Apply your changes Click Save Run Method.
Notes
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Unload the Instrument

Run Method Edit Run Method

n Extending cycles is only
Holding Stage Holding Stage Cycling Stage allowed when the last

l:l stage is a cycling stage that
collects data

Extend # of Cycles: a0 A
Starting cycle: [ | v—|:| B

100 —|

75—

50 —| — i

25 —|

Step 1 Step 1 Step 1 Step 2
< b4
Legend ‘

Data Collection On Data Collection Off A AutoDelta On A AutoDelta Off

If an alert is displayed, click the error for more information, then troubleshoot the
problem as explained in the 7500 Software Help (click @ or press F1).

Unload the Instrument

When your 7500/7500 Fast instrument displays the Run Complete, unload the reaction
plate from the instrument.

Unload the AWARNING PHYSICAL INJURY HAZARD. During operation, the sample

Reaction Plate block can be heated to 100 °C. Before performing the following procedure, be sure to
wait until the sample block reaches room temperature.

1. Push the tray door to open it.
2. Remove the calibration plate.

3. Push the tray door to close it.

Notes
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Chapter 5

Analyze the Relative Standard
Curve Experiment

This chapter covers:

B Chapter OVEIVIEW . . . .ottt ettt e et e e e ettt 76
Section 5.1 ReviewResults............coiiiiiiiiiiiiiiiiiiiiiiinenenn. 77
B Analyze the Experiment .. ............. . . it 78
B View the Standard Curve . ....... ... ... 82
B View the Amplification Plot. . ........ .. ... .. .. . .. . .. 85
B View the Gene Expression Plotand Well Table . . ......................... 93
B Publishthe Data ....... ... ... . . . . 97
Section 5.2 Troubleshoot (If Needed) ........ccciviiiiiiiiiiiiieneennenns 99
B View the Analysis Settings . . ........... .ot 100
B View the QC SUMMAry. . . .....ot ittt et e 103
B Omit Wells from the Analysis. .......... ... ... . .. 105
B View the Multicomponent Plot. .............. ... ... ... .. ... ....... 107
B Viewthe Raw DataPlot . ...... ... .. ... .. . . 109

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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Chapter Overview

Chapter Overview

The 7500 software analyzes the data using the relative standard curve quantitation
method. Section 1 of this chapter explains how to review the analyzed data using several
of the analysis screens and how to publish the data. Section 2. If you obtain questionable
results, Section 2 of this chapter explains how to perform some troubleshooting.

Note: The relative standard curve example experiment includes three flagged wells. The
flags indicate common problems that you may encounter when performing your own
experiments. Procedures are provided for viewing the flags and omitting one of the wells.

Example Start Relative Standard Curve Experiment
Experiment v
Workflow Design the Experiment (Chapter 2)

A 4
Prepare the Reactions (Chapter 3)

v
Run the Experiment (Chapter 4)

v
Analyze the Experiment (Chapter 5)

Section 1, Review Results:

1. Analyze.

2. View the standard curve.

3. View the amplification plot.

4. View the gene expression plot/results table.
5. Publish the data.

Section 2, Troubleshoot (If Needed):

1. View the analysis settings; adjust the baseline/threshold.

2. View the quality summary.

3. Omit wells.

4. View the multicomponent plot.

5. View the raw data plot.

A 4
End Experiment

Notes
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Section 5.1 Review Results

Section 5.1 Review Results

This section covers:

B Analyze the Experiment .. .............. ... i 78
B Viewthe Standard Curve . ......... ... . .. .. 82
B View the Amplification Plot. .. ...... .. .. .. . . 85
B View the Gene Expression Plotand Well Table . . ......................... 93
B Publishthe Data ......... .. ... . . . . . 97
Notes
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Analyze the Experiment

Notes

78

About the
Example
Experiment

Analyze the
Example
Experiment

The 7500 software analyzes the experiment and displays results in the analysis screens
(for example, the Amplification Plot screen, QC Summary screen, and so on).

For the relative standard curve example experiment, use the data file that is installed with
the 7500 software. The data file was created with the same design parameters that are
provided in Chapter 2, then run and analyzed on a 7500/7500 Fast instrument.

The data file for the example experiment is on your computer at:

<drive>:\Applied Biosystems\<sofiware name>\experiments\
Relative Standard Curve Example.eds

where:

5.

<drive> is the computer hard drive on which the 7500 software is installed.
<software name> is the current version of the 7500 software.

. Double-click 3 (7500 software) or select Start » All Programs »

Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.
In the Home screen, click Open.

In the Open dialog box, navigate to the experiments folder at:

<drive>:\Applied Biosystems\<software name>\experiments\

Double-click Relative Standard Curve Example.eds to open the example experiment.

Note: The examples folder contains several data files; be sure to select Relative
Standard Curve Example.eds.

L] Open

Lookin: [2) experiments b IETII:-'-HEIE

O Comparative Ct Example.eds

Comparative Ct Study Example (Biological Groups).edm
Comparative Ct Study Example. 2dm

Genotyping Example.eds

Presence Absence Example.eds

Relative Standard Curve Example.2ds

Standard Curve Example.eds

E

My Recent
Documents

Desktop

a
a
a
a
3
a

L-'

My Documents

My Computer

&

File name | | open |

My Network y
Places Files oftype:  |A)l SDS Files (edm: eds; edt sdm; sds; sc) LS | cancel |

Click Analyze. The software analyzes the data using the default analysis settings.
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Analyze the Experiment

6. See “Navigation Tips” on page 80 for information on navigating within the analysis
screens.

Preparing the The example file contains a single outlier (well A9) that has been omitted from the
Experiment for analysis for you. To use the experiment file with this chapter, you must include the well
Review and reanalyze the experiment.

1. Select the View Plate Layout tab, then select the outlier well that is marked (well A9).
2. Right-click well A9, then select Include.

3. Click Analyze. The software analyzes the data using the default analysis settings.

1 s View Plate LayoutT View Well Table ]
Selectwelis With: |- Selectfem- v [ o
| B showinwelis ¥ I BT View Legnd I B I BE I
outlier
9 10 11 12
i
Zoom In
Zoom Cut .
Fit Plate
Full Screen
Omit
|: Include 2
Save As... -
Print Preview...
Print...
_ 5
3
6
H
wells: [f] 12 Unknown [5] 30 Standard [1] 6 Negative Control 48 Empty
Notes
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Guidelines When you analyze your own relative standard curve experiment:

+ Immediately after a run, the 7500 software automatically analyzes the data using the
default analysis settings, then displays the Amplification Plot screen on your computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.
Navigation Tips How to Select Wells
To display specific wells in the analysis screens, select the wells in the View Plate Layout tab:

1. To select wells of a specific type in the Select Wells With drop-down list, select
Sample, Target, or Task, then select the sample, target, or task name.

A

To select a single well, click the well in the plate layout.

w

To select multiple wells: Click-drag over the desired wells, or CTRL+click or
Shift+click the desired wells in the plate layout.

4. To select all 96 wells, click the upper left corner of the plate layout.

> [ View Plate Layout | View el Table | [ [ 1

| I
SelectWells With: - Selecttem - v | 2o

| NShumealls v I

E| View Legend I

o

wells: [0 12 Unknown [5] 30 Standard [ 6 MNegative Control 48 Empty

Notes
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Analyze the Experiment

How to Display Multiple Plots

1. In the navigation pane, select Analysis » Multiple Plots View.

. To display four plots, click 5 (Show plots in a 2 X 2 matrix).

2

3. To display two plots in rows, click — (Show plots in two rows).

4. To display two plots in columns, click [|[| (Show plots in two columns).
5

. To display a specific plot, select the plot in the drop-down list above each plot
display.

5 23

Mutipi Plots View D, |

Bl m——4
I—
Amplification Plot - ARnvs Cycle v Muticomponent Plot v
P pal BB

Multicomponent Plot
Amplification Plot

2,000,000

1000000|
al
a 2 4 &

Fluarescence

’;‘f‘u E.B .D {.‘L::x .FAM
5
‘Standard Curve v [gene Expression Plot -
iy & IS iy 2 =
Standard Curve RQ vs Sample
i -m ;__,::::—:-1?_—_::::_—;;;___{_7__: 5 5‘
. Bk it £3 o
P— & >
Legernd Sample
n Standard ™1 Unknown Lagent
|V. Unknown (Flagged) ’ic-mvt
Notes
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View the Standard Curve

About the
Example
Experiment

View the
Standard Curve

The Standard Curve screen displays the standard curve for samples designated as
standards. The 7500 software calculates the quantity of an unknown target from the
standard curve.

In the relative standard curve example experiment, you review the Standard Curve screen
for the following values:

Slope/amplification efficiency
R? value (correlation coefficient)

C; values

. In the navigation pane, select Analysis » Standard Curve.

Note: If no data are displayed, click Analyze.

Display all 96 wells in the Standard Curve screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

In the Plot Settings tab, select All in the Target drop-down list (default).

In the Plot Settings tab, select Default in the Plot Color drop-down list.

Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

6. View the values displayed below the standard curve. In the example experiment, the
values for each target are within the acceptable ranges:
Amplification
2 2

Target Slope Y-Inter R< Value Efficiency (Eff%)

GAPDH -3.506 27.226 0.999 92.853

c-myc -3.696 23.82 0.998 86.438
Notes
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View the Standard Curve

7. Check that all samples are within the standard curve. In the example experiment, all
samples (blue dots) are within the standard curve (red dots).

4

w

Plot
Target |All \lt Flot Color Default ~|n
L
Standard Curve
325
20.0
7.5
7
25.0
5
225
200
17.5
15.0
0.01 0.02 0.1 0.2 1 2 a 4 5 10 20 30 100 200 100C
Quantity
6 0 Taraet: GAPDH Slope: -3.506 Y-Inter: 27.226 r2- 0.999 Eff%: 92.853 i
Legend
{. standard [l Uninown [l Unknown (Flagged) = 5
8. Check the C; values:
a. Select the View Well Table tab.
b. In the Group By drop-down list, select Replicate.
c. Look at the values in the C; column. In the example experiment, the C values
are within the expected range (>8 and <35).
8‘a
> View Piate Layout | View Well Table |
8b | SelectWells with: | Select e - ||
| Show in Table ¥ | Group By ¥ | Expand Al | ) colrapse an |
: ‘ 8c
# | well omit | Flag Sample MNa TargetMame = Task Dyes (efip CT Mean CTSD Quantity Mormaliz..  Mormaliz...
= GAPCH - NTC A
1 Ad | GAPDH NTC FAM-NFQ-MGBE Undetermined
2 AS | GAPDH NTC FAM-NFQ-MGBE Undetermined
3 AR ] GAPDH NTC FAM-NFQ-MGB Undetermined A
= GAPDH - STANTARLD - 0.02 T
4 D10 [} GAPDH STAMDARD FAM-NFQ-MGB 33.15889 33.04322 01 0.02
E D11 l GAPDH STAMDARD FAM-NFQ-MGB 32.98368 33.04322 01 0.02
[ D12 [} GAPDH STAMDARD FAM-NFQ-MGB 32.98709 33.04322 01 0.02 -
= GAPDH - STANTARD - 0.2
7 D7 [} GAPDH STAMDARD FAM-NFQ-MGB 29.626238 29.70095 0.065 0.2
a8 De l GAPDH STAMDARD FAM-NFQ-MGB 29.729017 29.70095 0.065 02
9 Da [} GAPDH STAMDARD FAM-NFQ-MGB 29.747599 29.70095 0.065 02
= GAPDH - STANTARLD - 2.0
10 D4 [} GAPDH STAMDARD FAM-NFQ-MGBE 26.369404 26.396555 0.025 2
11 D5 l GAPDH STAMDARD FAM-NFQ-MGB 26.418335 26.396555 0.025 2
Notes
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Notes
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View the Standard Curve

Analysis When you analyze your own relative standard curve experiment, look for:

Guidelines

* Slope/amplification efficiency values — Calculated using the slope of the regression

line in the standard curve. A slope close to -3.3 indicates optimal, 100% PCR
amplification efficiency. Factors that affect amplification efficiency are the:

— Range of standard quantities — For more accurate and precise efficiency
measurements, use a broad range (10° to 10° fold) of standard quantities.

— Number of standard replicates — For more accurate efficiency measurements, include
replicates to decrease the effects of pipetting inaccuracies.

— PCR inhibitors — PCR inhibitors in the reaction can reduce amplification efficiency.

R? values (correlation coefficient) — A measure of the closeness of fit between the
regression line and the individual C; data points of the standard reactions. A value of
1.00 indicates a perfect fit between the regression line and the data points. An R? value
>().99 is desirable.

C; values — The PCR cycle number at which the fluorescence level equals the
threshold. A C; value >8 and <35 is desirable. A C; value <8 indicates that there is too
much template in the reaction. A C; value >35 indicates a low amount of target in the
reaction; for C; values >35, expect a higher standard deviation.

If your experiment does not meet the guidelines above, troubleshoot as follows:

* Omit wells (see “Omit Wells from the Analysis” on page 105).

or

* Rerun the experiment.

For More For more information on:

Information

* The Standard Curve screen — Open the 7500 Software Help by clicking @) or

pressing F1.

+ Amplification efficiency — Refer to the Amplification Efficiency of TagMan® Gene

Expression Assays Application Note.
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View the Amplification Plot

View the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected wells.
Three plots are available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence generated by the
reporter at each cycle during the PCR amplification. This plot displays ARn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence from the reporter dye normalized to the
fluorescence from the passive reference. This plot displays Rn as a function of cycle
number. You can use this plot to identify and examine irregular amplification.

* C;vs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays C as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be displayed as a linear or log10 graph.

About the In the relative standard curve example experiment, you review each target in the
Example Amplification Plot for:

Experiment ¢ Correct baseline and threshold values
¢ Qutliers

Notes
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View the Amplification Plot

View the Plot 1. Inthe navigation pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the GAPDH wells in the Amplification Plot screen:
a. Select the View Plate Layout tab.
b. In the Select Wells With drop-down lists, select Target, then GAPDH.

2a8————{ View Plate Layout | Viewwell Tabls | | I 2b

SelectWells Vith: \Targllc.-t ~ ‘GALDH E]

| ﬂshuwm Wells ¥ I E| View Legend I |

10

11 12
= ———

Wells m 12 Unknown E3D Standard |]s Megative Control 48 Empty

3. In the Plot Settings tab of the Amplification Plot:
a. In the Plot Type drop-down list, select ARn vs Cycle (default).
b. In the Plot Color drop-down list, select Well.
c. Click I~ (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes
to Hide the plot legend.

Notes
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View the Amplification Plot

4. View the baseline values (Plot Settings):
a. In the Graph Type drop-down list, select Linear.
b. Select the Baseline check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant fluorescence is detected. In
the example experiment, the baseline is set correctly.

3a 4da 3b

Plot
| I |
Plot Type: [ARn vs Cycle ¥ Graph Type: Lingar ¥ Plot Color:jwell ¥

Save current settings as the default

£ L aREIE1I—3

Amplification Plot

Legend

A B lc D Hc Hr Hc HH

{ Options )
Target [ [ Threshold: [Aute [ | [JAutoBaseline

Show: [¥] Threshold —Eﬁ_a_ge_\_\_ng__st_g_rﬁ Well B Target 4 Baseline End: Well B Target 4.

4b

Notes
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5. View the threshold values:
a. In Plot Settings tab, select Log in the Graph Type drop-down list.
b. Select GAPDH in the Target drop-down list.

. Select the Threshold check box to show the threshold (default).

0

o

. Verify that the threshold is set correctly. In the example experiment, the
threshold is in the exponential phase.

5a

Plot

Plot Type: ARn vs Cycle [¥ GraphType: PIotCoIor

Save current settings as the default

£ L almEE

Amplification Plot

0.01

=

] 0.001

0.0001

0.00001

0.000001

Leagend
{-A g llc Hp He Hr Hc HH

" Options )
5b Target: Threshold: [] Auto [+] Auto Baseline
5c how: [¥] Threshold — [#] Baseline Start: Well B Target ss  Baseline End: Well /B Target 4~
Notes
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View the Amplification Plot

6. Locate any outliers:
a. In the Plot Type drop-down list, select C vs Well.

b. Look for outliers in the amplification plot. In the example experiment, there are
no outliers for GAPDH.

7. Repeat steps 2 through 6 for the c-myc target. In the example experiment, there is
one outlier for c-myc (well A9). You omit this well in the troubleshooting section
(“Omit Wells from the Analysis” on page 105).

6a
Pampincasonpir |~
Plot i |
Flot Type |CTvsWEH J‘ GraphType:‘ | F\otCoIor:
R P g 2 =
100 Amplification Plot
-v
5 -¥ =
. -«n >
outlier a saem
-
° a 5 10 15 20 25 30 35 40 45 5
Well Mumber
Lagered
A e Mc WD He Hr e HWH
Options )
Target Thresho\d: [] Auta [¥] Auto Baseline
Show [] Threshold — [] Baseline Start Well M Target &« Baseline End: Well /B Target 4.
Notes
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Notes

90

Analysis When you analyze your own relative standard curve experiment, look for:

Guidelines

Outliers

A typical amplification plot — The 7500 software automatically calculates baseline
and threshold values based on the assumption that the data exhibit a typical
amplification plot. A typical amplification plot has four distinct sections:

a. Plateau phase

b. Linear phase

c. Exponential (geometric phase)
d. Baseline
10
1 ,_,/fp_ —— a
b
0.210658 e
o1 .Threshold
ARn ¢
0.01
0.001 y
[/
. / T
|'I | - i | I :
o.0001 a Izl 4 .!ml 1"2 ||4 I\.: -13 M .)) :ul z;“‘).-'z C R R T
d

Cycle

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the 7500 software. Therefore, Applied Biosystems
recommends that you examine the Amplification Plot screen and review the
assigned baseline and threshold values for each well after analysis is complete.

Correct baseline and threshold values — See “Threshold Examples” on page 91 and
“Baseline Examples” on page 92.
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Threshold Examples

Threshold Set Correctly 0

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum increase
the standard deviation of the replicate groups.

Task Dyas Ccr CT Mgan CT50 Chaintity Chaintity Chaintity Cammi
HTC FAM-NFG-.. Undeteimi_.

HTC FAM-HFQ-.. Undelemi..

NTG FAMEHFQ-.. Unadstami..

UNEMOWN FAMANFO-.. 2096287 28923796 0074 248431 2551476 1262
UREMOWH  FAM-NFO-.. 28838787 28823706 0074 2667054 2 EE14TE 1282
UNEHOWH FAM-NFO-. 2008572 20023708 0074 2473084 2551478 1282

Threshold Set Too Low

The threshold is set below the exponential phase of the
amplification curve. The standard deviation is significantly
higher than that for a plot where the threshold is set
correctly. Drag the threshold bar up into the exponential
phase of the curve.

Task Oyes cr CT Mean (= §-10] Quantsy Quantsy Quantsy
NTC FAN-HFG-... Undetermi..
NTG FAN-NFQ-.. Unasstedmi .
HTC FAM-NFO-.. 30453182 5
UNKNOWH FAM-NFQ-. 2285404 22761744 0252 2314852 24TI463 400435
UNENOWN FAM-NFQ. . 22478973 22781744 0252 28927722 2472483 400.43%
UNENOWN FAM-NFO- . 220854218 22781744 0252 2TdME  24T2483 400.435
Threshold Set Too High 0
The threshold is set above the exponential phase of the '
amplification curve. The standard deviation is significantly —

higher than that for a plot where the threshold is set '
correctly. Drag the threshold bar down into the
exponential phase of the curve.

Task Dyes cr Cr Mean CrED Ouantéy Ouantsy Cuantsy Comme =

HTC FAMCNFG-.. Undetemi.. =

HTG FAM-NFQ- Uncetemi

HTC FAMNFO-. Undstsmii_. 001 4
UNKNOWH FAM-NF-. 37681107 37.89507 0202 2571477 2860425 363775 !
UNSNOWH FAM-NFO-. 3737671  37.49507 0202 3360023 2280428  MITIE

UNSNOWH FAM-NFQ-. 37524395 37.49507 0202 2824187 2880435 353775

Notes
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Baseline Examples

Baseline Set Correctly

The amplification curve begins after the maximum
baseline.

Baseline Set Too Low

The amplification curve begins too far to the right of the
maximum baseline. Increase the End Cycle value.

Baseline Set Too High

The amplification curve begins before the maximum
baseline. Decrease the End Cycle value.

If your experiment does not meet the guidelines above:
* Omit wells (see “Omit Wells from the Analysis” on page 105).
or

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 100).

For More For more information on the Amplification Plot screen, open the 7500 Software Help by
Information clicking @) or pressing F1.

Notes
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View the Gene Expression Plot and Well Table

The Gene Expression Plot screen displays the results of relative quantitation calculations
in the gene expression profile. Two plots are available:

* RQ vs Target — Groups the relative quantitation (RQ) values by target. Each sample is
plotted for each target. You can display the plot on a linear, log10, Ln, or log?2 scale.

RQ vs Target

RO

o
o
o

Target

Legert
Kidney Liver

* RQ vs Sample — Groups the relative quantitation (RQ) values by sample. Each
target is plotted for each sample. You can display the plot on a linear, log10, Ln, or
log?2 scale.

RQ vs Sample

RO

Sample

Legernt
c-mye

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes

» The calculated threshold cycle (C;), normalized fluorescence (Rn), and quantity

values
* Flags
Notes
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About the
Example
Experiment

View the Gene
Expression Plot
and Tables

2a

In the relative standard curve example experiment, you review:

» Each target in the Gene Expression Plot screen for the expression level (or fold

change) of the target sample relative to the reference sample.
The Well Table to evaluate the precision of the replicate groups.

. In the navigation pane, select Analysis » Gene Expression.

Note: If no data are displayed, click Analyze.

. In the Gene Expression Plot screen:

a. In the Plot Type drop-down list, select RQ vs Sample.
b. In the Graph Type drop-down list, select Log10.

c. In the Orientation drop-down list, select Vertical Bars.

. Click i~ (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

In the example experiment, the expression level of c-myc in the liver sample is
displayed relative to its expression level in the reference sample (kidney). Because
the reference sample is compared to itself, the relative expression level is 1. When
the result is displayed in the Log10 graph type, the expression level of the reference
sample appears as 0 in the graph (log10 of 1 =0).

2b 2c

3

0.6

0.5

0.4

0.2

=]

log10 RO

0.0

-0.1

-0.2

-0.3

-0.4

Plot i
|
Plot Type: [RQvs Sample |+ Graph Type:|Log10 » Orientation: Vertical Bars |+

| |

a = 3c

RQ vs Sample

Sample

c-mye

Notes
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4. Click < at the top left of the View Replicate Results Table tab.

The figure below shows the replicate results table.

» | View Replicate Results Table ]

Show In Table ¥ |

# | Omit Sample Target CTMean MNormalized Qty Mean Mormalized Gty Std Emr RQ RQ Min RO Max
1 [=] Liver C- e 20.532 -7.924 0.088 1.839 1.516 2232
2 [] Kidney - Mmye 21.461 -7.044 0168 1 0.723 1.382
Column Description
Omit For all technical replicates that evaluate the associated sample/target

combination:

¢ A check mark (v) indicates that all replicates have been removed from
the analysis.

¢ A hyphen (=) indicates that one or more replicates have been removed
from the analysis.

Sample The sample associated with the data displayed in the row.
Target The target associated with the data displayed in the row.
Ct Mean The arithmetic average of the technical replicate C; values.

Normalized Qty
Mean

The point estimate of the normalized quantities computed at the replicate
level as the geometric mean.

Normalized Qty

The confidence interval based variability associated with the normalized

Std Err quantities computed at the replicate level as the geometric standard error

of the mean.

RQ The relative level of gene expression for the replicate group computed
using normalized quantities.

RQ Min The minimum relative level of gene expression in the test samples

computed using normalized quantities and the confidence level setting.

Note: The minimum includes the variability associated with the
endogenous control and targets in only the test samples.

RQ Max The maximum relative level of gene expression in the test samples

computed using normalized quantities and the confidence level setting.

Note: The maximum includes the variability associated with the
endogenous control and targets in only the test samples.

Notes
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5. View the Well Table:

a. In the navigation pane, select Analysis » Amplification Plot, then select
the View Well Table tab.

b. In the Group By drop-down list, select Replicate.

c. Look at the C; SD column to evaluate the precision of the replicate groups. In
the example experiment, there is one outlier (well A9). You will omit this well
in the troubleshooting section (“Omit Wells from the Analysis” on page 105).

ba

» [ View Plate Layout | View Well Table ]

5b ‘ SelectWells With: |- Selectitern - &
| Show in Tablz ¥ | Group By ¥ | Expand Al Collapse All
L
5c
# | Well Omit Flag Sample Ma Target Mame = Task Dyes Ccr CT Mean CtSD Quantity MNormaliz. MNormaliz. E
= Liver - GAPCH - UNEMNOUWN e
G AlD [ | Liver GAFDH URKMNOWRN FAM-MFQ-MGE 28380135 28455734 0.072 0.469
26 Al1 [ | Liver GAFDH URKMNOWRN FAM-MFO-MGE 28484178 28455734 0.072 0.444
27 Al2 [ ] Liver GAFDH URKMNOWR FAM-MFO-MGE 28522894 28455734 0.072 0.427
= Liver - c-mye - UNENOWN
28 A7 [ | 1 Liver c-myc URKMNOWRN FAM-MNFQ-MGB 20.6035 21111605 1.007 7.386 0.583
29 AR [ | 1 Liver c-myc URKMNOWRN FAM-MFQ-MGE 20454822 21111605 1.007 8133 0.583
50 33 Ad [ ] 1 Liver c-mye URKMNOWR FAM-NFQ-MGB 22.27033 21111605 1.007 2.625 0.583
= ec-mye - NTC
N Al [ | £-Mmye NTC FAM-MFQ-MGB Undetermi
£ A2 [ | £-Mmye NTC FAM-MFQ-MGB Undetermi
33 A3 [ ] £-mye NTC FAM-MFQ-MGB Undetermi
= c-mye - STANCARD - 002
34 c7 [ | c-myc STANDARD FAM-MWFQ-MGB 30105022 30.082637 0.078 0.02
A ca [ | c-myc STANDARD FAM-MFQ-MGBE 30147276 30.082637 0.078 0.02
36 ca [ ] c-myc STANDARD FAM-MNFQ-MGE 29.9958 30.082687 0.078 0.02
= ec-mye - STANCARD - 02
37 Cc4 [ | c-myc STANDARD FAM-MFO-MGE 26424818 26602396 0.198 0.2
38 cs [ | c-myc STANDARD FAM-MFQ-MGE 26588543 26602396 0.198 0.2
39 Ca [ ] c-myc STANDARD FAM-MFO-MGE 26813423 26.602396 0.198 0.2
= c-mye - STANCARL - 20
40 c1 [ | c-myc STANDARD FAM-WFQ-MGB 22183528 2253345 0.317 2
41 c2 [ | c-myc STANDARD FAM-NFQ-MGB 22570677 2253345 0.317 2
42 c3 [ ] c-myc STANDARD FAM-MWFQ-MGB 22.830145 2253345 0.317 2
= c-mye - STANCARD - 200
43 B10 [ | c-myc STANDARD FAM-MFQ-MGE 19131712 1B8.828127 0.264 20
44 BE11 [ | c-myc STANDARD FAM-MWFQ-MGB 18656277 18.828127 0.264 20
.:( iAo S ATAMIMARA FAMLIEA AR 4R &REARA AR AARAAT Ansa An 5 b

Note: To show/hide columns in the Well Table, select/deselect the column name in the
Show in Table drop-down list.

Analysis When you analyze your own relative standard curve experiment, look for:

Guidelines  Differences in gene expression (as a fold change) relative to the reference sample.

» Standard deviation in the replicate groups (C SD values). If needed, omit outliers
(“Omit Wells from the Analysis” on page 105).

For More For more information on the Gene Expression Plot screen or Well Table, open the
Information 7500 Software Help by clicking ) or pressing F1.

Notes

96 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments



Chapter 5 Analyze the Relative Standard Curve Experiment ﬂ
Publish the Data

Publish the Data

You can publish the experiment data in several ways:

Save the plot as an image file

Print the plot

Print the reaction plate layout

Create slides

Print a report

Export data to applications such as Microsoft® Excel® and Microsoft® PowerPoint®.

For information on performing these tasks, open the 7500 Software Help by clicking
@) or pressing F1.

Notes
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Section 5.2 Troubleshoot (If Needed)

Section 5.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . . ..........vtitit i 100
B View the QC SUMMATrY. ... ..ottt e e e 103
B Omit Wells from the Analysis. ............ .. ... .. 105
B View the Multicomponent Plot. . .......... .. ... ... ... ... ... ... .. .... 107
B Viewthe RawDataPlot . ...... ... ... .. .. .. . . . . . . . .. 109
Notes
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View the Analysis Settings

View the Analysis Settings

About the
Example
Experiment

View the Settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cyp), flags, and advanced options. If the default analysis settings in the 7500 software are
not suitable for your experiment, you can change the settings, then reanalyze your
experiment.

In the standard curve example experiment, the default analysis settings are used without
changes.

1. In the navigation pane, select Analysis.
2. Click Analysis Settings to open the Analysis Settings dialog box.

3. Inthe example experiment, view the default analysis settings, which are specified in
each of the following tabs:

* C; Settings
» Flag Settings
* Advanced Settings

_‘__| Analysis Settings for Relative Standard Curve Example

|§___(__)_I__§91jt__i__r]g§__§| Flag Settings ] Relative Quantitation Settings I Advanced Settings }
-~
a Review the default settings for analysis of targets in this experiment. To editthe default settings, click "Edit Default Settings.” To use
different settings for a target, select the target from the table, deselect"Use Default Seftings,” then change the settings that are displayed.
Default C1 Settings
Default C1 settings are used to calculate the CT for targets without custorn settings. To editthe default settings, click "Edit Default Settings.”
Threshald: AUTO  Baseline Start Cycle: AUTO Baseline End Cycle: AUTO | Eclt Defauk Seftings |
Select a Target Cr Settings for GAPDH
Target Threshold Baseline Start Baseline End 7 Settings to Use: [ ] Use Default Settings
-~
DI B e ey [ sutomatic Threshold
c-myc 0.2 AUTO IALTO Threshald: | 0.2
Automatic Baseline
v
< »
| Revert to Default Analysis Seftings Apply Analysis Seftings ‘ Cancel |
4. Click Apply Analysis Settings.
Notes
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View the Analysis Settings

Analysis  Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the 7500 software. If the default settings are not suitable for
your experiment, you can change the:

* C; Settings — Use this tab to manually set the threshold and baseline. When manually
setting the threshold and baseline, Applied Biosystems recommends the following:

Setting Recommendation

Threshold | Enter a value for the threshold so that the threshold is:

* Above the background.

* Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.

Baseline Select the Start Cycle and End Cycle values so that the baseline ends
before significant fluorescence is detected.

* Relative Quantitation Settings — Use this tab to:
— Select the type of analysis to perform.
— Select the reference sample(s).

— Select the endogenous control. You can set more than one endogenous control for
relative standard curve experiments. See “Set Multiple Endogenous Controls” on
page 101).

— Reject outliers.

— Select the algorithm to use to determine RQ Min/Max values (confidence level or
standard deviations).

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.

— Change the flags that are applied by the 7500 software.
* Advanced Settings — Use this tab to change baseline settings well by well.

Set Multiple Endogenous Controls
You can select multiple endogenous controls for a relative standard curve experiment.

To select multiple controls:

1. Inthe Analysis Settings for Relative Standard Curve Example dialog box, select the
Relative Quantitation Settings tab.

2. In the Select Endogenous Control(s) group, click the Endogenous Control(s) drop-
down list, then select Multiple Controls.

Notes
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View the Analysis Settings

3. In the Select Multiple Endogenous Controls dialog box, select the targets that you
want to use as endogenous controls, then click OK.

Ct Settings I Flag Settings T Relative Quantitation Settings T Advanced Settings ]
@ singleplex o]
Select Reference(s)
Selectthe biological replicate group andior sample to use as the reference(s) for this experiment.
Biological Replicate Group Reference Reference Sample:  |Brain b
Select Endogenous Control(s)
Selectthe target to use as the endogenous control for this experiment. To use multiple endogenous controls, select "Multiple Controls”
from the drop-down list, then selectthe controls as necessary.
Endogenous Control(s): ) select Multiple Endogenous Controls §|
2 Multiple Controls 183
Efficiency 183 [1EGR3
EGR3 ClmAoB |
A0B Detec| L] 0GDH
OGDH [] osGEP
0SGEP 185 ] SERPING1 —
Enter percentage values HserppPINGT EGR3 E
WMACE |
OGDH
lnencd b
Outlier Rejection
Selectto reject replicates with ACT values less than or ngs apply only to multiplex
reactions
‘ 0K | | Cancel =
RQ MinMax Calculations
Selectthe algorithm to use to determing RQ Min and Max values (error bars). v
| Revert to Default Analysis Settings | Apply Analysis Settings Cancel |

For More For more information on the analysis settings, open the 7500 Software Help by pressing
Information  F1 when the Analysis Settings dialog box is open.

Notes

102 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve

and Comparative C; Experiments



Chapter 5 Analyze the Relative Standard Curve Experiment E
View the QC Summary

View the QC Summary

The QC Summary screen displays a list of the 7500 software flags, and includes the flag
frequency and location for the open experiment.

About the In the standard curve example experiment, you review the QC Summary screen for any
Example flags generated by the experiment data. In the example experiment, the HIGHSD flags
Experiment has been generated for wells: A7, A8, and A9.
View the QC 1. In the navigation pane, select Analysis » QC Summary.
Summary
Note: If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, three wells are flagged.

3. In the Flag Details table, look in the Frequency and Wells columns to determine
which flags appear in the experiment. In the example experiment, the Frequency
column displays 3 for the HIGHSD flag.

Note: The Frequency column displays 0 to indicate that the flag does not appear in
the experiment.

4. (Optional) Select the HIGHSD flag row to display details about the flag.

5
Flag v
Total Wells: a8 | ProcessedWells 48 Manually Omitted Wells 0 | Targets Used: 2
Wells SetUp 48 | FlaggedWells 3 Analysis Omitted Wells: 0 | Samples Used 2 ‘ 2
5
Flag Mame Frequency Wells
AMPINC Amplification in negative control 0
BADROX Bad passive reference signal 0
OFFSCALE Fluorescence is offscale 0
4 = HSD High standard deviation in replicate group 3 AT, AB, A9
MNOAMP Mo amplification 0
NOISE MNoise higher than others in plate 0
SPIKE Moise spikes 0
MNOSIGHNAL Mo signal in well 0
OUTLIERRG Outlier in replicate group 0
EXPFAIL Exponential algorithm failed 0
BLFAIL Baseline algorithm failed 0
THOLDFAIL Thresholding algorithm failed 0
CTFAIL Cr algarithm failed 0
Flag: HIGHSD—High standard deviation in replicate group
Flag Detail: The CT standard deviation for the replicate group exceeds the
flag setting
Flag Criteria: CT1 standard deviation > 0.5
Flagged Wells: AT, A3, A9
Wiew HIGHSD Troubleshooting Information
Notes
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Possible Flags

Notes

104

View the QC Summary

For standard curve experiments, the flags listed below can be generated by the
experiment data.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells column.

Flag

Description

AMPNC

Ampilification in negative control

BADROX

Bad passive reference signal

BLFAIL

Baseline algorithm failed

CTFAIL
EXPFAIL

C; algorithm failed

Exponential algorithm failed

HIGHSD

High standard deviation in replicate group

MTP

NOAMP

Multiple Tm peaks
Note: This flag is displayed only if the experiment includes a melt curve.

No amplification

NOISE

Noise higher than others in plate

NOSIGNAL

No signal in well

OFFSCALE

Fluorescence is offscale

OUTLIERRG

Ouitlier in replicate group

SPIKE
THOLDFAIL

Noise spikes

Thresholding algorithm failed

Analysis When you analyze your own standard curve experiment:

Guidelines * In the Flag Details table, click each flag that has a frequency >0 to display details
about the flag. If needed, click the troubleshooting link to view information on
correcting the flag.

* You can change the flag settings:

— Adjust the sensitivity so that more wells or fewer wells are flagged.

— Change the flags that are applied by the 7500 software.

For More For more information on the QC Summary screen or on flag settings, open the
Information 7500 Software Help by clicking g) or pressing F1.
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Omit Wells from the Analysis

About the
Example
Experiment

Omit Wells

Experimental error may cause some wells to be amplified insufficiently or not at all.

Omit Wells from the Analysis

These wells typically produce C values that differ significantly from the average for the

associated replicate wells. If included in the calculations, these outliers can result in

erroneous measurements; to ensure precision, omit the outliers from the analysis.

In the example experiment, you use the Well Table to remove well A9 from the analysis.
The C; of well A9 deviates significantly from those of the related technical replicates,

which generated the HIGHSD flag due to the degree of variation in their C; values (see
“View the QC Summary” on page 103).

1.

Note: If no data are displayed, click Analyze.

a. In the Group By drop-down list, select Replicate.

b. Look for any outliers in the replicate group (be sure they are flagged). In the

In the Well Table:

Select the View Well Table tab.

In the Plot Type drop-down list, select C vs Well.

example experiment, well A9 is the outlier.

c. Select the Omit check box next to well A9.

>

In the navigation pane, select Analysis » Amplification Plot.

Plot Settings ) Selact Walls With: - Select flem- v
Plot Type:[CTvs Well % Graph Type Plot Golor:[well v i |
2 " e | Show in Table ¥ | Group By ¥ | | Expand Al Collapse All
!
/@ /r—j =1 L \g ?_ # | Well Oﬂt Flag Sam.ple Ma Targethame = Task Dyes
= Liver- GAPDH - UNENOWN A
. . 2% Mo O Liver GAPDH UNKNOWN  FAMN
Amplification Plot 26 Al O Liver GAPDH UNKNOWN  FAM-N
7 M2 [ Liver GAPDH UNKNOWN  FAMN
s E Liver - c-mye - UNKNOWN
28 AT u i Liver c-mye UNKNOWN FAN-N
Adom 29 A u i Liver c-mye UNKROWHM FAM-N
e ki =t 30 M [ 4 Liver c-mye UNKNGWN  FAMN
wet e & c.mye- NTC
5 'JEI ° om4 k]| A O c-mye NTC FANEIN
=i 32 A2 o c-rmye NTE FAM-N
Well: A3 33 MmO c-mye NTC FAM-N
e Gups =l e-mye - STANDART - 0.02
Tas'_‘: UNKNOWRN 34 T | c-myc STANDARD  FAM-N
gﬁz;ﬂﬂy' f’;“ﬂ{?;.g;;'ﬁﬁn 35 ce [ cmye STANDARD  FAWLN
Uer cojossssseserss | m w G et emye SIENEERTE
Flags: HIGHSD c-mye - STANCARE - 0.2
37 cs O c-mye STANDARD  FAMHN
., Sample: Liver 38 cs O c-myc STAMDARD  FAM-N
- 39 | c-myc STANDARD  FAMHN
A MG ECHD NE N N - = c-mye - STANDARD - 20
40 | c-mye STANDARD  FAMHN
= 41 2 O c-myc STANDARD  FAMLN
Options "\ = 42 | crmye STANDARD  FAILN
Target |All ~ | Threshold: — 1=l e-mye - STANTART - 200
E 143 B0 [ cmyc STANDARD  FAMHN
Show: [ Threshold — [] Baseline Start: Well B Target & Baseline End: Well B v 44 811 O cmyc STANDARD  FAM-N
< | b ac man - R STARIRARR AL n
Notes
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4c
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Omit Wells from the Analysis

5. Click Analyze to reanalyze the experiment data with well A9 removed from the
analysis.

- >

SelectWells With: |- Select tem- | | |
PlotType:|Ccrvs wel %] Graph Type:| | PlotColorwel (¥ P
[ showinTavie v | eroupsy v | | wpand All | ) colrapse an |
!
/@ /9 B [ \g :* # | well Oﬂt Flag Sample Ia TaTget Mame = Task Dyes
= Liver- GAPCH - UNKNOWN |
} . 25 Mo [ Liver GAPDH UNKNOWN — FAMN
Amplification Plot 26 Al [ Liver GAPDH UNKNOWN — FAMN
7 M2 [ Liver GAPDH UNKNOWN  FAMN
Y = Liver - c-mye - UNKNOWN
28 AT Liver c-mye UNKNOWN — FAMN
*ae 29 AB | Liver c-myc LINKEROWN FAM-N
ar 1> == 30 A9 Liver c-mye UNKNOWN  FAMN
ens hils = cmye - NTC
5 . Lo aem o Al 1 c-rye NTC FAl-N
e il a2 2 [ c-mye NTC FAN-N
33 A3 | c-myc NTC FAM-N
= c-myc - STANDART - 0.02
34 cr O c-mye STANDARD  FAM-N
35 S| c-mye STANDARD  FAMN
10 36 co [ c-mye STANDARD  FAM-N
: ° ¢ = = = = “ “ = c-myc - STANDARD - 0.2
Well Number a7 i c-rye STAMDARD  FAM-N
., 38 S| c-mye STANDARD  FAMHN
— kL] cs [ c-rye STAMDARD  FAM-N
WA e MC MO ME HF Hc MH = c-myc - STANDARD - 2.0
40 ¢l O c-mye STANDARD  FAM-N
= 41 c2 O c-mye STANDARD  FAMHN
Doizeal 42 ca [ e-mye STANDARD  FAKN
Target Threshold . = = cmye - STANDARD - 200
E| 43 B0 [ c-mye STANDARD  FAM-N
Show: [] Threshold — [] Baseline Start: Well M Target s Baseline End: Well /B ~ a4 B11 ] c-mye STAMDARD FAN-I
< il | k) ac e - . STARIR AR Fana
L

Analysis When you analyze your own relative standard curve experiment, carefully view the
Guidelines replicate groups for outliers. If needed, remove outliers manually using the Well Table.
See “Omit Wells” on page 105 to remove the outliers in your experiment.

For More For more information on omitting wells from the analysis, open the 7500 Software Help
Information by clicking @) or pressing F1. Within the Help, search for the omit well topics:

1. Select the Search tab.
2. Enter omit well.
3. Click List Topics.

4. Double-click the topics you want to review.

Notes
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View the Multicomponent Plot

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of the PCR run.

About the In the example experiment, you review the Multicomponent Plot screen for:
Exa_lmple « ROX™ dye (passive reference)
Experiment « FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
» Amplification in the negative control wells

View the Plot 1. In the navigation pane, select Analysis » Multicomponent Plot.

Note: If no data are displayed, click Analyze.

2. Display the unknown and standard wells one at a time in the Multicomponent Plot
screen:

a. Select the View Plate Layout tab.

b. Select one well in the plate layout; the well is shown in the Multicomponent
Plot screen.

Note: Ifyou select multiple wells, the Multicomponent Plot screen displays the
data for all selected wells simultaneously.

3. In the Plot Color drop-down list, select Dye.

4. Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

5. View the FAM dye signal. In the example experiment, the FAM dye signal increases
throughout the PCR process, which indicates normal amplification.

Notes
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View the Multicomponent Plot

6. View the ROX dye signal. In the example experiment, the ROX dye signal is
constant throughout the PCR process, which indicates typical data.

2a |
Plot Sefti ’ SelectWells With: - Selecthem- v - cleoien |
‘ & | xshnwinWelleI VlewLegendI | I @I NI
4 S irrent settings as the default
ag‘g:‘— [T 2] 3] a]s 67 [ &8[9 [1w][n]iz

e S
1.750.000
1,500,000
C

1,250,000

2 ;

: :

% 1.000.000 o

2

5 ||

=
5 L 750 000

E

6 500,000 |

250,000

o

0 2 &4 B B 10 12 ¥ 18 18 A W M X B N LR M ¥ B L0 oL G
Cycle |
Legmt b
M rox I FAn
Wells 12 Unknown [5] 30 Standard [ 6 Megative Control 48 Empty

7. Select the negative control wells one at a time and check for amplification. In the
example experiment, no amplification occurs in the negative control wells.

> ) 1
SelectWells With: |- Selectem- v =i |
PlotColor [oye ¥
& | @ShowinWelleI \newLegendI | ml ﬁl @I
Save current settings as the default
a i = = v 72173 47 a6 [7 [ &8 [a[1w0][n]i

S B e A
2,000,000
150,000 ¢ IIIIIIIIHIIH
1,500,000
c

1.250.000

LA AN N Y
é 750,000 ]
E
7 5{]{],{]{]{{]__ —
25[!.[![![!__ F
n ||
@ 2 & 8 B 10 12 14 18 18 W P 2 M MW N W M W M &4 & G
Cytle -
Lot H
M rox I FAM
Wells m 12 Unknown ESIJ Standard mﬁ Megative Control 48 Empty
Notes
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Guidelines

For More
Information

Chapter 5 Analyze the Relative Standard Curve Experiment ﬂ
View the Raw Data Plot

When you analyze your own relative standard curve experiment, look for:

» Passive reference — The passive reference dye fluorescence level should be
relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or
sudden changes in the fluorescence.

* Negative control wells — There should not be any amplification in the negative
control wells.

For more information on the Multicomponent Plot screen, open the 7500 Software Help
by clicking @) or pressing F1.

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence (not normalized) for each optical
filter for the selected wells during each cycle of the real-time PCR.

About the In the relative standard curve example experiment, you review the Raw Data Plot screen
Example for a stable increase in signal (no abrupt changes or dips) from the appropriate filter.
Experiment
View the Plot 1. In the navigation pane, select Analysis » Raw Data Plot.
Note: If no data are displayed, click Analyze.
2. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.
3. Click = (Show a legend for the plot).
Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
Note: The legend displays the color code for each row of the reaction plate. In the
example shown below, Row A is red, Row B is yellow/green, Row C is green, and so on.
Notes
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View the Raw Data Plot

4. Drag the Show Cycle slider from cycle 1 to cycle 40. In the example experiment, a
stable increase occurs in the signal from filter 1, which corresponds to the FAM™
dye.

Raw Data Plot

iy & 5

Raw Data Plot

2,000,000
1,750,000
1500000 |
1,250 000 N
£ 1po00000
i
750,000

500,000

250,000

Filter

Leged
|iA B Mc D HE HF Hc HH 5,

Options
g 4
Show Cycle 40 r §]
1 10 20 30 40

The filters are:

Filter 1 2 3 4 5
e FAM™ dye e JOE™dye o TAMRA™dye | ® ROX™dye | Cy5®dye
Dye e SYBR®Green | ¢ VIC®dye | ¢ NED™dye ¢ Texas Red®
dye e Cy3®dye dye

Analysis When you analyze your own relative standard curve experiment, look for the following in
Guidelines  each filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, open the 7500 Software Help by
Information  clicking @) or pressing F1.

Notes
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m Design the Comparative C; Experiment

This chapter covers:

B Chapter OVeIrVIEW . . . ottt e e e e et e e 112
B Createa New EXperiment. .. ...ttt 113
B Define the Experiment Properties ............... .. ... 114
B Define the Methods and Materials .. .......... ... ... ... ... ... ..... 116
B SetUpthe Targets. ... ..ottt e 119
B SetUptheSamples. .. ....... . i i 121
B Set Up the Relative Quantitation Settings .. ..................cuver... 124
B SetUptheRunMethod ...... ... ... .. . i, 125
B Reviewthe Reaction Setup. ............ i 127
B Order Materials for the Experiment . .................................. 131
B Finish the Design Wizard .. ....... .. . i 134

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to use the Design Wizard in the 7500 software to set up the
comparative C; (AAC) example experiment. The Design Wizard guides you through
Applied Biosystems recommended best practices as you enter design parameters for the
example experiment.

Note: When you design your own experiments, you can select alternate workflows (see
“Using This Guide with Your Own Experiments” on page 13).

Example Start Comparative C; (AAC;) Experiment
Experiment v
Workflow Design the Experiment (Chapter 6)

. Create a new experiment.

. Define the experiment properties.
. Define the methods and materials.
. Set up the targets.

1
2

3

4

5. Set up the samples.
6. Set up the relative quantitation.

7. Set up the run method.

8. Review the reaction setup.

9. Order materials for the experiment.
1

0.Finish the Design Wizard.

A 4
Prepare the Reactions (Chapter 7)

v
Run the Experiment (Chapter 8)

v
Analyze the Experiment (Chapter 9)

v
End Experiment

Notes
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Create a New Experiment

Create a New Experiment

Create a new experiment using the Design Wizard in the 7500 software.

Create an 1. Double-click g (7500 software) or select Start » All Programs »
Experiment Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Inthe Home screen, click | [[\] Design Wizard to open the Design Wizard.

® 7500 Software v2.0 3=

File Edit Instrument Analysis Tools Help

[ New Experiment » 5 open.. [l 5ave - BN Close | 4B Ewot - B PrintReport
Analyze
QuickStart Analyze Experiment
2
Advanced Setup
[ 7500 : connected I
Notes
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Define the Experiment Properties

Define the Experiment Properties

In the Experiment Properties screen, enter identifying information for the experiment,
select the instrument type, then select the type of experiment to design.

About the In the comparative C (AAC;) example experiment:

Exa_lmple * The experiment is identified as an example.
Experiment

* The 7500 instrument is selected to run the experiment.
+ A MicroAmp® Optical 96-Well Reaction Plate is used.
* The experiment type is quantitation.

Complete the 1. Click the Experiment Name field, then enter Comparative CT Example.

Experiment

Properties Screen Note: The experiment header is updated with the experiment name you entered.

2. Leave the Barcode field empty.
3. Click the User Name field, then enter Example User.

4. Click the Comments field, then enter Example Experiment for the Comparative
Ct Getting Started Guide.

5. Select 7500 (96 Wells).
6. Select Quantitation for the experiment type.

7. Click Next.

1A. Define: Experiment Properties Experiment Properties Help @

a Instructions: Enter an experiment name, selectthe instrument type, then select the type of experiment to design

How do you want to identify this experiment? = Required
1 TEXpenmentame: | Comparative CT Example ‘
2 SO \
3 Liear Miama (Ninfinnal; | Example User ‘
4 Comments (Optional) |Examp\e Experiment for the Comparative Ct Getting Started Guide :‘
L b
Which instrument are you using to run the experiment?
5 I 7ew0eewars) | [ 7800 Fast 35 Wels) |7 rmeswes |
Setup, run, and analyze an experiment using a 4- or 5-color, 36-well system.
What type of experiment do you want to design?
6 [— + Quantitation } [ Genotyping ] [ Presence / Absence ]
Design a gene quantitation experiment to determine the amount of target nucleic acid sequence in a sample.
Notes
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Design  When you design your own comparative C experiment:

Guidelines » Enter an experiment name that is descriptive and easy to remember. You can enter
up to 100 characters in the Experiment Name field. You cannot use the following
characters in the Experiment Name field: /\><*?"|:;

Note: The experiment name is used as the default file name.

* (Optional) Enter a barcode to identify the barcode on the PCR reaction plate. You
can enter up to 100 characters in the Barcode field.

* (Optional) Enter a user name to identify the owner of the experiment. You can enter
up to 100 characters in the User Name field.

* (Optional) Enter comments to describe the experiment. You can enter up to 1000
characters in the Comments field.

* Select the instrument you are using to run the experiment:
— 7500 (96 Wells)
— 7500 Fast (96 Wells)

Note: You canuse 7500 software v2.0 to design experiments for the 7500/7500 Fast
instrument.

IMPORTANT! To set the default instrument type, select Tools » Preferences, then
select the Defaults tab (default). In the Instrument Type drop-down list, select the
appropriate instrument.

* Select Quantitation as the experiment type.

For More For more information on:

Information » Completing the Experiment Properties screen — Open the 7500 Software Help by
clicking @) or pressing F1.
» Consumables — See “Supported Consumables” on page 4.
* Quantitation experiments — Refer to the Real Time PCR System Reagent Guide.
Notes
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Define the Methods and Materials

In the Methods and Materials screen, select the quantitation method, reagents, ramp
speed, and PCR template to use for the experiment.

About the In the comparative C example experiment:
£ Exa_lmplci * The comparative C quantitation method is used.
Xperimen + TagMan® reagents are used.
* The standard ramp speed is used in the instrument run.
* cDNA (prepared from total RNA isolated from liver, kidney, brain, and universal
tissues) is the template type. You must first perform reverse transcription to convert
the RNA to cDNA (see “Prepare the Template” on page 139).
Complete the 1. Sclect Comparative C (AAC;) as the quantitation method.
Methods and
Materials Screen  2- Select TagMan® Reagents for the reagents. (default)
IMPORTANT! Fast runs cannot be performed on a 7500 system.
3. Select Standard (~ 2 hours to complete a run) for the ramp speed.
4. Select cDNA (complementary DNA) for the template type. (default)
5. Click Next.
1B. Define: Methods & Materials Methods & Materials Help @

a Instructions: Selectthe quantitation method, reagents, ramp speed, and type of template for the real-time PCR reactions.

Which guantitation method are you using?

[ Standard Curve J [ Relative Standard Curve J [ s Comparatl\fe CT (AACT) }
1 |
With the comparative C1 (AACT) method, you use a reference sample and an endogenous control to determine the relative quantity of target sequence in a sample
Which reagents do you want to use to detect the target sequence?
2 [ J TagMan® Reagents } [ SYBR® Green Reagents J
These real-time PCR reactions contain two primers and a TagMan® probe. The primers are designed to amplify the target sequence. The TagMan probe is designed to hybridize to the
target sequence and generate fluorescence signal when the target sequence is amplified
Which ramp speed do you want to include in the instrument run?
3 [.,' Standard (~ 2 hours to complete a run)}
Foroptimal results using the standard ramp speed, Applied Biosystems recommends standard reagents for your real-time PCR reactions.
What type of template do you want to use in the real-time PCR reactions?
4 f + cONA (complementary DNA RIMA DA (genamic DNA)
. p ry 4 d
ou are adding cDMA to the real-time PCR reactions. You have already performed reverse transcription to convertthe RNAto cDMA,
Notes
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Design  When you design your own comparative C experiment:

Guidelines * Select Comparative C (AACy) as the quantitation method. The comparative C;
(AAC) method is used to determine the relative target quantity in samples. When
setting up your reaction plate, the comparative C; method requires targets, samples,
a reference sample, and an endogenous control.

Note: Before you use the comparative C; method, Applied Biosystems
recommends that you determine that the PCR efficiencies for the target assay and
the endogenous control assay are approximately equal. Applied Biosystems
TagMan® Gene Expression Assays and Custom TagMan® Gene Expression Assays
have equivalent amplification efficiencies of 100% (£10%).

» Select the reagents you want to use:

— Select TaqMan® Reagents if you want to use TagMan reagents to detect
amplification and quantify the amount of target in the samples. TagMan reagents
consist of two primers and a TagMan probe. The primers are designed to amplify
the target. The TagMan probe is designed to hybridize to the target and fluoresce
when the target is amplified.

— Select SYBR® Green Reagents if you want to use SYBR Green reagents to
detect amplification and quantify the amount of target in the samples. SYBR
Green reagents consist of two primers and SYBR Green dye. The primers are
designed to amplify the target. The SYBR Green dye fluoresces when it binds to
double-stranded DNA. SYBR Green dye is often part of the SYBR Green master
mix added to the reaction. If you use SYBR Green dye, select the Include Melt
Curve check box to perform melt curve analysis of the amplified target.

IMPORTANT! Although you can use other fluorescence-based reagents on the
7500/7500 Fast system, you must design your experiment using Advanced Setup
instead of the Design Wizard.

Note: Fast runs can be performed only on the 7500 Fast system and an upgraded
7500 system.

» Select the appropriate ramp speed for the instrument run:

— Select Fast (~ 40 minutes to complete a run) if you are using Fast reagents for
the PCR reactions.

— Select Standard (~ 2 hours to complete a run) if you are using standard
reagents for the PCR reactions.

» Select the appropriate PCR template:

— Select cDNA (complementary DNA) if you are performing 2-step RT-PCR, and
you have already performed reverse transcription to convert the RNA to cDNA.
You are adding complementary DNA to the PCR reactions.

Notes
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— Select RNA if you are performing 1-step RT-PCR. You are adding total RNA or
mRNA to the PCR reactions.

Note: To use the Fast ramp speed with RNA templates, you must design your
experiment using Advanced Setup instead of the Design Wizard.

— Select gDNA (genomic DNA) if you have already extracted the gDNA from
tissue or sample. You are adding purified genomic DNA to the PCR reactions.

For More For more information on:

Information .

Completing the Methods and Materials screen — Open the 7500 Software Help by
clicking @) or pressing F1.
Determining PCR efficiencies — Open the 7500 Software Help by clicking @) or
pressing F1. Within the Help, search as follows:

a. Select the Search tab.

b. Enter PCR efficiency.

c. Click List Topics.

d. Double-click Determine Amplification Efficiency.
Using Advanced Setup — See “Advanced Setup Workflow” on page 204.
Using the relative standard curve quantitation method — See Chapters 2 through 5 of
this guide.
Using the standard curve quantitation method — Refer to the Applied Biosystems

7500/7500 Fast Real-Time PCR System Getting Started Guide for Standard Curve
Experiments.

TagMan and SYBR Green reagents — Refer to the Real Time PCR System Reagent
Guide.

PCR, including singleplex vs. multiplex PCR and 1-step vs. 2-step RT PCR — Refer
to the Real Time PCR System Reagent Guide.
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Set Up the Targets

In the Targets screen, enter the number of targets you want to quantify in the PCR
reaction plate, then set up the assay for each target.

About the In the comparative C; example experiment:
Example

! » Two targets are quantified in the reaction plate.
Experiment

» The Target 1 assay is set up for the endogenous control. For the example experiment
the target is human 18S. 18S serves as the endogenous control because its expression
levels tend to be relatively stable.

» The Target 2 through 6 assays are set up for the targets you are studying. For the
example experiment, the targets are EGR3, MAOB, OGDH, OSGEP, and SERPINGI.

Complete the 1. Click the How many targets do you want to quantify in the reaction plate? field,
Targets Screen then enter 6.

Note: The number of rows in the target assays table is updated with the number you
entered.

2. Set up the Target 1 assay:
a. Click the Enter Target Name cell, then enter 18S.
b. In the Reporter drop-down list, select FAM (default).
c. In the Quencher drop-down list, select NFQ-MGB (default).
d. Leave the default in the Color field.

3. Set up the remaining targets as shown below:

Target Target Name Reporter Quencher Color
2 EGR3 FAM NFQ-MGB (Use default color)
3 MAOB FAM NFQ-MGB (Use default color)
4 OGDH FAM NFQ-MGB | (Use default color)
5 OSGEP FAM NFQ-MGB (Use default color)
6 SERPING1 FAM NFQ-MGB (Use default color)

4. Click Next.
Note: For all targets, leave blank the (Optional) Enter Gene Name field. You can search

for the gene/assay ID when you order your materials (see “Order Materials for the
Experiment” on page 131).

Notes
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Notes

Set Up the Targets

2A. Set Up: Targets

Targets Help )

a Instructions: Enter the number of targsts to quantify in the reaction plate, then set up the assay for each target

Set Up Targets

* How many targets do youwant to quantify in the reaction plate? &

For each target assay in the reaction plate, enter atarget name, selectthe reporter and guencher to use to detect the target, and select a target color. (Optional) Enter a gene name,
find Applied Biosystems gene expression assays, then select an assayto fill in the Assay 1D

* Enter Target Name Reporter Quencher Calor Assay D (Optional) Enter Gene Name and Click "Find”

= Required

([[res

FAI v [MFQ-MGB v v | Find |

|EcR3

FAI “ [MFQ-MGB v v | Find |

[mace

FAI “ [MFQ-MGB v v | Find |

[oGDH

FAI “ [MFQ-MGB v v | Find |

[oseer

FAM

<

MFQ-MGB v v | Find |

[sERPING1

FAM MFQ-MGB v v | Find |

4

Design
Guidelines

When you design your own comparative C; experiment:

+ Identify each target assay with a unique name and color. You can enter up to

100 characters in the Target Name field.

Select an endogenous control for each sample. The endogenous control is a target that is

present in all samples under investigation. It should be expressed equally in all sample

types, regardless of treatment or tissue origin (examples of endogenous controls are [3-

actin, GAPDH, and 18S ribosomal RNA [18S rRNA]). The endogenous control is used

to normalize the PCR results; the endogenous control corrects for variable sample mass,
nucleic acid extraction efficiency, reverse transcription efficiency, and pipette calibration
errors. Note that:

— Each sample type (for example, each tissue in a study comparing multiple tissues)
requires an endogenous control.

— If samples are on multiple plates, each plate must have an endogenous control.
Additionally, every reaction plate must include an endogenous control for every
sample type on the reaction plate.

— You can select multiple endogenous controls for a single plate. See “Set Multiple
Endogenous Controls” on page 101.

Select the reporter dye used in the target assay. In the Methods and Materials screen on

page 116, if you selected:

— TagMan® Reagents — Select the dye attached to the 5" end of the TagMan probe.
— SYBR® Green Reagents — Select SYBR.

Select the quencher used in the target assay. In the Methods and Materials screen on
page 116, if you selected:

— TagMan® Reagents — Select the quencher attached to the 3’ end of the TagMan probe.
— SYBR® Green Reagents — Select None.

For More For more information on:

Information

* Completing the Targets screen — Open the 7500 Software Help by clicking @) or

pressing F1.

* Selecting an endogenous control — See the Application Note Using TagMan®

Endogenous Control Assays to Select an Endogenous Control for Experimental Studies.

120
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Set Up the Samples

In the Samples screen, enter the number of samples, replicates, and negative controls to
include in the reaction plate, enter the sample names, then select the sample/target
reactions to set up.

About the In the comparative C; example experiment:
Example .

) Four samples are used: cDNA prepared from total RNA isolated from four tissues
Experiment

(brain, kidney, liver, and universal). The samples contain unknown quantities of
EGR3, MAOB, OGDH, OSGEP, and SERPINGT (targets), and 18S (endogenous
control).

» Four technical replicates are used. The replicates are identical reactions, containing
identical reaction components and volumes.

* No negative controls are used. Negative control reactions contain water instead of
sample and should not amplify. The software automatically includes three negative
controls for each target assay.

IMPORTANT! Although the example experiment does not use negative controls,
Applied Biosystems recommends them.

Complete the 1. Click the How many samples do you want to test in the reaction plate? ficld, then
Samples Screen enter 4.

Note: The number of rows in the samples table is updated with the number you entered.

2. Click the How many replicates do you need? ficld, then enter 4.

3. Click the How many negative controls do you need for each target assay? field,
then enter 0.

4. Setup Sample 1:
a. Click the Enter Sample Name field, then enter Brain.
b. Leave the default in the Color field.

5. Set up the remaining samples as shown below:

Sample Name Color
Kidney (Use default color)
Liver (Use default color)
Universal (Use default color)

6. Select No Biological Replicates.

7. Select All Sample/Target Reactions to test all targets in all samples.

Notes
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Set Up the Samples

8. In the Well Count pane, verify that there are:

9.

* 96 Unknown wells [T
* 0 Negative Control wells []
* 0 Empty wells

In the Arrange Plate by drop-down list of the View Plate Layout tab, select Rows
(default).

10. Click Next.

2B. Set Up: Samples

Samples Help @.

a Instructions:

Enter the number of samples to test in the reaction plate, enter the number of sampleftarget reaction replicates, enter sample names, associate the samples with
biological replicate groups, then select the sampleftarget reactions to set up.

‘ 9

1 ————— * How many samples do you want 1o test in the reaction plate? Arrange Plate by; |Rows -
2 ———— * How many replicates do you need? m
3 -+ How many negative controls do you need far each target assay? Ijl | msnomeells M | PR LERE ‘ | | | m |
For each sample in the reaction plate, enter a sample name and select a sample 1 ‘ 2 | 3 | 4 ‘ 8 | & | 7 ‘ 8 | 4 | 10 ‘ " | 12 |
color. Brain  Brain Brain Brain Brain Brain Brain Brain Brain Brain Brain Brain
Enter Sample Name Color | |
4 |E|rain E Brain  Brain  Brain  Brain Brain Brain  Brain  Brain Brain  Brain  Brain  Brain
flm- m- m O M- m° m* m° o
,7 v 1
Kidney | = Kidney Kidney Kidney Kidnev Kidney Kidney Kidnev Kidney Kidney Kidnev Kidney Kidney
5 ] [Liver | 3 ‘lm-m'm-m- 00| m- |- [ [ m
| Universall | b N Kidney Kidney Kidney Kidney Kidney Kidney Kidney Kidney Kidney Kidney Kidney Kidney
. . "m0 O O 000 0 DD oo
| Liver Liver Liwer Liver Liver Liver Liver Liver Liver Liver Liver Liver
a RN R R A R A
6 [ 7 No B Repllcates ][ Specn‘y BID\DQICN Repllcate Gmups] ? Liver Liver Liwer Liver Liver \Liwver Liver Liver \Liver Liver Liver Liver
sampleftarget reastions do you want to set up? [ BRSPS S S S S S S S
7 [7 < All Sample/Target Reactions ][ Specify Sample/Target Reactions ] [ T L s 2 | | | | [ [ A
Design  When you design your own comparative C experiment:
Guidelines + Identify each sample with a unique name and color. You can enter up to
100 characters in the Sample Name field.
* Enter the number of replicates (identical reactions) to set up. Applied Biosystems
recommends three replicates for each sample reaction.
» Set up biological replicate groups (see “Set Up Biological Replicate Groups” on
page 123).
Biological replicates allow you to assess the representative nature of your results as
they relate to the population being studied. Inclusion of biological replicates can
give insight into any natural variation that is present within the population.
» The software automatically includes three negative controls for each target assay.
» Select which targets to test in the samples:
— Select All Sample/Target Reactions to test all targets in all samples.
Notes
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— Select Specify Sample/Target Reactions to specify the targets to test in each sample.

Note: When you use the Design Wizard to set up a comparative C; experiment, you
can set up only singleplex reactions (amplification and detection of one target per
well). If you want to set up a comparative C; experiment with multiplex reactions
(amplification and detection of two or more targets per well), design your
experiment using Advanced Setup instead of the Design Wizard.

Set Up Biological Replicate Groups

Note: You can also specify biological replicate groups when analyzing comparative C
experiments as part of a study (see “Define Replicates” on page 192).

1. Select Specify Biological Replicate Groups.
2. Enter the number of biological replicate groups that you want to test in the reaction plate.

3. For each biological replicate group, click the cell in the Biological Group Name
column, then enter a name for the biological group. For example, BrainGP.

4. Assign the biological replicate group(s) to the reaction plate:

a. Select wells in the plate layout that contain samples associated with the
biological replicate group.

b. In the Assign column, select the check box of the appropriate biological
replicate group.

IMPORTANT! A sample cannot belong to more than one biological group.

Set Up Biological Replicate Groups

l INo Biological Replicates J| + Specify Biological Replicate Groups ~|» 1
* How many Biological Replicate Groups do you want to testin the reaction plate? E— 2
Selectwell(s) in the plate layout, then assign a hiological replicate group from the list.
Assign Biological Group Mame Color Comments
4b H—1[1 |Bi0|0gica| Replicate Group 1| v | |
O |Bi0|0gica| Replicate Group 2 | v | |
3 1

For More For more information on:

Information * Completing the Samples screen — Open the 7500 Software Help by clicking @) or
pressing F1.
» Using Advanced Setup — See “Advanced Setup Workflow” on page 204.
Notes
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Set Up the Relative Quantitation Settings

In the Relative Quantitation Settings screen, select the reference sample and the
endogenous control to perform relative quantitation.

About the In the comparative C example experiment:

Example * Brain is used as the reference sample.

Experiment » 18S is used as the endogenous control.

Complete the 1. Inthe Which sample do you want to use as the reference sample? drop-down list,
Relative select Brain.
Quantitation

Settings Screen 2. Inthe Which target do you want to use as the endogenous control? drop-down list,

select 18S.

3. Click Next.

2C. Set Up: Relative Quantitation Settings Relative Cuartitation Settings Help g/,

a Instructions: Select the reference sample and the endogenous control to perform relative guantitation
1 Which sample do you wantto use as the reference sample? |Brain b
2 ‘Which target do you want to use as the endogenous control? |185 he

Design  When you design your own comparative C experiment:

Guidelines * Select a reference sample from your previously created samples (“Set Up the
Samples” on page 121). Amplification results from the samples are compared to the
amplification results from the reference sample to determine relative expression.

* Select an endogenous control from your previously created target assays (“Set Up
the Targets” on page 119). Amplification results from the endogenous control are
used to normalize the amplification results from the target for differences in the
amount of template added to each reaction.

For More For more information on:
Information » Completing the Relative Quantitation Settings screen — Open the 7500 Software
Help by clicking @) or pressing F1.
* Reference samples (also known as calibrators) and endogenous controls — See User
Bulletin #2: Relative Quantitation of Gene Expression.

Notes
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Set Up the Run Method

In the Run Method screen, review the reaction volume and the thermal profile for the

default run method. If needed, you can edit the default run method or replace it with one
from the Run Method library.

About the In the comparative C; example experiment, the default run method is used without edits.
Example
Experiment

Review the Run 1. Select either the Graphical View tab (default) or Tabular View tab.
Method Screen ‘ S
2. Make sure the Reaction Volume Per Well field displays 50 uL.

3. Make sure the thermal profile displays the holding and cycling stages shown below.
If necessary, add click on a temperature or time setting and change it.

4. Click Next.

2D. Set Up: Run Method Run Method Help @)
n Instructions: Review the reaction volume and the thermal profile for the default run method. If needed, edit the default run method or select a run method from the library.
1—f Graphical View T Tabular View ]
2 —— Reaction Volume PerWell L [ ExpertMoce |
Add Stage ¥ | Add Step ¥ | Delete Selected ‘ || Collect Data ¥ H Open Run Method | Save Run Method . | Revertto Defaults | |
Holding Stage Haolding Stage Cycling Stage
Mumber of Cycles
[[] Enable AutoDelta
Starting Cycle: [ |
00 —| 850°C 850°C
10:00 100% 00:15
75 —| 1088
3 0o 50.0°C
50.0°C 01:00
80 — —
02:00
To0%
25 —|
a—|
Step 1 Step 1 Step 1 Step 2
N < >
Legend
Data Collection On Data Gollection Off A AutoDelta On A AutoDefta OF
Notes
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Design  When you design your own comparative C experiment:

Guidelines * Enter a number from 10 to 100 for the reaction volume/well. The 7500 system

supports reaction volumes from 20 to 100 uL. The 7500 Fast system supports
reaction volumes from 10 to 30 uL.

* Review the thermal profile:
— Make sure the thermal profile is appropriate for your reagents.
— If you are performing 1-step RT-PCR, include a reverse transcription step.

If your experiment requires a different thermal profile, edit the thermal profile or
replace the run method with one from the Run Method library. The Run Method
library is included in the 7500 software.

For More For more information on:

Information * The Run Method library or on completing the Run Method screen — Open the
7500 Software Help by clicking @) or pressing F1.
» Using Advanced Setup — See “Advanced Setup Workflow” on page 204.
Notes
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Review the Reaction Setup

In the Reaction Setup screen, select the assay type (if using TagMan reagents), then
review the calculated volumes for preparing the PCR reactions and sample dilutions. If
needed, you can edit the reaction volume, excess reaction volume, component
concentrations, and/or diluted sample concentration.

About the In the comparative C; example experiment:
Example .

: Applied Biosystems TagMan® Gene Expression Assays are used.
Experiment

* The reaction volume per well is 50 uL.
* The excess reaction volume is 10%.
* The reaction components are:
— TagMan® Universal PCR Master Mix (2X)

Assay Mix (20X) for each target (18S, EGR3, MAOB, OGDH, OSGEP, and
SERPING]1)

Sample
— Water
* The diluted sample concentration is 50 ng/uL.

* The sample stock concentration is 100 ng/pL.

Complete the IMPORTANT! Perform the following steps for each target assay in the reaction plate.
Reaction Setup
Screen

Complete the Reaction Mix Calculations Tab for the Assays
1. Select the Reaction Mix Calculations tab (default).

. In the Select Target pane, select 18S.

. In the Assay Type drop-down list, select Inventoried/Made to Order.

2
3
4. Make sure the Reaction Volume Per Well field displays 50 nL.
5. Make sure the Excess Reaction Volume field displays 10%.

6

. In the Reactions for 18S pane:
a. Make sure the Master Mix Concentration field displays 2.0X.
b. Make sure the Assay Mix Concentration field displays 20.0X.

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve 127
and Comparative C; Experiments



Chapter 6 Design the Comparative C; Experiment
o Review the Reaction Setup

2E. Set Up: Reaction Setup

c. Review the components and calculated volumes for the PCR reactions:

Component Volume (pL) for 1 Reaction
Master Mix (2.0X) 25.00
Assay Mix (20.0X) 2.50
Sample (10X) 5.00%
H20 17.50
Total Volume 50.00

I The sample volume is limited to 10% of the total reaction volume.

3 4 5

Reaction Setup Help @

u Instructions: reactions. Ifneeded, editthe reaction voluine, excess reaction volume, compon

For each target assay in the reaction plate| select the assay type (ifusing TagMin reagents), then review the calculated yplumes for preparing the samples and PCR

=nt concentrations, and/or stock concentfations. Click "Print Reaction Setup” to print
instructions on how to prepare the PCR refactions.
1 —— [ Reaction Mix Calculations T Sarnple Dill.tion Calculations ]
2 Jismecﬂargel Assay Type Inventoried/Made to Order % | Reaction Volume PerWell: | 50 | L Excess Reaction Volume 10]% (Lernt Reacton setup MJ
EGR3 Reactions for 185
6a MAOR
S
6b 828;: Master Mix Concentration 2.0 | X Assay Mix Concentration ‘200 X
SERPINGT ||| component Valume (uL) for 1 Reaction
’7 Master Mix (2.0) 25.00
6¢c
t Total Volume 50.00
7. Repeat steps 2 through 6 for the remaining targets listed in the Selected Targets pane
(EGR3, MAOB, OGDH, OSGEP, and SERPING1).
Complete the Sample Dilution Calculations Tab
1. Select the Sample Dilution Calculations tab.
2. Click the Diluted Sample Concentration (10X for Reaction Mix) ficld, then
enter 50.0.
3. In the unit drop-down list, select ng/uL (default).
Notes
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4. Review the calculated volumes for the sample dilutions:

Sample Stock Concentration Sample Volume Diluent Volume Total Volume of Diluted Sample
Name (ng/pL) (uL) (uL) (bL)
Brain 100.0 66.00 66.00 132.00
Kidney 100.0 66.00 66.00 132.00
Liver 100.0 66.00 66.00 132.00
Universal 100.0 66.00 66.00 132.00
2E. Set Up: Reaclion Setup Reaction Setup Help )

For each target assay in the reaction plate, selectthe assay type (if using TagMan reagents), then review the calculated volumes for preparing the samples and PCR
a Instructions: reactions. If needed, edit the reaction volume, excess reaction volume, component concentrations, andior stock concentrations. Click "Print Reaction Setup” to print

1 insfruetions an how fn nrenare the PCR rearfions
2 [ Reaction Mix Calculations | Sample Dilutiop Calculations ]
Diluted Sample Concentration (10X for Reaction Mix) naiL (¥ | Print Reaction Setup |
Sample Mame Stock Concentration (ng/uL) Sample Volume (L) Diluent Volume (L) Total Volume of Diluted Sample (uL)
" [lerain [100.0 | 66.00 66.00 132.00
4 ‘ Kidney [100.0 | 66.00 66.00 132.00
Liver [100.0 | 66.00 66.00 132.00
Universal [100.0 | 66.00 66.00 132.00

Print Reaction Setup Instructions

Print reaction setup instructions for use in Chapter 7, “Prepare the Comparative C
Reactions.”

1. Click Print Reaction Setup.

2. In the Print Reaction Setup Instructions dialog box, select:
* Detailed Reaction Setup Instructions
* Include Plate Layout

e Use sample color
3. Click Print to print the reaction setup instructions.

4. Click Next.

2E. Set Up: Reaction Setup Reaction Setup Help @‘,

7 For each target assay I the rea o Dl at: s
a Instructions: reactions. f needead, editthe reaction volu TR R TR I [ E T T T
instructions on how to prepare the PCR 1

Reaction Mix Calculations I Sample Dil @ Selectthe ype of instructions to print

gl | voluMes for preparing the samples and PCR
ﬁ| entrations. Click"Print Reaction Setup” to print

Diluted Sample Concentration (10X for Reaction Mix) |: | print Reaction Setup | | 1

() Summary Reaction Setup Instructions

Sample Mame Stock Concentration
2 S 66.00) 132.00

Kidney 100.0 66.00 132.00]

——(@ Use sample color

Liver 100.0 66.00 132.00]

(O Use task calor

Universal 100.0 66.00 132.00]

Total Valume of Diluted Sample (L)

3
Preview ‘ |E| ‘ Cancel
Notes
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Notes
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Review the Reaction Setup

Design
Guidelines

When you design your own comparative C; experiment:

If you are using TagMan reagents, select the type of assay you are using;:
— Select Inventoried/Made to Order if you are using Applied Biosystems
TagMan® Gene Expression Assays (Inventoried or Made to Order), or Applied

Biosystems Custom TagMan® Gene Expression Assays.

— Select Custom if you are designing your own assays with Primer Express®

software.

Enter a number from 10 to 100 for the reaction volume/well. The 7500 system
supports reaction volumes from 20 to 100 puL. The 7500 Fast system supports
reaction volumes from 10 to 30 uL.

Include excess reaction volume to account for the loss that occurs during pipetting.
Applied Biosystems recommends an excess reaction volume of at least 10%.

Review the reaction mix concentrations for each target: If needed:
— For TagMan reagents, edit the master mix and assay mix concentrations.

— For SYBR Green reagents, edit the master mix, forward primer, and reverse
primer concentrations.

— For 1-step RT-PCR, edit the reverse transcriptase concentration.
Review the reaction mix components for each target:

— If you are running Fast PCR reactions, make sure you use Fast master mix in the
PCR reactions.

— If you are running standard PCR reactions, make sure you use standard master
mix in the PCR reactions.

— For 1-step RT-PCR, make sure you include reverse transcriptase in the PCR
reactions and use a specific buffer.

Review the sample dilution calculations for each sample. If needed, edit the diluted

sample concentration (including units) and stock concentration.

For More For more information on:

Information

Completing the Reaction Setup screen — Open the 7500 Software Help by clicking
@) or pressing F1.

Applied Biosystems assays — Refer to the:

— TagMan® Gene Expression Assays Protocol

— Custom TagMan® Gene Expression Assays Protocol.
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Order Materials for the Experiment

Order Materials for the Experiment

In the Materials List screen, review the list of materials recommended to prepare the PCR
reaction plate. (Optional) Print the materials list, create a shopping list, then order the
recommended materials from the Applied Biosystems Store.

Note: You must have an Internet connection to access the Applied Biosystems Store.
Product availability and pricing may vary according to your region or country. Online
ordering through the Applied Biosystems Store is not available in all countries. Contact
your local Applied Biosystems representative for help.

Note: The 7500 software recommends the materials to order based on your experiment
design. It is assumed that you will design your experiment, order your materials, then
prepare (Chapter 7) and run (Chapter 8) the reaction plate when your materials arrive.

About the In the comparative C example experiment, the recommended materials are:
Exa_lmple + MicroAmp® Optical 96-Well Reaction Plate
Experiment » MicroAmp " Optical Adhesive Film
+ MicroAmp® Splash Free Support Base
+ TagMan® Universal PCR Master Mix (2X), No AmpErase® UNG
* 18S Assay Mix: Hs99999901_s1
* EGR3 Assay Mix: Hs00231780_m1 (RefSeq NM_004430.2)
* MAOB Assay Mix: Hs00168533_m1 (RefSeq NM_000898.3)
* OGDH Assay Mix: Mm00803121_m1 (RefSeq NM_010956.3)
* OSGEP Assay Mix: Hs00215099_m1 (RefSeq NM_017807.2)
* SERPINGI Assay Mix: Hs00163781_m1 (RefSeq NM_001032295.1/NM_000062.2)

Complete the 1. Find the target assay in the Applied Biosystems Store:
Ordering

Materials Screen a. Click the Enter Gene Name field, enter 18S, then click Find Assay.

b. In the Find Assay Results dialog box, select the Hs99999901_s1 assay row,
then click Apply Assay Selection.

2. Repeat step 1 to apply the remaining target assays for the experiment:
* EGR3 Assay Mix: Hs00231780_ml1
* MAOB Assay Mix: Hs00168533_m1
* OGDH Assay Mix: Mm00803121_m1
* OSGEP Assay Mix: Hs00215099_m1
* SERPINGI1 Assay Mix: Hs00163781_m1

Notes
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Notes
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Order Materials for the Experiment

3. In the Display drop-down list, select All Items (default), then review the

recommended materials.

Note: For more information on a specific item, click the part number link. You are
connected to the product information page at the Applied Biosystems Store. To
access the Applied Biosystems Store, you need to have an Internet connection.

. (Optional) Click Print Materials List to print the materials list.

. (Optional) Create a shopping list:

a. Select the check box next to each of the following items:
+ MicroAmp® Optical 96-Well Reaction Plate
+ MicroAmp"" Optical Adhesive Film
+ MicroAmp® Splash Free Support Base
+ TagMan® Universal PCR Master Mix (2X), No AmpErase® UNG
* 18S Assay Mix: Hs99999901_s1
* EGR3 Assay Mix: Hs00231780_ml1
* MAOB Assay Mix: Hs00168533_m1
* OGDH Assay Mix: Mm00803121_m1
* OSGEP Assay Mix: Hs00215099_m1
* SERPINGI1 Assay Mix: Hs00163781_m1

b. Click Add Selected Items to Shopping List.

. (Optional) Create a shopping basket at the Applied Biosystems Store:

Note: You must have an Internet connection to access the Applied Biosystems
Store. Product availability and pricing may vary according to your region or country.
Online ordering through the Applied Biosystems Store is not available in all
countries. Contact your local Applied Biosystems representative for help.
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Order Materials for the Experiment

a. Check that the Experiment Shopping List contains the desired materials and
that the quantities are correct, then click Order Materials in List.

3A. Order: Materials List (Optional) Materials List Help QJ

a Instructions; 2ViEw the list of materials recommendead to prepare the PCR reaction plate. To create a shopping basket on the Applied Biosystems Store, add items to the shapping list,
" enter a name for the shopping basket, click"Order Materials in List," then log in.

Enter Gene Name ‘ GAPDH | (e J Enter a gene name, then click "Find Assay" to search the Applied Biosystems Store for a gene expression
1a,1a 1 T assay
;
|
5b7+ Add Selected ftems to Shopping List J Display |AH ltems 4 | | Prit Materials List | 4
[ Check All tem Part Mumhber Description
TITCTOTE TCTIES TS REVETSE TTAIMSTTITPTESE, RTTE S IO, T WIS, F
5a Il TagMan® Reverse Transcriptase Reagents MNBO0B0234 Oligo d(T)16, Random Hexamers, 10X RT Buffer, MgCI2 Solution. Sufficient for [~
200 Reverse Transcriptase reactions at 10 pL reaction volume.
‘ Find Assay Results
4 Assays Found. Click the Assay 1D to view the assay in the Applied Biosystems Store. Select an assay to detect and quantify the target sequence. 185 ~
Availahility Assay D Gene Symhbal Gene Name RefSeq
1b Pre mads Hsogggggnt s1 188 Eukaryotic 185 rRNA _
Wadeto Order  RhO2796879 mi HSASTE1 similar to Probable dimethyladenc... XM_001085304.1 ] (" Order Materias in List 6a
RN02796879 m1 order Materis i Lis |
Wadeto Order  RhO0917510 mi HSA97E similar to Probable dimethyladenc... XM_001085304.1
Wadeto Order  RhO0917511 mi HSAS7E similar to Probable dimethyladenc... XM_001085304.1
|
|
|
1b ‘
(et | Tort (et ) (Lamt| [ (Aorty Assny Seection ) | carcet )
b. In the Order Materials - Log In dialog box, enter your user name and password
for the Applied Biosystems Store, then click Log In and Submit.
Note: If you do not have an account with the Applied Biosystems Store, click
Register Now to create an account.
Order Materials - Log In El
Log into the Applied Biosysterns Store to place the selected items in your shopping basket. fyou do not
have a user name and password, click "Register Now" o create a new account.
Store Log In OR Register
To log into the Applied Biosystems Store, enter your user Iryou do_ nothave
name and password then click "Log In and Submit" ap Applied
1N Biosystems
’7 User Narme: | ‘ account, click the
link below to
create a new
(5] o — Passward: | ‘ account
| Log In and Submit | Cancel
Reqgister Now
[ Remember my username and password for future arders
c. When you are connected to the Applied Biosystems Store, follow the prompts
to complete your order.
7. Go to “Finish the Design Wizard” on page 134.
Notes
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Finish the Design Wizard

When you design your own comparative C; experiment:

Design

Guidelines Select all the materials you require for your experiment, then add them to your

shopping list.
» To access and use the Applied Biosystems Store:
— Confirm that your computer has an Internet connection.

— Use the following Applied Biosystems-recommended browsers and versions of
Adobe® Acrobat® Reader:

Desktop ® Microsoft® . ® Adobe®
Operating "rl\leat\?iczrt)gr Internet Ma;;r}tac:?h Acrobat®
System 9 Explorer Reader
Windows® v6.x or later v6.x or later Not applicable v4.0 or later
2000/NT/XP/Vista
Macintosh® Not supported | Not supported | v2.0.4 or later v4.0 or later

OS 9+ or later

IMPORTANT! Make sure that cookies and JavaScript are turned on.

For More For more information on completing the Materials List screen, open the 7500 Software
Information  Help by clicking @) or pressing F1.

Finish the Design Wizard

To finish the Design Wizard, review the plate layout, then select an exit option.

About the The 7500 software automatically selects locations for the wells in the reaction plate. In

Example the comparative C; example experiment:
Experiment » The wells are arranged as shown below.
1 [z [ s [ o« [ s | & [ ¢ [ & [ s [ 10 [ 1 [ 12 |

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

A 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

B 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

o] 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

] 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP 1BS MﬂDE mDSGEP

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

E EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

F EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

] EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\

|| Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

H EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\ EGRS DGDH SERP\

Notes
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Finish the Design Wizard

» The experiment is saved as is and closed.

Note: For the example experiment, do not perform the run at this time.

Finish the 1. At the bottom of the 7500 software screen, click Finish Designing Experiment.
Design Wizard

2. In the Review Plate Layout for Experiment window, review the plate layout. Make
sure there are:

* 96 Unknown wells [T
* 0 Negative Control wells []
* 0 Empty wells

Note: If the plate layout is incorrect, click Return to the Wizard, then check your
entered values.

3. Click Save Experiment.

r_-._ Review Plate Layout for Experiment "Comparative CT Example™

a Review the plate layout, then select what you want to do next.

3 Save Experiment Start Run for This Experiment Edit Plate Layout Create Another Experiment Return to the Wizard
| Using the Design Wizard

Save and close this Save this experiment, then Use Advanced Setup to edit Save and close this Continue designing this

experiment. startthe run. Make sure the the plate layout. experiment, then create experiment using the Design
reaction plate is loaded into another experiment using the Wizard
the instrument. Design Wizard
| B show inWells ¥ | Visw Lagand | BE | B |

[ + [ 2 [ 3 [ o« | & | & [ 7 [ & [ 8 [ 1o [ 11 [ 12 |

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

A [m s [ M40 [I] OSGEF [ 8S [ M40 [I] OSGEF [ 8S [[1ace  |[m] oscer [ 1S [ 1ace  |[r] OsGE?

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

B [m s [ M40 [I] OSGEF [ 8S [ M40 [I] OSGEF [ 8S [[1ace  |[m] oscer [ 1S [ 1ace  |[r] OsGE?

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

o3 m«as mMAOB mOSGEP m«as mMAOB mOSGEP m«as mMAOB mOSGEP m«as mMAOB mOSGEP

Brain EBrain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

2 D m«as mMAOB mOSGEP m«as mMAOB mOSGEP m«as mMAOB mOSGEP m«as mMAOB mOSGEP
: Brain EBrain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

? Brain EBrain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

N Brain EBrain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

e} mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

Brain EBrain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

H mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

Notes
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Finish the Design Wizard

4. Inthe Save Experiment dialog box, enter Comparative Ct Example Setup.eds in
the File name drop-down list, then click Save. The example experiment is saved and
closed, and you are returned to the Home screen.

IMPORTANT! Do not save the experiment using the default file name. Doing so will
overwrite the example experiment already present in the experiments folder.

Note: By default, the example experiment is saved to the
<drive>:\Applied Biosystems\<software name>\experiments folder.

Design  When you design your own comparative C experiment:

Guidelines  In the Review Plate Layout for Experiment window, select the appropriate exit option:
Click To...
Save Experiment Save and close the experiment without making any

further changes or starting the run.

Start Run for This Experiment | Save the experiment and start the run. Make sure the
reaction plate is loaded in the instrument.

Edit Plate Layout Use advanced setup to edit the plate layout.

Create Another Experiment Save and close the current experiment, then create

Using the Design Wizard another experiment using the Design Wizard.

Return to the Wizard Return to the experiment to make changes using the
Design Wizard.

* By default, experiments are saved to:
<drive>:\Applied Biosystems\<software name>\experiments
To change the:

— Save location for a specific experiment — Navigate to the desired location using
the Save Experiment dialog box.

— Default save location — Select Tools » Preferences, then select the Defaults tab.
In the Data Folder field, browse to then select the desired location.

For More For more information on using Advanced Setup, see “Advanced Setup Workflow” on
Information page 204.

Notes
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Chapter 7

ﬂ Prepare the Comparative C; Reactions

This chapter covers:

B Chapter OVeIrVIEW . . . ottt e e e e et e e 138
B Prepare the Template. .. ... i e e 139
B Prepare the Sample Dilutions . .. ........ .. ... i 142
B Prepare the Reaction Mix .. ... ... i 144
B Prepare the ReactionPlate . .......... .. .. .. . . . 146

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

This chapter explains how to prepare the PCR reactions for the comparative C (AACy)
example experiment and it provides guidelines for how to prepare the PCR reactions for
your own comparative C experiment.

Example Start Comparative C; (AAC;) Experiment
Experiment w
Workflow Design the Experiment (Chapter 6)
v

Prepare the Reactions (Chapter 7)
1. Prepare the template.
2. Prepare the sample dilutions.

3. Prepare the reaction mix for each target assay.

4. Prepare the reaction plate.

v
Run the Experiment (Chapter 8)
v
Analyze the Experiment (Chapter 9)

End Experiment

Notes
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Prepare the Template

Prepare the Template

Prepare the template for the PCR reactions using the High-Capacity cDNA Reverse
Transcription Kit.

IMPORTANT! Applied Biosystems recommends that you use the High-Capacity cDNA
Reverse Transcription Kit to reverse-transcribe cDNA from total RNA. The TagMan®
Gene Expression Assays are designed to be compatible with the High-Capacity cDNA
Reverse Transcription Kit; other protocols have not been tested for use with the TagMan
Gene Expression Assays.

About the For the comparative C example experiment, the template for the PCR reactions is cDNA
Example reverse-transcribed from total RNA samples using the High-Capacity cDNA Reverse
Experiment Transcription Kit.

Required + One of the following Ambion® starter packs for RNA isolation:
Materials

Catalog

Kit Contents Number

qgRT-PCR RNA/ater® Tissue Collection: RNA Stabilization AM7020
Starter Pack Solution

RNaseZap® Wipes AM9786

RT-PCR Grade Water (nuclease-free) AM9935

Silencer® Validated siRNA, Std Purity AM51331

Choice of RNA sample preparation products:

¢ RNAqueous®-4PCR Kit AM1914

Note: Recommended if you are isolating RNA from
cells or tissues that may be difficult to disrupt or
have high RNase activity.

¢ RiboPure™ Kit AM1924
Note: Recommended if you are:

¢ Isolating RNA from all tissues, including those
that may be difficult to disrupt, are rich in lipids,
or have high RNase activity, or

¢ Labeling and amplifying RNA for use on
microarrays.

e TURBO DNA-free™ AM1907

Note: Recommended if you are using SYBR®
Green reagents. If you are using SYBR Green
reagents, use TURBO DNA-free in conjunction with
the RiboPure Kit.

Notes
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Prepare the Template

. Catalog
Kit Contents Number
PCR Starter RT-PCR Grade Water (nuclease-free) AM9935
Pack
DNAZap™ AM9890
Choice of RNA sample preparation products, as See above
listed above under the gRT-PCR Starter Pack.
High Capacity RNA/ater® Tissue Collection: RNA Stabilization AM7020
cDNA Kit Solution
RNaseZap® Wipes AM9786
Choice of RNA sample preparation products, as See above
listed above under the gRT-PCR Starter Pack.
miRNA Starter Pre-miR™ miRNA Starter Kit AM1540
Pack

» Total RNA isolated from liver, kidney, brain, and universal tissues
* One of Applied Biosystems High-Capacity cDNA Reverse Transcription Kits:

Kit Part Number
High-Capacity cDNA Reverse Transcription Kit (200 reactions) 4368814
High-Capacity cDNA Reverse Transcription Kit (1000 reactions) 4368813
High-Capacity cDNA Reverse Transcription Kit with RNase Inhibitor 4374966
(200 reactions)
High-Capacity cDNA Reverse Transcription Kit with RNase Inhibitor 4374967
(1000 reactions)

Note: The High-Capacity cDNA Reverse Transcription Kit was formerly called the
High-Capacity cDNA Archive Kit.

Prepare the Use the High-Capacity cDNA Reverse Transcription Kit to reverse-transcribe cDNA
Template from the total RNA samples. Follow the procedures in the Applied Biosystems High-
Capacity cDNA Reverse Transcription Kits Protocol to:

1. Prepare the RT master mix.

| A (\UI[e]l] CHEMICAL HAZARD. 10X RT Buffer may cause eye, skin,

and respiratory tract irritation. Read the MSDS, and follow the handling
instructions. Wear appropriate protective eyewear, clothing, and gloves.

2. Prepare the cDNA reactions.

3. Perform reverse transcription on a thermal cycler.

Notes
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Prepare the Template

Preparation When you prepare your own comparative C (AACy) experiment Applied Biosystems
Guidelines recommends:

» That you first extract DNA or RNA from the tissue or sample.
* The following templates:

— Complementary DNA (cDNA) — cDNA reverse-transcribed from total RNA
samples using a High-Capacity cDNA Reverse Transcription Kit.

— RNA - Purified total RNA or mRNA extracted from tissue or sample.
— Genomic DNA (gDNA) — Purified gDNA already extracted from tissue or sample.

For More For more information on:

Information » Preparing cDNA templates — Refer to the Applied Biosystems High-Capacity cDNA
Reverse Transcription Kits Protocol. The protocol is not shipped with the High-
Capacity cDNA Reverse Transcription Kits. You can download the protocol from:
http://docs.appliedbiosystems.com/search.taf

* Preparing RNA or gDNA templates — Refer to the protocol for the purification
reagents that you select. To locate Applied Biosystems purification reagents, visit:

http://www.appliedbiosystems.com/

Notes
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Prepare the Sample Dilutions

Prepare the Sample Dilutions

Notes

142

Perform sample dilutions before adding the samples to the final reaction mix. Dilute the
samples using the volumes that were calculated by the 7500 software (“Select the Sample
Dilution Calculations tab.” on page 128).

About the For the comparative C example experiment:

Exa_lmple » Sample dilutions are necessary because the sample volume is limited to 10% of the
Experiment total reaction volume in the 7500 software. Because the total reaction volume is
50 pL/reaction, the sample volume is 5 puL/reaction.

» The stock sample concentration is 100 ng/uL. After diluting the sample according to
the Sample Dilutions Calculations table, the sample has a concentration of
50 ng/uL. Adding 5 UL at this concentration to the final reaction mix volume of
50 uL yields a 1X concentration in the final reaction.

* The volumes calculated in the software are:

Sample Stock Concentration Sample Diluent Total Volume of
Name (ng/uL) Volume (uL) | Volume (puL) | Diluted Sample (uL)

Brain 100.0 66.0 66.0 132.0

Kidney 100.0 66.0 66.0 132.0

Liver 100.0 66.0 66.0 132.0

Universal 100.0 66.0 66.0 132.0

Required « Water (to dilute the sample)
Materials * Microcentrifuge tubes

* Pipettors

* Pipette tips

» Sample stock

» Vortexer

* Centrifuge
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Prepare the Sample Dilutions

Prepare the 1. Label a separate microcentrifuge tube for each diluted sample:
Sample Dilutions e Brain

* Kidney
e Liver

e Universal

2. Add the required volume of water (diluent) to each empty tube:

Tube Sample Name Diluent Volume (uL)
1 Brain 66.0
2 Kidney 66.0
3 Liver 66.0
4 Universal 66.0

3. Add the required volume of sample stock to each tube:

Tube Sample Name Sample Volume (uL)
1 Brain 66.0
2 Kidney 66.0
3 Liver 66.0
4 Universal 66.0

4. Vortex each diluted sample for 3 to 5 seconds, then centrifuge the tubes briefly.

5. Place the diluted samples on ice until you prepare the reaction plate.

Preparation When you prepare your own comparative C experiment:

Guidelines » Sample dilutions may be necessary because the sample volume is limited to 10% of

the total reaction volume in the 7500 software. You must perform the sample
dilutions before adding the samples to the final reaction mix.

+ For optimal performance of TagMan® Gene Expression Assays or Custom TagqMan®
Gene Expression Assays, use 10 to 100 ng of cDNA template per 20-uL reaction.

* Use TE buffer or water to dilute the sample.

For More For more information on Applied Biosystems assays, refer to the:

Information » TagMan® Gene Expression Assays Protocol
 Custom TagMan® Gene Expression Assays Protocol.
Notes
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Prepare the Reaction Mix

Prepare the Reaction Mix

Prepare the reaction mix using the components and volumes that were calculated by the
7500 software (“Complete the Reaction Mix Calculations Tab for the Assays” on page 127).

Note: The software calculates the volumes for all components for the PCR reactions.
However, when you prepare the reaction mix in this section, include only the master mix,
assay mix, and water. Add the sample when you prepare the reaction plate (see “Prepare
the Reaction Plate” on page 146).

About the For the comparative C; example experiment:

Exgmple * The reaction mix components are:
Experiment — TagMan® Universal PCR Master Mix (2X)

— 18S Assay Mix (20X)

— EGR3 Assay Mix (20X)

— MAOB Assay Mix (20X)

— OGDH Assay Mix (20X)

— OSGEP Assay Mix (20X)

— SERPINGI Assay Mix (20X)

— Water

* The volumes calculated in the software for the target assays are:
Component Volume (pL) for 1 Reaction

Master Mix (2.0X) 25.0
Assay Mix (20.0X) 2.50
Water | 17.50
Total Volume 45.0

Note: The sample is not added at this time.

Required  Microcentrifuge tubes
Materials « Pipettors

* Pipette tips
» Reaction mix components (listed above)

* Centrifuge

Notes
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Prepare the Reaction Mix

Prepare the IMPORTANT! Prepare the reaction mix for each target assay separately.
Reaction Mix

1. Label an appropriately sized tube for each reaction mix:
* 18S Reaction Mix
* EGR3 Reaction Mix
e MAOB Reaction Mix
* OGDH Reaction Mix
* OSGEP Reaction Mix
* SERPINGI1 Reaction Mix

2. For the 18S assay, add the required components to the 18S Reaction Mix tube:

Component Vo:u;:&;:g:or v‘?éug:ezg:mg '
(Plus 10% Excess)
TagMan® Universal PCR Master Mix (2X) 25.0 440.0
18S Assay Mix (20X) 2.5 44.0
Water 17.5 308.0
| Total Reaction Mix Volume 45.0 792.0

. Repeat step 2 for each remaining assay: EGR3, MAOB, OGDH, OSGEP, and SERPING].

3
4. Mix the reaction mix in each tube by gently pipetting up and down, then cap each tube.
5. Centrifuge the tubes briefly to remove air bubbles.

6

. Place the reaction mixes on ice until you prepare the reaction plate.

Preparation When you prepare your own comparative C experiment:
Guidelines  If your experiment includes more than one target assay, prepare the reaction mix for
each target assay separately.
* Include excess volume in your calculations to provide excess volume for the loss

that occurs during reagent transfers. Applied Biosystems recommends an excess
volume of at least 10%.

* Include all required components.
* Prepare the reagents according to the manufacturer’s instructions.

» Keep the assay mix protected from light (in the freezer) until you are ready to use it.
Excessive exposure to light may affect the fluorescent probes.

* Prior to use:
— Mix the master mix thoroughly by swirling the bottle.
— Resuspend the assay mix by vortexing, then centrifuge the tube briefly.

— Thaw any frozen samples by placing them on ice. When thawed, resuspend the
samples by vortexing, then centrifuge the tubes briefly.

Notes
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Prepare the Reaction Plate

For More For more information on preparing the reaction mix, refer to the protocol appropriate for
Information the reagents you are using in the PCR reactions:

s TagMan® Gene Expression Assays Protocol

» Custom TagMan® Gene Expression Assays Protocol

Prepare the Reaction Plate

Prepare the reactions for each replicate group, then transfer them to the reaction plate.
Use the plate layout displayed in the 7500 software.

About the For the comparative C example experiment:
Exa_lmple + A MicroAmp® Optical 96-Well Reaction Plate is used.
Experiment

The reaction volume is 50 puL/well.
* The reaction plate contains:
— 96 Unknown wells [0
— 0 Negative Control wells []
— 0 Empty wells
» The plate layout that is automatically generated by the 7500 software is used:

Required .

Materials

Microcentrifuge tubes
Pipettors

[z [ 3 ] 4 ] s [ & [ 7 [ & [ & [ 10 [ 11 [ 1z |

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

A m1EIS mM.AOB mOSGEP m1EIS mM.AOB mOSGEP m1EIS mM.AOB mOSGEP m1EIS mM.AOB mOSGEP

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

B m1EIS mM.AOB mOSGEP m1EIS mM.AOB mOSGEP m1EIS mM.AOB mOSGEP m1EIS mM.AOB mOSGEP

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

o] 188 MACE OSGEP 188 MACE OSGEP 188 MACE OSGEP 188 MACE OSGEP
m m m m m m m m m m m m

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

[u] 188 MACE OSGEP 188 MACE OSGEP 188 MACE OSGEP 188 MACE OSGEP
m m m m m m m m m m m m

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

E mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

F mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

G EGR3 QGDH SERPI EGR3 QGDH SERPI EGR3 QGDH SERPI EGR3 QGDH SERPI
m m m m m m m m m m m m

Brain Brain Brain Kidney Kidney Kidney Liver Liver Liver Universal Universal Universal

H mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\ mEGRG mOGDH mSERP\

* Pipette tips

* Reaction mixes (from page 145)

* Water

» Samples (from page 143)

+ MicroAmp® Optical 96-Well Reaction Plate
+ MicroAmp"" Optical Adhesive Film

* Centrifuge

Notes
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Reaction Plate

Chapter 7 Prepare the Comparative C; Reactions ﬂ

Prepare the Reaction Plate

1. For each replicate group, prepare the reactions for the unknowns:

a. To appropriately sized tubes, add the volumes of reaction mix and sample listed

below.

Reaction Mix Volume

Tube | Unknown Reaction Reaction Mix (L) Sample | Sample Volume (uL)
1 18S Brain 18S Reaction Mix 198.0 Liver 22.0
2 | 18S Kidney | 18S Reaction Mix 198.0 Kidney 22.0
3 18S Liver 18S Reaction Mix 198.0 Brain 22.0
4 18S Universal 18S Reaction Mix 198.0 Universal 22.0
5 EGR3 Brain EGR3 Reaction Mix 198.0 Liver 22.0
6 EGRS3 Kidney EGR3 Reaction Mix 198.0 Kidney 22.0

EGR3 Liver EGR3 Reaction Mix 198.0 Brain 22.0
8 | EGRS3 Universal | EGRS3 Reaction Mix 198.0 Universal 22.0
9 MAOB Brain MAOB Reaction Mix 198.0 Liver 22.0
10 MAOB Kidney MAOB Reaction Mix 198.0 Kidney 22.0
11 MAOB Liver MAOB Reaction Mix 198.0 Brain 22.0
12 MAOB Universal MAOB Reaction Mix 198.0 Universal 22.0
13 OGDH Brain OGDH Reaction Mix 198.0 Liver 22.0
14 | OGDH Kidney | OGDH Reaction Mix 198.0 Kidney 22.0
15 OGDH Liver OGDH Reaction Mix 198.0 Brain 22.0
16 OGDH Universal OGDH Reaction Mix 198.0 Universal 22.0
17 OSGEP Brain OSGEP Reaction Mix 198.0 Liver 22.0
18 OSGEP Kidney OSGEP Reaction Mix 198.0 Kidney 22.0
19 OSGEP Liver OSGEP Reaction Mix 198.0 Brain 22.0
20 | OSGEP Universal | OSGEP Reaction Mix 198.0 Universal 22.0
21 SERPING1 Brain SERPING1 Reaction Mix 198.0 Liver 22.0
22 SERPING1 Kidney SERPING1 Reaction Mix 198.0 Kidney 220
23 SERPINGH Liver SERPING1 Reaction Mix 198.0 Brain 22.0
24 SERPING1 Universal | SERPING1 Reaction Mix 198.0 Universal 22.0
b. Mix the reactions by gently pipetting up and down, then cap the tubes.
c. Centrifuge the tubes briefly to remove air bubbles.
d. Add 50 pL of the unknown (sample) reaction to the appropriate wells in the
reaction plate.
Notes
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Prepare the Reaction Plate

Preparation
Guidelines

2.
3.
4.

5.

Seal the reaction plate with optical adhesive film.
Centrifuge the reaction plate briefly to remove air bubbles.

Verify that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a higher speed and for a longer period of time.

IMPORTANT! Do not allow the bottom of the reaction plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block and cause an abnormally high background signal.

Correct Incorrect
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. |« Not centrifuged for enough time

Place the reaction plate on ice in the dark until you are ready to perform the run.

When you prepare your own comparative C experiment:

Make sure you use the appropriate consumables.

Make sure the arrangement of the PCR reactions matches the plate layout displayed
in the 7500 software. You can either:

— Accept the plate layout automatically generated by the software.
or

— Use Advanced Setup to change the plate layout in the software.

If you use optical adhesive film, seal each reaction plate as follows:

a. Place the reaction plate onto the center of the 96-well base.
b. Load the reaction plate as desired.

c. Remove a single optical adhesive film (film) from the box.

Fold back one of the end-tabs. Hold the film with its
backing side up.

d. In one continuous movement, peel back the white
protective backing from the center sealing surface. Do not
touch the center sealing surface.

IMPORTANT! Improper peeling of the optical adhesive film may result in
haziness, but does not affect results. Haziness disappears when the film comes
into contact with the heated cover in the instrument.
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Prepare the Reaction Plate

e. While holding the film by the end-tabs, lower the film onto
the reaction plate (adhesive side facing the reaction plate).
Be sure the film completely covers all wells of the reaction
plate.

f.  While applying firm pressure, move the applicator slowly
across the film, horizontally and vertically, to ensure good
contact between the film and the entire surface of the
reaction plate.

g. While using the applicator to hold the edge of the film in
place, grasp one end of the end-tab and pull up and away
sharply. Repeat for the other end-tab.

¥
]

h. Repeat step fto ensure a tight, evaporation-free seal. While
applying firm pressure, run the edge of the applicator
along all four sides of the outside border of the film.

Note: Optical adhesive films do not adhere on contact. The films require the
application of pressure to ensure a tight seal.

i. Inspect the reaction plate to be sure all wells are sealed. You should see an
imprint of all wells on the surface of the film.

For More For more information on:
Information » Preparing the reaction plate — Refer to the protocol appropriate for the reagents you
are using in the PCR reactions:
— TagMan® Gene Expression Assays Protocol
— Custom TagMan® Gene Expression Assays Protocol
* Consumables — See “Supported Consumables” on page 4.

» Using Advanced Setup to change the plate layout — See “Advanced Setup
Workflow” on page 204.

Notes
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Prepare the Reaction Plate

Notes
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Chapter 8

Run the Comparative C; Experiment

This chapter covers:

B Chapter OVeIrVIEW . . . ottt e e e e et e e 152
B Prepareforthe Run....... .. .. .. ... . . . . . . . 153
B Runthe Experiment ... ..... ... ... i 154

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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Chapter Overview

Chapter Overview

This chapter explains how to perform a run on the Applied Biosystems 7500/7500 Fast
Real-Time PCR Systems.

Example Start Comparative C; (AAC;) Experiment
Experiment v
Workflow - -
or Design the Experiment (Chapter 6)
v
Prepare the Experiment (Chapter 7)
v

Run the Experiment (Chapter 8)
. Prepare for the run.
. Enable the notification settings (Optional).
. Start the run.

. Monitor the run.

a W N =

. Unload the instrument.

h 4
Analyze the Experiment (Chapter 9)

v
End Experiment

Notes
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Prepare for the Run ®

Prepare for the Run

Prepare for the run by opening the example experiment file you created in Chapter 6,
then loading the sealed reaction plate into the 7500/7500 Fast instrument.

Open the 1. Double-click g (7500 software) or select Start » All Programs »
Example Applied Biosystems » 7500 Software » <software name>

Experiment where <software name> is the current version of the 7500 software.

2. In the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder (default) at:

<drive>:\Applied Biosystems\<software name>\experiments

4. Double-click the example experiment file that you created in Chapter 6.

&) 7500 Software v2.0
File Edit Instrument Analysis Tools Help

2 = = - BN Close | 4@ Export. - B PrintReport

Run Analyze

Design Wizard QuickStart Analyze Experiment

Advanced Setup Run Experiment

[»]

]

Template

I | 7500 : connected I

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve 153
and Comparative C; Experiments



m Chapter 8 Run the Comparative C; Experiment
Run the Experiment

Run the Experiment

Perform the following procedures in Chapter 4 for the comparative C; experiment:
* “Load the Reaction Plate into the Instrument” on page 68
» “Enable the Notification Settings (Optional)” on page 69
o “Start the Run” on page 71
* “Monitor the Run” on page 72
* “Unload the Instrument” on page 74

Notes
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m Analyze the Comparative C; Experiment

This chapter covers:

B Chapter OVEIVIEW . . . .ottt et et e e e et e e et 156
Section 9.1 ReviewResults.............coiiiiiiiiiiiiiiiiiiiininnnn. 157
B Analyze the Experiment .. ....... ... i 158
B View the Gene Expression Plotand Well Table . .. ....................... 162
B View the Amplification Plot. .. ....... .. .. ... .. .. .. . 166
B PublishtheData .......... ... ... . . 174
Section 9.2 Troubleshoot (If Needed) ........cciiiiiiiiiiiiinennnnnans 175
B View the Analysis Settings . . ............ i 176
B Viewthe QC Summary. ... ...ttt 179
B Omit Wells from the Analysis. .. ........ ... ... .. 181
B View the Multicomponent Plot. . .......... ... .. ... ... ... ... ... .. .... 182
B Viewthe Raw DataPlot . ...... ... ... .. .. ... .. i, 185
Section 9.3 Perform a Study of Multiple Experiments .................... 187
B Section OVEIVIEW . . . oottt e ettt e e e e et e 188
B Designa Study .. ..ot 189
B Analyzethe Study.......... .. 195
B Publishthe Data .......... ... .. . . . 202

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Chapter Overview

Chapter Overview

Example
Experiment
Workflow

Notes

The 7500 software analyzes the data using the comparative C (AACy) quantitation
method. This chapter includes the following sections:

Section 9.1 explains how to review the analyzed data using several of the analysis
screens and how to publish the data.

Section 9.2 explains how to perform some troubleshooting steps if you receive
questionable results.

Section 9.3 explains how to analyze multiple experiments as a study.

Start Comparative C; (AACy) Experiment

v
Design the Experiment (Chapter 6)

v
Prepare the Reactions (Chapter 7)

v
Run the Experiment (Chapter 8)

v

a b~ ON =

© 0N U A LN

Analyze the Experiment (Chapter 9)
Section 1, Review Results:
1. Analyze.

2. View the Gene Expression Plot/well table.
3. View the Amplification Plot.
4. Publish the data.

Section 2, Troubleshoot (If Needed):

. View the analysis settings; adjust the baseline/threshold.

. View the quality summary.
. Omit wells.
. View the Multicomponent Plot.

View the Raw Data Plot.

Section 3, Create a Study:
. Create a study.
. Define replicates.

Analyze.

. View the Gene Expression Plot.
. View the experiment data.

. View the Multicomponent Data.
. View multiple plots.

. View the quality summary.

. Publish the data.

v
End Experiment
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Section 9.1 Review Results

Section 9.1 Review Results

This section covers:

B Analyze the Experiment . .. ........ ... i 158
B View the Gene Expression Plotand Well Table . .. ....................... 162
B View the Amplification Plot. .. ....... .. .. .. . . 166
B PublishtheData ..... ... ... .. . 174
Notes
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Analyze the Experiment

Analyze the Experiment

Notes

158

The 7500 software analyzes the experiment and displays results in the analysis screens
(for example, the Amplification Plot screen, QC Summary screen, and so on).

About the For the comparative C example experiment, use the data file that is installed with the
Example 7500 software. This data file was created with the same design parameters that are
Experiment provided in Chapter 6, then run and analyzed on a 7500/7500 Fast instrument.

The data file for the example experiment is on your computer at:

<drive>:\Applied Biosystems\<sofiware name>\experiments\

Comparative Ct Example.eds

where:
* <drive> is the computer hard drive on which the 7500 software is installed.
» <software name> is the current version of the 7500 software.

Analyze the 1. Double-click g (7500 software) or select Start » All Programs »
Example Applied Biosystems » 7500 Software » <software name>
Experiment where <software name> is the current version of the 7500 software.

2. In the Home screen, click Open.

3. Inthe Open dialog box, navigate to the experiments folder at:

<drive>:\Applied Biosystems\<software name>\experiments\

4. Double-click Comparative Ct Example.eds to open the example experiment data
file.

Note: The examples folder contains several data files; be sure to select
Comparative Ct Example.eds.
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Analyze the Experiment

&) 7500 Software v2.0

File Edit Instrument Analysis Tools Help

2 o nEweapEnmEnY 5 Open. [l 00 ose | A Export & PrintReport..

Design Wizard QuickStart

[

3 . Lookin |@ experiments

4 - |3 comparative Ct Example.zds
| Comparative Ct Study Example (Biolagical Groups).edm

My Recent
Documents

2

O Comparative Ct Study Example.2dm
& Genotyping Example.eds

O Presence Absence Example.eds

@ Relative Standard Curve Example.gds
2

Desktop | Standard Curve Example.eds

My Documents

—

File name || L Qpen J

My Network y
Places Files of type |AHSDS Files (edm; eds; edt; sdm; sds; sdf) | cancel ]

Real-Time

7500 : connected

5. Click Analyze. The software analyzes the data using the default analysis settings.

6. See “Navigation Tips” on page 160 for information on navigating within the
analysis screens.

Guidelines When you analyze your own comparative C; experiment:

* Immediately after a run, the 7500 software automatically analyzes the data using the
default analysis settings, then displays the Amplification Plot screen on your
computer.

» To reanalyze the data, select all the wells in the plate layout, then click Analyze.

Notes
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Analyze the Experiment

Navigation Tips How to Select Wells

To display specific wells in the analysis screens, select the wells in the View Plate Layout
tab as follows:

1. To select wells of a specific type, use the Select Wells With drop-down lists, select
Sample, Target, or Task, then select the sample, target, or task name.

2. To select a single well, click the well in the plate layout.

3. To select multiple wells, click-drag over the desired wells, or CTRL+click or
Shift+click the desired wells in the plate layout.

4. To select all 96 wells, click the upper left corner of the plate layout.

o

»| View Plate LayoutT View Well Table W
SelectWells With: |[Sampl V| - Selectltem - |+
Selectltem -
| B show inWells ¥ Visw Lagand Brain | | BE | B |
Kidney
[ 2 3 [ 5 3 inersa\ 9 10 T 12
Brain Brain Brain Brain Brain Kidney Fidney Kidney Kidney Kidney Kidney
- _ ey - _ _ - ey
Cr: 2691 Cr:25.85
Brain Brain Brain Brain Brain Kidney Kidney Kidney Kidney Kidney Kidney
- _ - ey - _ _ - Eag
Cr:26.94 Cr: 258
Brain Brain Brain Brain Brain Kidney Kidney Kidney Kidney Kidney Kidney
- ey _ - _ _ - ey
Cr: 26.96 Cr:25.79
Brain Brain Brain Brain Brain Kidney Kidney Kidney Kidney Kidney Kidney
- _ - ey - _ _ - Eaig
Cr: 26.87 Cr:25.78
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
- _ - Eaig - _ _ - ey
Cr21.2 Cr:27.86
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
- Eag _ - _ _ - ey
Cr:21.04 Cr:27.86
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
- _ - Ea - _ _ - ey
Cr:21.15 Cr:27.87
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
- _ _ - Ea - _ _ - ey
Cr: 2118 Cr:27.98
wells: [[ 96 Unknown [ 0 Negative Control 0 Empty

Notes
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Analyze the Experiment
How to Display Multiple Plots

Use the Multiple Plots view to display up to four plots simultaneously. To navigate within
the Multiple Plots view:

1. In the navigation pane, select Analysis »

Multiple Plots View.

. To display four plots, click 55 (Show plots ina 2 5 2 matrix).

2

3. To display two plots in rows, click — (Show plots in two rows).

4. To display two plots in columns, click [|[| (Show plots in two columns).
5

. To display a specific plot, select the plot in the drop-down list above each plot

display.
5 23
T N I
B = a4
—
[ampiification Ptot - ARnvs cycle v AAmpiification Plot - Rnvs Cycle v
2 L aliEE 2 paHEE

Amplification Plot Amplification Plot

I EEEEEEEEEEE)

Cycle

Legend Lagend

’VIA Em® mP mA B gC gl

[Mutticomponent Piot v Raw Data Plot v
a2 =

Multicomponent Plot

Ampituck

Fluoreseence

) = .“:ﬂd B .[: .D
.RDX .FAM .E .F .G .H
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View the Gene Expression Plot and Well Table

View the Gene Expression Plot and Well Table

Displays the results of relative quantitation calculations in the gene expression profile.
Two plots are available:

* RQ vs Target — Groups the relative quantitation (RQ) values by target. Each sample
is plotted for each target. You can display the plot on a linear, log10, Ln, or log2 scale.

RQ vs Target

60
s0

40

RO

30

2 & ® o
S 2 & (=) o
= £ & - 25 ¢

Q
&

Taraet

{ Brain Liver Kidney Universal

* RQ vs Sample — Groups the relative quantitation (RQ) values by sample. Each target
is plotted for each sample.You can display the plot on a linear, log10, Ln, or log2 scale.

RQ vs Sample

&0
50
40

30

RO

Sample

AAAAA

The Well Table displays data for each well in the reaction plate, including:
* The sample name, target name, task, and dyes
* The calculated threshold cycle (Ct), normalized fluorescence (Rn), and quantity values
* Flags

About the In the comparative C example experiment, you review:

Example . gach target in the Gene Expression Plot screen for the expression level (or fold
Experiment change) of the target sample relative to the reference sample.

* The Well Table to evaluate the precision of the replicate groups.

Notes
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View the Gene Expression Plot and Well Table

View the Plot and 1. In the navigation pane, select Analysis » Gene Expression.
Well Table

Note: If no data are displayed, click Analyze.

2. In the Gene Expression Plot screen:
a. In the Plot Type drop-down list, select RQ vs Sample.
b. In the Graph Type drop-down list, select Log10.

c. In the Orientation drop-down list, select Vertical Bars.

3. Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

In the example experiment, the expression of EGR3, MAOB, OGDH, OSGEP, and
SERPINGI in the liver, kidney, and universal samples are displayed relative to the
expression in the reference sample (brain). Because the reference sample is
compared to itself, the relative expression level is 1. When the result is displayed in
the Log10 graph type, the expression level of the reference sample appears as 0 in
the graph (log10 of 1 =0).

2a 2b 2c

Plot i
| | |

PlotType: RQvs Sample % | Graph Type: |Log10 % | Orientation: Vertical Bars  |»

| |

Bl 3c
RQ vs Sample

loglORQ

o o

(=} o
|
I

i

[
|
|

& o & o
o ~ o o

Sample

Lgers
W ocor Mecr3 [ oscer [l maoB SERFING1

Notes
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View the Gene Expression Plot and Well Table

4. Click < at the top left of the View Technical Replicates tab.

The figure below shows the technical replicates table.

s [ View Technical Replicates ] View Biological Groups }

Shown Table v |
# | Omit Sample Target CTMean ACT Mean ACT 8D DCT RQ RQ Min RQ Max
1 Brain 185 10.883
2 Erain QGDH 26.8 15917 0.055 o 1 0.911 1.008
3 Brain EGR3 279 17.016 0.05 o 1 09139 1.088
4 Brain OSGEP 29.345 18.462 0.053 a 1 0915 1.083
5 Brain MAOB 25.906 15.023 0.064 1] 1 0.897 1115
[ Brain SERPING1 26.921 16.038 0.042 1] 1 0.931 1.074
7 Kidney 185 11.506
8 O Kidney QGDH 25.222 13.716 0.062 -2.202 4.6 4141 5109
9 [F] Kidney EGR3 30.822 19.416 0.088 24 01839 0163 022
10 [.d] Kidney OSGEP 28.947 17.441 0.057 -1.01 2.029 1.642 2.235
11 [ Kidney MAOB 25183 13677 0.06 -1.346 2542 2295 2815
12 O Kidney SERPING1 25.803 14.207 0.058 -1.741 3343 3.029 369
13 Liver 18s 10.757
14 O Liver QGDH 27.874 17117 0.04 1.199 0.435 0.407 0.466
15 [F] Liver EGR3 31.845 21.087 0.065 4.071 0.059 0.053 0.066
16 [.d] Liver OSGEP 29.521 18.764 0.045 0.302 0811 0752 0.875
17 [ Liver MAOB 25.149 14.392 0.043 -0.631 1.549 1.439 1.667
18 O Liver SERPING1 21137 10.38 0.051 -5.658 50.501 46.35 55.024
19 Universal 185 10.819
20 O Universal QGDH 25.908 15.089 0.045 -0.828 1778 1.644 1.916
21 O Universal EGR3 28.866 18.047 0.046 1.031 0.489 0.453 0.529
22 [.d] Universal OSGEP 27.836 17.017 0.051 -1.444 2722 2.498 2,967
23 [F] Universal MAOB 29.504 18.685 0.067 3.662 0.079 0.072 0.087
24 O Universal BERPINGT 27 891 17.072 0.051 1.034 0.488 0.448 0532
Column Description
Omit For all technical replicates that evaluate the associated sample/target
combination:
e A check mark (v) indicates that all replicates have been removed from the
analysis.
¢ A hyphen (-) indicates that one or more replicates have been removed from
the analysis.
Sample The sample associated with the data displayed in the row.
Target The target assay associated with the data displayed in the row.
C; Mean The arithmetic average of the technical replicate C; values.

AC; Mean | The arithmetic average of the technical replicate C; values for the sample
replicate group.

AC; SD The sample standard deviation of the sample replicate group level C; values.

AAC+ The calculated AAC; value for the replicate group associated with the test
sample.

RQ The calculated relative level of gene expression for the replicate group

associated with the test sample.

RQ Min The minimum relative level of gene expression in the test samples calculated
using the confidence level set in the Analysis Settings dialog box.

Note: The minimum includes the variability associated with the endogenous
control and targets in only the test samples.

RQ Max The maximum relative level of gene expression in the test samples calculated
using the confidence level set in the Analysis Settings dialog box.

Note: The maximum includes the variability associated with the endogenous
control and targets in only the test samples.

Notes
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5. View the Well Table:

a. In the navigation pane, select Analysis » Amplification Plot, then select
the View Well Table tab.

b. In the Group By drop-down list, select Replicate.

c. Look at the C; SD column to evaluate the precision of the replicate groups. In
the example experiment, there are no outliers.

ba 5¢c

[ View Plate Layout | View Well Table |

5b ‘ SelectWells With: |- Selectitem - | v
‘ ‘
| snowinTanie v | sroupsy v | | 4 Expand au | 5 collapse Al |
‘
# | wel omit Flag Sample... | TargetN.. | Task Dyes cr CrMean | CTSD act ACTMean | ACTSE |«
= Bram - 185 "
1 Al 0 Brain 188 UNKNOWN FAM-NFG-.. 10919253 10.883143 0.076
2 B 0 Brain 188 UNKNOWN FAM-NFG-.. 108319 10.883143 0.076
3 o 0 Brain 188 UNKNOWN  FAM-NFG-.. 10972014 10.883143 0.076
4 D 0 Brain 188 UNKNOWN  FAM-NFG-.. 10809404 10.883143 0.076
= Bramn - EGR3
5 A3 0 Brain EGR3 UNKNOWN FAM-NFG-.. 27.828663 27.899587 0.064 17.016 0.05
§ B3 0 Brain EGR3 UNKNOWN  FAM-NFG-.. 27.862165 27.899587 0.064 17.016 0.05
7 c3 0 Brain EGR3 UNKNOWN  FAM-NFG-.. 27.958967 27.899587 0.064 17.016 0.05
8§ D3 0 Brain EGR3 UNKNOWN  FAM-NFG-.. 27.948591 27.899587 0.064 17.016 0.05
= Bramn - MAOB
R 0 Brain MAOB UNKNOWN  FAM-NFG-.. 2575427  25.906 0104 15023 0.064
10 B5 0 Brain MAOB UNKNOWN  FAM-NFG-.. 25926657 25.906 0104 15.023 0.064
1 cs 0 Brain MAOB UNKNOWN  FAM-NFG-.. 25956247 25.906 0104 15.023 0.064
12 Ds 0 Brain MAOB UNKNOWN  FAM-NFG-.. 25986826 25.906 0104 15.023 0.064
= Bramn - OGDH
13 A2 0 Brain 0GDH UNKNOWN FAM-NFG-.. 267171  26.800344 0.08 15917 0,055
14 B2 0 Brain 0GDH UNKNOWN FAM-NFG-.. 26774733 26.800344 0.08 15917 0,055
15 c2 0 Brain 0GDH UNKNOWN FAM-NFG-.. 26.800894 26.800344 0.08 15917 0,055
1% D2 0 Brain 0GDH UNKNOWN  FAM-NFG-.. 26.908648 26.800344 0.08 15917 0,055
= Bramn - OSGEP
17 A 0 Brain 0SGEP  UNKNOWN FAM-NFO-.. 29.244791 2934477 0,073 18,462 0,063
18 B 0 Brain 0SGEP  UNKNOWN FAM-NFO-.. 29.338083 2934477 0,073 18.462 0,053
19 c4 0 Brain 0SGEP  UNKNOWN FAM-NFO-.. 29.404493 2934477 0,073 18.462 0,053
0 D4 0 Brain 0SGEP  UNKNOWN FAM-NFO-.. 29.331718 2934477 0,073 18.462 0,053
= Buain - SERPING]
7 26 0 Brain SERPING! UNKNOWN FAM-NFO-.. 26913081 26.92132 0.036 16.038 0.042
2 B6 M Brain SERPING! UNKNOWN FAM-NFO-.. 26.939188 26.92132 0.036 16.038 0042 ¥
>

Note: To show/hide columns in the Well Table, select/deselect the column name in the
Show in Table drop-down list.

Analysis When you analyze your own comparative C; experiment, look for:
Guidelines » Differences in gene expression (as a fold change) relative to the reference sample.

+ Standard deviation in the replicate groups (C SD values). If needed, omit outliers
(see “Omit Wells from the Analysis” on page 181).

For More For more information on the Gene Expression Plot screen or Well Table, open the
Information 7500 Software Help by clicking ) or pressing F1.

Notes
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View the Amplification Plot

The Amplification Plot screen displays amplification of all samples in the selected wells.
Three plots are available:

* ARn vs Cycle — ARn is the magnitude of normalized fluorescence generated by the
reporter at each cycle during the PCR amplification. This plot displays ARn as a
function of cycle number. You can use this plot to identify and examine irregular
amplification and to view threshold and baseline values for the run.

* Rn vs Cycle — Rn is the fluorescence from the reporter dye normalized to the
fluorescence from the passive reference. This plot displays Rn as a function of cycle
number. You can use this plot to identify and examine irregular amplification.

* C; vs Well — C; is the PCR cycle number at which the fluorescence meets the
threshold in the amplification plot. This plot displays C as a function of well
position. You can use this plot to locate outlying amplification (outliers).

Each plot can be displayed as a linear or log10 graph.

About the In the comparative C example experiment, you review each target in the Amplification
Example Plot for:

Experiment ¢ Correct baseline and threshold values
¢ Qutliers

Notes
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View the Plot 1. Inthe navigation pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Display the 18S wells in the Amplification Plot screen:
a. Select the View Plate Layout tab.

b. In the Select Wells With drop-down lists, select Target, then 18S.
2a [View Plate LayoutT View Well Table ] I I 2b
| I
SelectWells With: | Target v|[18s v
| {3 showinwells ¥ | | o |
| 1 [ 2 I 3 [ 1 [ 5 I 6 7 [ [ I g [0 T [ 1z
Brain Brain Brain Brain Brain Kidney Kidney Kidney Kidney Kidney Kidney
- e - o
T 26.91 CT 2585
Brain Brain Brain Brain Brain i Kidney Kidney Kidney
- o - vy
CT 26,94 cT 258
Brain Brain Brain Brain Brain Kidney Kidney Kidney
- v - e
CT 26,95 CT 2579
Brain Brain Brain Brain Brain Kidney Kidney Kidney
_ _ _ m | _ _ _ m e
CT: 26,87 CT 2578
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
_ _ _ m e - _ _ m .
cr212 CT: 27 86
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
- _ _ m o _ _ _ m .
CT21.04 CT: 27 86
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
_ _ m e _ _ _ m e
CT 2115 Ccr27.87
Liver Liver Liver Liver Liver Universal Universal Universal Universal Universal Universal
_ _ _ m e _ _ _ m -
CT21.16 CcT27.98
Wells mgﬁ Unknown Dl] Megative Control 0 Empty

3. In the Amplification Plot screen, Plot Settings:
a. In the Plot Type drop-down list, select ARn vs Cycle (default).
b. In the Plot Color drop-down list, select Well (default).

Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes

to Hide the plot legend.

Notes
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View the Amplification Plot

4. View the baseline values (Plot Settings tab):
a. In the Graph Type drop-down list, select Linear.
b. Select the Baseline Start check box to show the start cycle and end cycle.

c. Verify that the baseline is set correctly: The end cycle should be set a few
cycles before the cycle number where significant florescence is detected. In the
example experiment, the baseline is set correctly.

Note: By default, the Amplification Plot displays the data for all targets present in
the experiment. Consequently, the plot overlays the baseline and threshold labels for
all targets until you select an individual target from the Target drop-down list.

3a 4a 3b

Plot

| |
PlotType:‘Aans Cycle \‘v| GraphType:|Lmear v| Plot Colar:

ave current settings as the default

p p iy 2 =—1——3c

Amplification Plot

a 2 4 & & 10 12 14 16 18 20 22 24 26 28 30 a2 34 36 ] 40 a2

LF g llc Hp He Hr Hc HH

Options
Target: [ [ Threshoia: [Jauto [ | [ JAutBaseline

Show: [¥] Threshold — [7] Baseiine Start; Well B Target . Baseline End: Well (B Target 4.

4b
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View the Amplification Plot

5. View the threshold values:
a. In Plot Settings tab, select Log in the Graph Type drop-down list.
b. Select 18S in the Target drop-down list.
In the Options tab, select the Threshold check box to show the threshold.

o

o

Verify that the threshold is set correctly. The example experiment contains
multiple thresholds, one for each target assay. The thresholds for all targets
occur in the exponential phase.

5a

Plot

|
PlotType:‘Aans Cycle v| GraphType:|Lng v| PIotCoIor

P P a !

Amplification Plot

o1

0.001

0.0001

Cycle

Leged

LF g llc Hp He Hr Hc HH

Options

5b Target Threshold: [] Auto | 0483733

Show; Threshu\d—Baseline Start: Well W Target s« Baseline End: Well (M Target 4

5¢c

Notes
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View the Amplification Plot

Plot

Amplification Plot

6. Locate any outliers:

a. In Plot Settings tab, select C vs Well in the Plot Type drop-down list.

b. Look for outliers in the amplification plot. In the example experiment, there are

no outliers for 18S.

6a

|
Plot Type: Ctvs Well | Grapthpe:|

| Protcotor wel =

Amplification Plot

L pa !

well Number

Lagend

A

5 lc HD HE Hr Hc HH

Show:

Target: Threshaold:

Options )

L ]

— [[] Baseline Start: Well M Target s Baseline End: Well (B Target 4.

7. Repeat steps 2 through 6 for the EGR3, MAOB, OGDH, OSGEP, and SERPING1
wells. In the example experiment, there are no outliers for any of the targets.
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View the Amplification Plot

Analysis When you analyze your own comparative C experiment, look for:

Guidelines .

Notes

Outliers

A typical amplification plot — The 7500 software automatically calculates baseline
and threshold values based on the assumption that the data exhibit a typical
amplification plot. A typical amplification plot has four distinct sections:

a. Plateau phase

b. Linear phase

(2}

. Exponential (geometric phase)

o

. Baseline

¥y

1210658
o4 .Threshold

ARN

0.013:

DDDEH':"‘I.' A V'l S  PA N, WY A H
’ 024.351012|1¢m1?.9n':oq¢mo:}

Cycle

IMPORTANT! Experimental error (such as contamination or pipetting errors) can
produce atypical amplification curves that can result in incorrect baseline and
threshold value calculations by the 7500 software. Therefore, Applied Biosystems
recommends that you examine the Amplification Plot screen and review the
assigned baseline and threshold values for each well after analysis is complete.

Correct baseline and threshold values — See the “Threshold Examples” on page 172
and “Baseline Examples” on page 173.
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Threshold Examples

Threshold Set Correctly 0

The threshold is set in the exponential phase of the
amplification curve.

Threshold settings above or below the optimum increase

the standard deviation of the replicate groups. 242706

o1
Task Dyas Ccr CrMaan CT8D Quantey Quantey Quantsy Commi

HTC FAM-HFQ- . Undebeimi =

HTC FAMCNFOQ-.. Undgtemi..

TG FAM-NFQ-.. Undstemi.. 0.01

UNSMOWH  FAM-NFO-.. 2896287 28.923796 0.074 248431 2551478 1252

UNHMOWH FAM-NFO. . 28832747 28823766 0074 2487084 2EE14TE 1282

UNEMOWN FAM-NFO-. 2004572 20023708 0.074 2472084 2551478 1282

0.001 IR

!
0.0001

Cycla

Threshold Set Too Low ©

The threshold is set below the exponential phase of the
amplification curve. The standard deviation is significantly
higher than that for a plot where the threshold is set '
correctly. Drag the threshold bar up into the exponential
phase of the curve.

Task Dyes cr €1 Mean CT80 Quantey Quantey Cuamsy &
TG FAM-NFO-.. Undeteimi.. -
NTE FAM-NFQ-.. Undetemi..
NTC FAM-NFQ-.. 38453182 0.01
UNKNOWH FAM-NFQ-.. 2285404 22TEIT44 0352 2314857  JATIAE3 400435
UNKNOWN FAM-NFG... 22478971 22751744 0252 28927722 2472483 400435
UNKNOWN FAM-NFO-_. 22654218 22781744 0252 2AT4R1E 2AT2.483 400435
0.001
0.0001 !
Threshold Set Too High 0
The threshold is set above the exponential phase of the
amplification curve. The standard deviation is significantly —

higher than that for a plot where the threshold is set !
correctly. Drag the threshold bar down into the
exponential phase of the curve.

Task Dyes cr T Mgan CTED Caniiy Caniiy Cariiy Comme =
HTC FAMCNFG-.. Undetemi.. =
TG FAM-NFQ-. Undsteami..
NTC FANENFO-. Unasiem.. 0.01
URKMOWH FAM-NFO-. 37681107 3748507 0202 2571977 288419 3BT
UNEMOWH  FAM-NFG-.. 3T.275T1 3749507 0202 3260833 2880439 IATTE
UNHMNOWH FAM-NFG- . 3T 524305  37.49507 0.202 2824187 280425 BT
0.001 Lo
{3 |
,1 II
| LA |
0.0001 [ ,f 2 = 34 20 e .. - -
Cycla
Notes
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View the Amplification Plot

Baseline Examples

Baseline Set Correctly

The amplification curve begins after the maximum .
baseline. 7

Baseline Set Too Low

The amplification curve begins too far to the right of the
maximum baseline. Increase the End Cycle value.

Baseline Set Too High

The amplification curve begins before the maximum ’
baseline. Decrease the End Cycle value. F

If your experiment does not meet the guidelines above, troubleshoot as follows:
* Omit wells (see “Omit Wells from the Analysis” on page 181).
or

* Manually adjust the baseline and/or threshold (see “View the Analysis Settings” on
page 176).

For More For more information on the Amplification Plot screen, open the 7500 Software Help by
Information  clicking @) or pressing F1.

Notes
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Publish the Data

You can publish the experiment data in several ways:
» Save the plot as an image file
* Print the plot
* Print the reaction plate layout
* Create slides
* Print a report
+ Export data to applications such as Microsoft® Excel® and Microsoft® PowerPoint®.

For information on performing these procedures, open the 7500 Software Help by
clicking @) or pressing F1.

Notes
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Section 9.2 Troubleshoot (If Needed)

This section covers:

B View the Analysis Settings . . ..........vtitit i 176
B View the QC SUMMATrY. ... ..ottt e e e 179
B Omit Wells from the Analysis. ............ .. ... .. 181
B View the Multicomponent Plot. . .......... .. ... ... ... ... ... ... .. .... 182
B Viewthe RawDataPlot . ...... ... ... .. .. .. . . . . . . . .. 185
Notes
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View the Analysis Settings

The Analysis Settings dialog box displays the analysis settings for the threshold cycle
(Cyp), flags, relative quantitation, and advanced options. If the default analysis settings in
the 7500 software are not suitable for your experiment, you can change the settings in the
Analysis Settings dialog box, then reanalyze your experiment.

About the In the comparative C example experiment, the default analysis settings are used without
Example changes.
Experiment

View the Settings 1. In the navigation pane, select Analysis.

2. Click Analysis Settings to open the Analysis Settings dialog box.
In the example experiment, the default analysis settings are used from each of the
following tabs:
* C; Settings
* Flag Settings
* Relative Quantitation Settings

* Advanced Settings

?__| Analysis Settings for Comparative Ct Example

|| Dlag Settings ] Relative Quantitation Settings | Advanced Seftings |
-~
ﬂ Review the default settings for analysis of targets in this experiment. To editthe default settings, click "Edit Default Settings.” To use
different settings for a target, selectthe target from the table, deselect"Use Default Settings,” then change the settings that are displayed.
Default C1 Settings
Default C1 settings are used to calculate the CTfor targets without custom settings. To edit the default settings, click "Edit Default Settings "
Threshold: AUTO  Baseline Start Cyele: AUTO  Baseline End Gyele: AUTO | Edit Defauk Seftings |
Select a Target Cr1 Settings for 185
Target Threshald Baseline Start Baseline End 7 Settings to Use: Use Default Setiings
185 IALTO AUTO IALTO e
EGR3 IALTO AUTO IALTO
MAOB IALTO AUTO IALTO
OGDH IALTO AUTO IALTO
OSGEP IALTO AUTO IALTO
SERPING1 IALTO AUTO IALTO
-
< >
| Revert to Default Analysis Seftings Apply Analysis Seftings ‘ Cancel |

3. Click Apply Analysis Settings.

Notes
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View the Analysis Settings

Analysis  Unless you have already determined the optimal settings for your experiment, use the
Guidelines default analysis settings in the 7500 software. If the default settings are not suitable for
your experiment, you can change the:

* C; Settings — Use this tab to manually set the threshold and baseline. When
manually setting the threshold and baseline, Applied Biosystems recommends the

following:
Setting Recommendation
Threshold Enter a value for the threshold so that the threshold is:
¢ Above the background.
¢ Below the plateau and linear regions of the amplification curve.
¢ Within the exponential phase of the amplification curve.
Baseline Select the Start Cycle and End Cycle values so that the baseline

ends before significant fluorescent signal is detected.

* Flag Settings — Use this tab to:
— Adjust the sensitivity so that more wells or fewer wells are flagged.
— Change the flags that are applied by the 7500 software.
* Relative Quantitation Settings — Use this tab to:
— Select the type of analysis to perform.
— Select the reference sample(s).

— Select the endogenous control. You can set more than one endogenous control.
See “Set Multiple Endogenous Controls” below.

— Set the efficiency. See “Set Efficiency” on page 178.
— Reject outliers.

— Select the algorithm to use to determine RQ Min/Max values (confidence level or
standard deviations).

* Advanced Settings — Use this tab to change baseline settings well by well.

Set Multiple You can select multiple endogenous controls for a comparative C experiment.

Endogenous .
To select multipl trols:
Controls o select multiple controls
1. Inthe Analysis Settings for Comparative Ct Example dialog box, select the Relative
Quantitation Settings tab.
2. In the Select Endogenous Control(s) group, click the Endogenous Control(s) drop-
down list, then select Multiple Controls.
Notes
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3. In the Select Multiple Endogenous Controls dialog box, select the targets that you
want to use as endogenous controls, then click OK.

1

Ct Seftings I Flag Settings I Relative Quantitation Settings I Advanced Settings }
(&) singleplex

Select Reference(s)
Selectthe biological replicate group andior sample to use as the reference(s) for this experiment

Biological Replicats Group Reference: ~ Reference Sample:  |Brain v

Select Endogenous Control(s)

Selectthe target to use as the endogenous control for this experiment. To use multiple endogenous controls, select"Multiple Controls”
from the drop-down list, then select the controls as necessary.

Endogenous Control(s): /185 b %) select Multiple Endogenous Controls ﬁ‘
2 Multiple Gontrals 85
Efficiency [ EcR3
[ maoB
Deter] £ 0GDH
1gg | O] OSGEP &
Enter percentage values I Ecr3 | [ SERPINGT N
MAOB ( 3 )
0GDH N
nencco ]
Outlier Rejection
Selectto reject replicates with ACT values less than or gs apply only to multiplex
reactions
| OK ‘ | Cancel
RQ Min/Max Calculations
Select the algorithm to use to deterring RQ Min and Max values (error bars). ™
| Revert to Default Analysis Seftings | | Apply Analysis Seftings Cancel

Set Efficiency

You can specify efficiency on a per-assay basis. When you set an assay to have less than
100% efficiency, the 7500 software uses the relative standard curve algorithm.

By setting the correct assay efficiencies for your experiment, you enable the 7500
software to produce more precise quantitation results for reactions that do not amplify
with 100% efficiency. By default, the 7500 software calculates sample quantities based
on assays that have calculated amplification efficiencies of 100%. Applied Biosystems
TagMan® Gene Expression Assays (Inventoried and Made to Order) have an
amplification efficiency of 100% +/- 10% when measured over a broad dynamic range
(6 logs) in samples that are free of PCR inhibitors. To determine efficiency of custom
designed assays, use at least 5-6 logs dilution range of template.

To set assay efficiency, click 100.0 in the Efficiency (%) column of an assay, then type a
percentage value between 1% and 100%.

Efficiency
Detectar Efficiency (%)
GAPDH 100.0
Enter percentage values between 1 and 150% |c-myc 100.0

Murtliar Boiactian

For More For more information on the analysis settings, open the 7500 Software Help by pressing
Information F1 when the Analysis Settings dialog box is open.
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View the QC Summary

The QC Summary screen displays a list of the 7500 software flags, and includes the flag
frequency and location for the open experiment.

About the In the comparative C example experiment, you review the QC Summary screen for any
Example flags generated by the experiment data; however, no flags are generated.
Experiment

View the QC 1. In the navigation pane, select Analysis » QC Summary.

Summary
Note: If no data are displayed, click Analyze.

2. Review the Flags Summary. In the example experiment, there are no flagged wells.

3. In the Flag Details table, look in the Frequency and Wells columns to determine the
flags that appear in the experiment. In the example experiment, no wells were
flagged by the 7500 software.

Note: A 0 displayed in the Frequency column indicates that the flag does not appear
in the experiment.

4. (Optional) Click each flag row to display details about the flag.
e —

Flag v
Total Wells 96 | Processed Wells: 96 Manually Omitted Wells: 0 | Targets Used: 6
Wells Set Up: 96 | Flagged Wells: 0 Analysis Omitted Wells: 0 | Samples Used: 4
‘ 2
Flag Details 3
— ——
Flag: Mame Frequency Wells ;
4 AMPNC Amplification in negative contral 0
BADROX Bad passive reference signal 0
OFFSCALE Fluorescence is offscale 0
HIGHSD High standard deviation in replicate group 0
NOAMP Mo amplification 0
MNOISE INoise higherthan others in plate 0
SFIKE oise spikes 0
MNOSIGMAL Mo signal inwell 0
OUTLIERRG Outlier in replicate group 0
EXPFAIL Exponential algarithm failed 0
BLFAIL Baseline algorithm failed 0
THOLDFAIL [Threshalding algorithm failed 0
CTFAIL Ct algorithm failed 0
Flag: AMPNC—Amplification in negative control
Flag Detail: A sequence amplified in a negative contral
reaction.
Flag Criteria: CT<35.0
Flagged Wells: None
View AMPNC Troubleshooting Infarmation
Notes
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View the QC Summary

For comparative C experiments, the flags listed below may be generated by the
experiment data.

If a flag does not appear in the experiment, its frequency is 0. If the frequency is >0, the
flag appears somewhere in the experiment; the well position is listed in the Wells column.

Flag

Description

AMPNC

Amplification in negative control

BADROX

Bad passive reference signal

BLFAIL

Baseline algorithm failed

CTFAIL
EXPFAIL

' Exponential algorithm failed

C; algorithm failed

HIGHSD

High standard deviation in replicate group

MTP

NOAMP

' No amplification

Multiple Tm peaks
Note: This flag is displayed only if the experiment includes a melt curve.

NOISE

Noise higher than others in reaction plate

NOSIGNAL

No signal in well

OFFSCALE

Fluorescence is offscale

OUTLIERRG

Outlier in replicate group

SPIKE
THOLDFAIL

' Thresholding algorithm failed

Noise spikes

Analysis When you analyze your own comparative Cy experiment:

Guidelines * In the Flag Details table, click each flag that has a frequency >0 to display details
about the flag. If needed, click the troubleshooting link to view information on
correcting the flag.

* You can change the flag settings:

— Adjust the sensitivity so that more wells or fewer wells are flagged.

— Change the flags that are applied by the 7500 software.

For More For more information on the QC Summary screen or on flag settings, open the
Information 7500 Software Help by clicking g) or pressing F1.
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Omit Wells from the Analysis

Experimental error may cause some wells to be amplified insufficiently or not at all.
These wells typically produce C values that differ significantly from the average for the
associated replicate wells. If included in the calculations, these outliers can result in
erroneous measurements. To ensure precision, omit the outliers from the analysis.

About the In the comparative C; example experiment, there are no outliers. No wells need to be
Example removed from analysis.
Experiment

Omit Wells 1. In the navigation pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. Inthe Amplification Plot screen, select C vs Well in the Plot Type drop-down list.

3. Click the upper left corner of the plate layout in the View Plate Layout tab to display
all wells.

4. Select the View Well Table tab.
5. In the Well Table:

a. In the Group By drop-down list, select Replicate.

b. Look for any outliers in the replicate group (be sure they are flagged). In the
example experiment, there are no outliers.

4
|
View Plate Layout | View Well Table ]
5a | SelectWells With: - Szlect Hem - |,
. ‘
[ snowinTapie v | sroupsy v | Expand All | B colapse an |
|
£ | well omit Flag Sample .. | TargetN.. | Task Dyes cr CrMean | C1SD acT ACTMean | ACTSE | :
= Bran- 185 A
1 A | Brain 188 UNKMNOWH  FAM-NFO-.. 10919253 10883143
LAY =] Brain 188 UNKMOWH 108319 10.883143
i =] Brain 188 UNKMOWH 10872014 10.883143 0.078
4 D =] Brain 188 UNKMOWH 10809404 10883143 0.076
= Bran - EGR3
§ a3 | Brain E6R3 UNKMOWH 0.084 17.016 0.05
§ 63 =] Brain E6R3 UNKMOWH 0.084 17.016 0.05
7 ca =] Brain E6R3 UNKMOWH 0.084 17.016 0.05
g D3 =] Brain EGR3 UNKMOWH 0.084 17.016 0.05
= Bran - MAOB
g a5 | Brain MA0B UNKMOWH 0104 15.023 0.084
10 BS =] Brain MA0B UNKMOWH 0104 15.023 0.084
1 cs =] Brain MA0B UNKMOWH 0104 15.023 0.084
12 Ds =] Brain MA0B UNKMOWH 25.906 0104 15.023 0.084
= Bram - OGLCH
13 az | Brain OBDH  UNKNOWN 26.800344 0.08
14 B2 =] Brain OBDH  UNKNOWN 26.800344 0.08
15 2 =] Brain OGDH  UNKMOWH FAM-NF 00864 26.800344 0.08
15 D2 =] Brain OGDH  UNKNOWH FAM-NFO-.. 26908648 26800344 0.08
= Brain - OSGEP
7 oA | Brain DSGEP  UNKMNOWN 29.244791 0.073
18 B4 =] Brain DSGEP  UNKMNOWN 29.338083 0.073
19 o =] Brain DSGEP  UNKMNOWN 404453 7 0.073 ;
W m =] Brain OSGEF  UNKNOWN FAWNFO-. 29361718 26,3477 0.073 18.462 0.083
S Brain - SERPINGI
2 a ] Brain SERFINGT UNKNOWH FAM-NFQ-.. 26913061 2652132 0.036 16.038 0.042
an . m Fremi armninea inessam Cake Rimo A fAan4an Ae Aaaaa nAae aenan nnan 8
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Analysis  When you analyze your own comparative C experiment, carefully view the replicate
Guidelines  groups for outliers. If needed, remove outliers manually using the Well Table:

1. In the navigation pane, select Analysis » Amplification Plot.

Note: If no data are displayed, click Analyze.

2. In the Plot Type drop-down list of the Amplification Plot screen, select C vs Well.
3. Select the View Well Table tab.

4. In the Well Table:
a. In the Group By drop-down list, select Replicate.
b. Look for any outliers in the replicate group (be sure they are flagged).

c. Select the Omit check box next to the outlying well(s).

5. Click Analyze to reanalyze the experiment data with the outlying well(s) removed
from the analysis.

For More For more information on omitting wells from the analysis, open the 7500 Software Help
Information by clicking @) or pressing F1. Within the Help, search for the omit well topics:

1. Select the Search tab.
2. Enter omit well.

3. Click List Topics.

4

. Double-click the topics you want to review.

View the Multicomponent Plot

The Multicomponent Plot screen displays the complete spectral contribution of each dye
in a selected well over the duration of the PCR.

About the In the comparative C; example experiment, you review the Multicomponent Plot screen
Example for:

Experiment « ROX™ dye (passive reference)
+ FAM™ dye (reporter)
» Spikes, dips, and/or sudden changes
» Amplification in the negative control wells
Notes
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View the 1. In the navigation pane, select Analysis » Multicomponent Plot.

Multicomponent
Plot Note: If no data are displayed, click Analyze.
2. Display the unknown wells one at a time in the Multicomponent Plot screen:
a. Click the View Plate Layout tab.
b. Select one well in the plate layout; the Multicomponent Plot shows the well data.
Note: If you select multiple wells, the Multicomponent Plot screen displays the
data for all selected wells simultaneously.
3. In the Plot Color drop-down list, select Dye.
4. Click = (Show a legend for the plot).
Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.
5. View the FAM dye signal. In the example experiment, the FAM dye signal increases
throughout the PCR process, which indicates normal amplification.
6. View the ROX dye signal. In the example experiment, the ROX dye signal is
constant throughout the PCR process, which indicates typical data.
4 2a
|
i v SelectWells with: [Target || selectitem - v
rtcaeroe B | B show in Wells ¥ | | = | B |
& Ry = = v T 2] 37 ¢« s e 7 [8[98 [10][n ]2

Brain  Brain Brain  Brain Brain  Brain Kidney Kidney Kidney Kidney Kidney Kidney

S——— 0 5 G0 O
Cr 2. Cr 2.

=

1.200,000 Erain | Brain | Brain  Brain | Brain | Brain Kidney Kidney Kidney Kidney Kidney Kidney
L L

2b fmae : H m nu m
Cr 2. Cr 2.
1,000,000 Erain | Brain | Brain  Brain | Brain | Brain Kidney Kidney Kidney Kidney Kidney Kidney
o Cnu msnunms
00,000 Cr 2. Cr 2.
® : Brain | Brain | Brain  Brain | Brain | Brain Kidney Kidney Kidney Kidney Kidney Kidney
c 700,000 : . ;A
@ 500,000 (EAF 7L Cr 2.
§ 500,000 Liver | Liver Liver Liver Liver  Liver Unive.. Unive.. Unive... Unive.. Unive... Unive...
L L

5 oo £ n H m n H m
Cr 2. Cr 2.
S00,000 Liver Liver Liver Liver | Liver | Liver Unive.. Unive... Unive... Unive... Unive... Unive...
6 - F nunmsnu ms
100,000 Cr 2. Cr 2.
Liver | Liver Liver Liver Liver  Liver Unive.. Unive.. Unive... Unive.. Unive... Unive...
a S L

cesrrmmEmmammmam e © nun m nu m
Cr 2. Cr 2.

Cycle
Liver | Liver Liver Liver Liver  Liver Unive.. Unive.. Unive... Unive.. Unive... Unive...
Lagend o u M s il u m:
M Rox EEFAM ey cr2.
wells: [l 96 Unknown [l 0 Megative Control 0 Empty
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Analysis When you analyze your own comparative C experiment, look for:
Guidelines » Passive reference — The passive reference dye fluorescence level should remain
relatively constant throughout the PCR process.

* Reporter dye — The reporter dye fluorescence level should display a flat region
corresponding to the baseline, followed by a rapid rise in fluorescence as the
amplification proceeds.

* Any irregularities in the signal — There should not be any spikes, dips, and/or
sudden changes in the fluorescence.

* Negative control wells — There should not be any amplification in the negative
control wells.

For More For more information on the Multicomponent Plot screen, open the 7500 Software Help
Information by clicking @) or pressing F1.

Notes

184 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve
and Comparative C; Experiments



Chapter 9 Analyze the Comparative C; Experiment m
View the Raw Data Plot

View the Raw Data Plot

The Raw Data Plot screen displays the raw fluorescence (not normalized) for each optical
filter for the selected wells during each cycle of the real-time PCR.

About the In the comparative C example experiment, you review the Raw Data Plot screen for a
Example stable increase in signal (no abrupt changes or dips) from the appropriate filter.
Experiment

View the Plot 1. In the navigation pane, select Analysis » Raw Data Plot.

Note: If no data are displayed, click Analyze.

2. Display all 96 wells in the Raw Data Plot screen by clicking the upper left corner of
the plate layout in the View Plate Layout tab.

3. Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

Note: The legend displays the color code for each row of the reaction plate. In the
example shown below, Row A is red, Row B is yellow/green, Row C is green, and so on.

Notes
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4. Drag the Show Cycle slider from cycle 1 to cycle 40. In the example experiment, a
stable increase occurs in signal from filter 1, which corresponds to the FAM™ dye filter.

Raw Data Plot

Raw Data Plot

2,000,000
1,760,000
1500000 |
1,250,000 N

g
= 1.000.000

5
750,000

500,000

250,000

Filter

Legerrd
[-A g llc Hp He Hr Hc HH ]

Options
Show Cycle 40 - & 4
] 10 20 n 40

The filters are:

Filter 1 2 3 4 5
e FAM™ dye e JOE™dye ¢ TAMRA™dye | ® ROX™dye | Cy5®dye
Dye e SYBR®Green | ¢ VIC®dye | ¢ NED™dye ¢ Texas Red®
dye e Cy3®dye dye

Analysis When you analyze your own comparative C experiment, look for the following in each
Guidelines filter:

* Characteristic signal growth
* No abrupt changes or dips

For More For more information on the Raw Data Plot screen, open the 7500 Software Help by
Information clicking g) or pressing F1.

Notes
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Section 9.3 Perform a Study of Multiple Experiments

This section covers:

B Section OVEIVIEW . . .. oottt et et e e e e e e e e 188
B Designa Study .. ..ot 189
B Analyzethe Study........ ... ... 195
B PublishtheData ......... ... . . . . . . . . e 202
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Section Overview

The 7500 software can combine the analysis of experiments that use the comparative C
method (AAC;) of relative quantitation.

In a comparative C; study, you can... You cannot...

e Specify the endogenous control(s) and e Create, add, or modify samples.
reference sample for the study. e Create, add, or modify targets.

* Select the control type when applicable. e Change assay tasks.

e Set baseline and threshold values and
confidence levels, or set the number of

standard deviations for Comparative C;
Min/Max.

e Omit wells individually or together through
their association with replicate groups
(technical or biological).

Note: You can perform these operations in
comparative C; experiments.

For more information about methods of calculating relative quantitation, refer to the
Real-Time PCR Systems Reagent Guide.

About the In this section, you use two files:

Example Study * In the first half, you create a comparative C; example study file that contains setup
data, then save it to the experiments folder on your computer.

* In the second half, you view results in a example study file that is installed with the
7500 software. You can find the data file for the example study on your computer at:

<drive>:\Applied Biosystems\<software name>\experiments\
Comparative Ct Study Example.edm

where:
— <drive> is the computer hard drive on which the 7500 software is installed.

— <software name> is the current version of the 7500 software.

Note: The Comparative Ct Study Example.edm file is not designed to demonstrate the
use of biological replicate groups; an additional example study provided with the 7500
software provides a better example. You can find the alternate study file on your
computer at: <drive>:\Applied Biosystems\<software name>\experiments\
Comparative Ct Study Example (Biological Groups).edm.

Notes
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Design a Study

This section explains how to use the 7500 software to set up a comparative C example
study. It also describes Applied Biosystems recommended best practices as you create
the study

Create a New Study

To create a new experiment using the Design Wizard in the 7500 software:

1. Double-click g (7500 software) or select Start » All Programs »
Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. In the Home screen, click @ Create Study.

Note: If you do not see the Create Study icon, click the arrow beneath the Analyze
Experiment icon to expand the Analyze menu.

¥ 7500 Software 2.0

File Edit Instrument Analysis Tools Help

Close Export.. = Print Report
P

Run Analyze

QuickStart Analyze Experiment

il

Advanced Setup Run Experiment Create Study

;
or—

Template

I [ 7500 : connected I

Notes
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Define Study Properties

In the Experiment Properties screen, enter identifying information for the study, then add
experiments to the study.

About the In the example study, the:
Example Study .

Study is identified as an example.

» Experiment that you add to the study is the same example experiment analyzed in
Section 9.1 and Section 9.2 of this chapter.

Complete the 1. Inthe navigation pane, select Setup » Study Properties.

Study Properties ‘ . ‘
Screen 2. In the Study Properties pane, click the Study Name field, then enter Comparative
Ct Study Example.

3. Click the Comments field, then enter Example Comparative Ct Study for the
Relative Standard Curve/Comparative Ct Getting Started Guide.

4. Click the User Name field, then enter Example User.
5. In the Set Up Experiments pane, click Add Experiment(s).

6. Inthe Open dialog box, open the Comparative Ct Example.eds file at:

<drive>:\Applied Biosystems\<software name>\experiments\

7. In the Set Up Experiments table, select the Comparative Ct Example experiment.
The 7500 software displays the details of the experiment in the Properties pane.

2 * Study Name: | Comparative CT Study Example | Analysis: unknown
3 ‘©omments (Optional) | Example Comparative Ct Study for the Relative Standard Curve/Comparative Ct Getting Started Guide |
4 tJser Name (Optional): | Example User |
Last Modified Mumber of Experiments: 1
Set Up Experiments (1)
5 ————AddExperimert(s) | | || Hisle Fiter
Enter a filter query, then click "Apply Filter"
IF ‘ExperimemName v‘ ‘: v|| ‘ | Apply Fitter ] | |
Experiment Name MNumber of Targets | Number of Samp Operator Run Date Properties: Comparative Ct Example.eds 7
7 —5 Comparative CtExampleieds 6 4 Example User
Overview T Samples T Targets
@ negative Control Well
0 standard Well
@ unknown Well
& Empty well
< [} |
Notes
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Design  When you design your own comparative Cy study:

Guidelines * Enter an study name that is descriptive and easy to remember. You can enter up to
100 characters in the Study Name field. You cannot use the following characters in
the Study Name field: /\><*?"|:;

Note: The study name is used as the default file name.

* (Optional) Enter a user name to identify the owner of the study. You can enter up to
100 characters in the User Name field.

* (Optional) Enter comments to describe the study. You can enter up to
1000 characters in the Comments field.

* Add up to 100 comparative C; experiments to the study.
To add experiments to a study they must have:
— One or more common endogenous control(s).

— Identical thermal cycling parameters (the same number of steps, cycles, sample
volume, and emulation mode).

IMPORTANT! The 7500 software cannot combine in the same study experiments
that use Fast and standard thermal cycling conditions.

IMPORTANT! The 7500 software automatically analyzes a study after more than one
experiment is added to it. Consequently, to ensure that the software uses the correct
settings, Applied Biosystems recommends that you review the analysis settings of
your study after adding multiple experiments.

Note: The 7500 software automatically assigns the endogenous control and
reference sample for a study based on the analysis settings of the first experiment
added to it.

Note: If experiments that contain biological replicate groups are added to a study,
the 7500 software automatically merges the matching biological groups.

* When adding experiments to the study, Ctrl+click multiple experiments in the Open
dialog box to add them to the study.

* Select an experiment that has been added to the study to view its properties in the
Properties pane.

* Filter the experiments added to the study to simplify the list for easier review. See
“How to Simplify Data Lists Using the Filter Query” on page 192.

Notes
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How to Simplify Data Lists Using the Filter Query

To narrow your search for an experiment, define and apply a filter as follows:
1. In the left-most drop-down list, select an experiment attribute to query.
2. In the center drop-down list, select an operator for the query.

3. In the right-most field, enter the condition to for which to test, then
click Apply Filter.

Note: After applying a filter, click Hide Filter/Show Filter to hide or show the filter
tool, or click Remove Filter to remove the filter.

For More For more information on:

Information * Completing the Experiment Properties screen — Open the 7500 Software Help by
clicking @) or pressing F1.
* Quantitation experiments — Refer to the Real Time PCR System Reagent Guide.

Define Replicates

In the Define Replicates screen, create biological replicate groups and use them to
associate samples for the analysis. Biological replicates allow you to assess the
representative nature of your results as they relate to the population being studied.
Inclusion of biological replicates can give insight into any natural variation that is present
within the population.

About the The comparative C example does not contain biological replicate groups. You will
Example Study create and apply the biological group “LKBGP” as an exercise.

Complete the 1. In the navigation pane, select Setup » Define Replicates.

Define Replicates _
Screen 2. Click Add Biological Group.

3. Set up the example LKBGP biological replicate group:

a. In the Add Biological Replicate Group dialog box, click the Biological Group
Name field, then enter LKBGP.

Note: In the example study, the LKBGP (liver, kidney, brain group) biological
group is not used for the analysis.

b. In the Color field, leave the default.

c. Click the Comments field, then enter Example Biological Replicate Group
for the Example Comparative Ct Study.

d. In the Select Plate drop-down list, select Comparative Ct Experiment.eds.

Notes
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e. In the plate layout, select wells D6 and D7, then click >> to add the technical
replicate wells associated with the selected wells to the biological group.

The 7500 software automatically adds technical replicates of the selected wells
to the biological group.

f. Click OK.

4. Select the LKBGP group that you just added to the study. The 7500 software
displays the details of the biological group in the Properties pane.

Set Up Biological Replicate Groups

2 — 1 addBiological Group | | Ecit Biological Group | | Remove Biological Group | 4

Biological Group Name Color # of Replicates Comments Prop

4 eer | 4 | Examiple Biological Replicate Group for the Example ...

Biological Group Name: LKEGP

Color: -

Comments

#of Replicates: 4

Sample Target
Brain SERPING1
Kidney 185

Liver SERPING1
Universal 185

%) Add Biological Replicate Group

G Instructions: Enter a name for the hiological replicate group, then add technical replicate groups to the new hiological replicate group as needed.
3b |
3a—1 Biological Group Mame: | LKBGP | “:|‘a‘ 255,222 vl
3C L Comments (Optional) ‘Examu\e Biological Replicate Group for the Example Comparative Ct Study |

Add technical replicates to the new biological replicate group:

Foreach experiment in the study, selectthe plate, then selectthe wells of the plate that contain samples associated with the new biological replicate group
As you selecttechnical replicates, the software automatically adds the associated replicate wells to the biological replicate group.

3d —7 SelectPlate: |Comparative Gt Example.eds |+ Technical Replicate Groups Added to Biological Replicate Group:
# of Replicatss in Group: 2
Sample Target
| 9 [ show in wells ¥ | ] Viaw Lagand ‘ | ] | iz | Brain |SERPING1 |
Kidney [18s |
[z [ s ] 4 ] s 6 7o [ e [ e ] o [ o1 [ 12
Brain Brain Brain Brain Brain Brain Kidnev  Kidnev  Kidnev | Kidnev | Kidnev | Kidnew
A |[@]'es [ °°cH [ ESRe | °5S-- [ ™A [ SERP-/[]'®S [ °S°H [ ESF° | ©SC- | [ MA- | [ SEFT
REE Brain Brain Brain Brain Brain Kidney Kidnew Kidney Kidnev Kidnev Kidnew
B|@™®s Mo M5 Mo MM [SE e [ °c°H mIESR moss mMA M R
| | Buain Brain Brain Brain Brain Brain Kidnev  Kidnew  Kidnev | Kidnev | Kidnev | Kidnew
C|[m]'es @] °c0H [ ESRS @] ©S6.- [ ™A [N SERP- ] "85 [ °S°H [W]EGFe |[m] OG- | [ MA- | [N] SEFP
Brain Brain Biain Brain Braln Ridnev | Kidnev  Kidnev | Kidnev | Kidnev  Kidnew
3e £ SERP.. [T 185 |[J] °S°H [E] ESR° |[m] ©SC- | [ MA- | [ SERF =
[ | Liver Liver Liver Liver T Universal | Univesal | Universal | Universal | Universal
ElmM*™s moc™t M MmOt MM MSF-m'sS MmOt mEct meoss mM+ M
[ ] Liver Liver Liver Liver Liver Liver Universal | Universal | Universal | Universal | Universal  Universal
FI@E™ mmeeeH mee™ moss- mM- [ R M mos™ mEe mosc- mvA [ S
[ Liver Liver Liver Liver Liver Liver | Univessal | Universal | Universal | Universal | Universal  Universal Used on Plate(s)1
G|[ 'S U] 9G0H [m] ESRR 0%G.. [ MA- [U] SERP- [T] 8% [M] 9S0H O] SR [I] 9SG [ MA-  [I] SERF * Comparative CtExample eds
[ Liver Liver Liver Liver Liver Liver Universal | Universal | Universal | Universal | Universal  Universal
H|m'es [ eccH | EsRe 0sG...| [ MA- U] SERP-|[M] "85 | [@] °S°% [ S |[m] °SC- | [ MA- [ SERF
wells: [ 96 Unknown [5] 0 Standard [ o Negative Control 0 Empty

| Save and Add Another Group \E | cancel

3f
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Design  When you add a biological replicate group:

Guidelines .

Enter a biological replicate group name that is descriptive and easy to remember.
You can enter up to 100 characters in the Biological Group field. You cannot use the
following characters in the Biological Group field: /\><*?"|:;

(Optional) Enter comments to describe the biological replicate group. You can enter
up to 1000 characters in the Comments field.

Add an unlimited number of technical replicates to a biological group.

IMPORTANT! A sample cannot belong to more than one biological group.

Click-drag over the desired wells, or CTRL+click or Shift+click in the plate layout
to select multiple wells.

Click the upper left corner of the plate layout to select all 96 wells.

You can use the Define Replicates screen to change the name of a biological

replicate group, change its color identification and description, and add or remove
technical replicates. See “Edit a Biological Replicate Group” below.

Delete an existing biological replicate group by selecting the desired biological
group, then clicking Remove Biological Group.

IMPORTANT! After you remove a biological replicate group from a study, you
cannot restore it.

Edit a Biological Replicate Group

1.
2.

3.

Click Edit Biological Group.

In the Add Biological Replicate Group window, click the Biological Group Name
drop-down list, then select a biological group to edit. Add or remove technical
replicates to or from the biological group as needed.

Note: To change the name of the group, click the Edit button after the Biological
Group Name field.

To save your changes, click OK. To leave the group unchanged, click Cancel.
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Analyze the Study

This section explains how to use the 7500 software to analyze the comparative C
example study. It also describes Applied Biosystems recommended best practices as you
perform the analysis.

Note: The Comparative Ct Study Example.edm file is not designed to demonstrate the
use of biological replicate groups; an additional example study provided with the 7500
software provides a better example. You can find the alternate study file on your
computer at: <drive>:\Applied Biosystems\<software name>\experiments\
Comparative Ct Study Example (Biological Groups).edm.

Open the 1. Double-click g (7500 software) or select Start » All Programs »
Example Study Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.
2. In the Home screen, click Open.

3. In the Open dialog box, navigate to the experiments folder at:

<drive>:\Applied Biosystems\<software name>\experiments\

4. Double-click Comparative Ct Study Example.edm to open the example study data
file.

Note: The examples folder contains several data files; be sure to select
Comparative Ct Study Example.edm.

!l Open

3 Lookin: |2 experiments v EEE

Comparative Ct Example.eds

Comparative Ct Study Example (Biological Groups).edm
Comparative Ct Study Example.edm

Genotyping Example.eds

Presence Absence Example.eds

Relative Standard Curve Example.eds

Standard Curve Example.eds

j=J

g

g2

i

@
SO

&

File name: | | open |

My MNetwaork
Places Files oftype:  |a) SDS Files (2dm; eds; edt, sdm; sds; sdt) L | cancer |

Notes
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View the Gene Expression Plot, Replicate Results Table, and Well Table

The Gene Expression Plot screen displays the results of the relative quantitation
calculations in the gene expression profile. Two plots are available:

* RQ vs Target — Groups the relative quantitation (RQ) values by target. Each sample
is plotted for each target. You can view the plot as a linear, log10, Ln, or log2 graph.

* RQ vs BioGroup — Groups the relative quantitation (RQ) values by biological
replicate group (if present). Each target is plotted for each biological group.You can
view the plot as a linear, log10, Ln, or log2 graph.

The Replicate Results Data group organizes the results of the gene expression study by
biological or technical replicate association. The data are organized into two tabs:

Technical Replicates Tab

Biological Replicates Tab

This tab groups the results of the relative quantitation
analysis by technical replicate group. The 7500 software
displays the results for each sample/target combination as a
row in the table. You can view the members of a technical
replicate group by selecting the appropriate row in the table.
When a row is selected, the Well Result Data table displays
the wells that make up the group.

Replicate Results Data |

Technical ReplicatesT Biological Replicates L

| ShowinTable ¥ || Add BioGroup || Endo Cortrols ¥ || Ref Sample ¥ |

# | Oomit Sample Target CT Mean ACT Mea
1 IF1 ACVR1 5514
a2 O ACVR2 6.0 5=
3 O CCR2 o
4 ] BLADDER 2 CD3D 77
5 O BLADDER 2 FGF21
(3 ] BLADDER 2 FLT4 987
7 (] BLADDER 2 GAPDH 0e
8 BLADDER 2 GAPDH-VIC
a (] BLADDER 2 GTF2B 581

10 ] BLADDER 2 GTF2| 324

1 (] BLADDER 2 HTR4 1752

[}

BLADDER 2 KAI

B.ig
= . s

av

Well Results Data

| Show in Table ¥ || Group Resuits By ¥ | | Il |

# | Sample Omit
BLADD!
BLADD
BLADD!
BLADD
BLADD!
BLADD
BLADD!
Rl ANN

Target
ACVR2
ACVR2
ACVR2
ACVR2
ACVR2
ACVR2
ACVR2
ACVRI

Experim...  Well
BLADDER 2 B1

>

e
(]
(=)
e
s

<

-
v

This tab groups the results of the relative quantitation
analysis by biological replicate group. The 7500 software
displays the results for each biological group as a row in the
table. You can view the members of a group by selecting the
appropriate row from the table. When a row is selected, the
Biological Replicate Details table displays the technical
replicates that make up the biological group. You can then
display the members of a technical replicate group by
selecting a row in the Biological Replicate Details table.

Replicate Results Data
Technical Replicates I Biological Replicates

| Show In Table ¥

|| Add BioGroup || Endo Controls ¥ || Ref BioGroup ¥ |

# Omit Biologic Target # Replic. CT1 Mean
1 O Bladder ACVR1 1 -~
2 O Bladder ACVR2 1 =1
3 O Bladder CCR2 1
4 O Bladder CD3D 1 i
< >

Biological Replicate Details

#  Omit
1 O

| Edit BioGroup | | Delete BioGroup |

Sample Target
BUADDER 7lacvR2

ACT Mean
60904 o

CT Mean

< b

av

Well Results Data

| Show in Table ¥ || Group Resuits By ¥ | | I |

# | Sample

BLADD!
BLADD
BLADD!
BLADD
BLADD!
BLADD
BLADD!
Rl ANN

Target
ACVR2
ACVR2
ACVR2
ACVR2
ACVR2
ACVR2
ACVR2
ACVRI

Experim...  Well
BLADDER 2 B1
BLADDER 2 B2
BLADDER 2 B3
BLADDER 2 B4
Copy of B1
Copy of B2

Copy of B3
are nf R4

Omit

>

<

o

-
v
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Note: The Omit column of the Replicate Results Data group tabs indicates the omission
status of the members of the associated replicate groups. For example, a check mark (¢)
indicates that all members of a group have been omitted from the analysis. A hyphen (-)
indicates that one or more members of the group have been omitted.
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Analyze the Study

The Well Results Data group displays data for each well in the reaction plates that are
added to the study, including:

* The sample name, target name, task, and dyes
* The calculated threshold cycle (Cy), normalized fluorescence (Rn), and quantity values
+ Flags

About the In the comparative C; example study, you review:

Example Study » Each target in the Gene Expression Plot screen for the expression level (or fold
change) of the target sample relative to the reference sample.

» The Replicate Results Data group to evaluate the precision of the replicate groups.

View the Gene 1. In the navigation pane, select Analysis » Gene Expression.
Expression Plot )
2. In the Gene Expression Plot screen:
a. In the Plot Type drop-down list, select RQ vs Sample.
b. In the Graph Type drop-down list, select Log10.

c. In the Orientation drop-down list, select Vertical Bars.

3. Click = (Show a legend for the plot).

Note: This is a toggle button. When the legend is displayed, the button changes to
Hide the plot legend.

In the example experiment, the expression level of multiple targets in samples are
displayed relative to the expression level of the same targets in the reference sample
(universal). Because the reference sample is compared to itself, the relative expression
level is 1. When the result is displayed in the Log10 graph type, the expression level of
the reference sample appears as 0 in the graph (log10 of 1 = 0).

Plot i \ ~

Plot Type: |[RCvs Sample % Graph Type:|Log10 |+ Orientation: Vertical Bars |+

a =
RQ vs Sample

1

log10 RO

o

435’@5‘?:" Q?Y\ = \\"& ‘)\S\ o‘\‘"\ v
Sample
Notes
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4. Click < at the top left of the Replicate Results Data group. The figure below shows

the replicate results and well results tables.

Replicate Results Data

Technical Replicates T Biological Replicates W

| Show InTable ¥ || Add BioGroup || Endo Cortrols ¥ || Ref BioGroup ¥ |

# | Omit Binlogic Target #Replic C1Mean ACTMean | ACTSE MACT RQ RQ Min RQ Max

1 ] Bladder ACVR1 1 55715 0.183 -3.7867 13.8006 10.2248 18.627 ~

2 ] Bladder ACVR2 1 6.0904 0.0501 -3.8316 14.2375 13,1154 15.4556 =

3 O Bladder CCR2 1 11.98 1] -25114 57018 57018 57018

4 1 Bladder CD3D 1 7.5755 0.2925 2.3807 0.192 0.11e9 0.3102

& O Bladder FGF21 1 >
Biological Replicate Details | Edit BioGroup | | Delete BioGroup
# | Omit Sample Target Ct Mean ACTMean | ACTSE BACT RQ RQ Min RQ Max

1 O BLADDER 2 ACVR2 6.0804 0.0507 -2.9296 7.6192 7.0187 8.2711

e
Well Results Data

| Show In Table ¥ “ Group Results By ¥ J | ” |

# Target Experim... | Well omit Cr ACT ACT Medi ACT SE BAACT RQ RQ Min RQ Max Flags
1CVR2 BLADDER 2 B1 O 26.7521 6.0876 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711 |
2CVR2 BLADDER 2 B2 O 26.7253 6.0057 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711
3CVR2 BLADDER 2 B3 O 26.694 5.962 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711
4CZVR2 BLADDER 2 B4 O 26.8892 6.3062 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711 =
SCVR2 Copy of B1 O 26.7521 6.0876 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711
BCVR2 Copy of B2 O 26.7253 6.0057 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711
TCVR2 Copy of B3 O 26.694 5.962 6.0467 0.0501 -2.9296 7.6192 7.0187 8.2711 =
FI"‘(\JF?? anv nf RA [ 7R RRG?D A AINRT R N4RT m nnant -7 Q7GR TR1GT7 FO1R7 87711 | 3 __
Column Description
Omit For all technical replicates that evaluate the associated sample/target combination:
e A check mark (v) indicates that all replicates have been removed from the analysis.
¢ A hyphen (-) indicates that one or more replicates have been removed from the analysis.
Sample The sample associated with the data displayed in the row.
Target The target assay associated with the data displayed in the row.
Ct; Mean The arithmetic average of the technical replicate C values.
AC; Mean | The arithmetic average of the technical replicate C; values for the sample replicate group.
AC; SE The sample standard deviation of the sample replicate group level C; values.
AAC; The calculated AAC value for the replicate group associated with the test sample.
RQ The calculated relative level of gene expression for the replicate group associated with the test sample.
RQ Min The minimum relative level of gene expression in the test samples calculated using the confidence level set in
the Analysis Settings dialog box.
Note: The minimum includes the variability associated with the endogenous control and targets in only the
test samples.
RQ Max The maximum relative level of gene expression in the test samples calculated using the confidence level set
in the Analysis Settings dialog box.
Note: The maximum includes the variability associated with the endogenous control and targets in only the
test samples.
Flag The number of QC flags the well generated as listed in the A symbol.
Notes
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Analyze the Study

Analysis When you review the Gene Expression Plot of a comparative Cy study:

Guidelines + Select the Technical Replicates tab or the Biological Replicates tab to organize and
view the sample data according to the associated technical replicate group or biological
replicate group.

* Change the endogenous control by clicking Endo Control, then selecting a new target.
* Change the reference sample by clicking Ref Sample, then selecting a new sample.

* Omit biological or technical replicates from the analysis. See “Omit Wells using the
Well Table” on page 200

» Display a subset of the data in the study by selecting one or more rows in the Technical
Replicates tab or the Biological Replicates tab, then by selecting Hide unselected data
from plot in bottom of the Gene Expression Plot.

Note: Comparative Ct Example Study.edm does not contain biological replicate groups.
However, another example study that installed with the 7500 software better
demonstrates the use of biological groups. You can find the data file for the example
study on your computer at: <drive>:\Applied Biosystems\<software name>\experiments\
Comparative Ct Study Example (Biological Groups).edm

Omit Replicates from the Analysis

You can use the Technical Replicates and Biological Replicates tabs of the Gene
Expression screen to omit technical replicates and biological replicates from the analysis.

To omit a technical or biological replicate:
1. In the navigation pane, select Analysis » Gene Expression.

2. In the Gene Expression screen, select the Technical Replicates or Biological
Replicates tab according to the type of replicate that you want to omit.

3. In the replicate table, scroll to the biological or technical replicate of interest, then
select the check box in the Omit column.

4. Click Analyze when you are finished omitting wells.

IMPORTANT! You cannot omit a// technical replicates that belong to a reference sample,
belong to a reference biological group, or serve as the endogenous control for a study.

Note: You can also omit the technical replicates in the Biological Replicate Details table
at the bottom of the Biological Replicates tab.

For More For more information on:
Information + Viewing the Gene Expression Plot — See “View the Gene Expression Plot and Well
Table” on page 162, or open the 7500 Software Help by clicking @) or pressing F1.

* Calculating Relative Quantitation Values — Refer to the User Bulletin #2: Relative
Quantitation of Gene Expression.

Notes
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Analyze the Study

View the Amplification Plot

The Amplification Plot displays post-run amplification of the samples of the experiments
added to the study. The plot is identical to the plot of the same name described in the
experiment-level analysis with the exception of the Experiment Data table, which allows
you to select the experiment data displayed by the plot. For more information, see “View
the Amplification Plot” on page 166.

Note: To display a subset of the study data in the Amplification Plot, select one or more
rows in the Experiment Data tab or the Well Table tab, then select Hide unselected data
from plot to display data only from the selected rows.

Omit Wells using the Well Table

You can use the Well Table to omit individual wells from the analysis. To omit a well:

1. In the Experiment Data group, select the experiment that contains the well of
interest.

2. In the View Well Table tab, select the check box in the Omit column for the well of
interest.

IMPORTANT! You cannot omit all technical replicates that belong to a reference sample,
belong to a reference biological group, or serve as the endogenous control.

View the Multicomponent Plot

Notes

200

The Multicomponent Plot displays complete spectral contribution of each dye over the
duration of the PCR run in a selected well of any experiment added to the study. The plot
is identical to the plot of the same name described in the experiment-level analysis with
the exception of the Experiment Data table, which allows you to select the experiment
data displayed by the plot. For more information, see “View the Multicomponent Plot” on
page 182.

Note: To display a subset of the study data in the Multicomponent Plot, select one or
more rows in the Experiment Data tab or the Well Table tab, then select Hide unselected
data from plot to display data only from the selected rows.

Note: You can use the View Well Table tab of the Multicomponent Plot to omit
individual wells from the analysis. The procedure for omitting wells is identical to that
for the Amplification Plot. See “Omit Wells using the Well Table” above.
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Analyze the Study

View Multiple Plots

In the Study Menu, select Multiple Plots View. The operation of the plot is identical to
the plot of the same name described in the experiment-level analysis with the exception
of the Experiment Data table, which allows you to select the experiment data displayed
by the plot. For more information, see “How to Display Multiple Plots” on page 161.

Note: To display a subset of the study data in the Multiple Plots View, select one or more
rows in the Experiment Data tab or the Well Table tab, then select Hide unselected data
from plot to display data only from the selected rows.

Note: You can reduce the data displayed in the plots by applying a filter using the filter
function at the top of the screen. See “How to Simplify Data Lists Using the Filter
Query” on page 192 for more information on using filters.

Note: You can use the View Well Table tab of the Multiple Plots View to omit individual
wells from the analysis. The procedure for omitting wells is identical to that for the
Amplification Plot. See “Omit Wells using the Well Table” on page 200.

View the QC Summary

The QC Summary screen displays a list of the 7500 software flags, and it includes the
flag frequency and location for the experiments added to the open study. The summary is
identical to the QC Summary that appears in the experiment-level analysis. For more
information, see “View the QC Summary” on page 179.

Notes
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Compare Analysis Settings

The Compare Settings screen allows you to perform a side-by-side comparison of
analysis settings for a comparative C; study.

Complete the 1. In the navigation pane, select Analysis » Compare Settings.

Compare . . . . . .
Settings Screen 2. In the Comparison Settings group, modify the comparison analysis settings:

a. Click Edit to the right of the Comparison Analysis Settings heading.
b. Edit the comparison analysis settings as desired, then click Analyze.
c. Click Use Comparison Analysis Settings to analyze the study data using the

modified settings.

Note: Click Use Comparison Analysis Settings to use the previous analysis
settings.

3. Compare the results in the Results Comparison pane. The table uses shaded cells to
distinguish the results from the comparison settings.

Gene Expression Comparison Settings Current Analysis Settings | Eclit... Comparison Analysis Settings | Edit \7728
= Target Settings (Threshold, Baseline Start, Baseline End) ~
GAPDH-VIC AUTO, AUTO, AUTO AUTO, AUTO, AUTO
2750 CD3D AUTO, AUTO, AUTO AUTO, AUTO, AUTO =
ZNF145 AUTO, AUTO, AUTO AUTO, AUTO, AUTO L
2500 WLDLR AUTO, AUTO, AUTO AUTO, AUTO, AUTO
RXRA AUTO, AUTO, AUTO AUTO, AUTO, AUTO
RARA AUTO, AUTO, AUTO AUTO, AUTO, AUTO
2,250 FGF21 AUTO, AUTO, AUTO AUTO, AUTO, AUTO
ACVR2 AUTO, AUTO, AUTO AUTO, AUTO, AUTO
GTF2B AUTO, AUTO, AUTO AUTO, AUTO, AUTO
2000 TRIP15 AUTO, AUTO, AUTO AUTO, AUTO, AUTO
RARG AUTO, AUTO, AUTO AUTO, AUTO, AUTO
1750 IF1 LITOALITOALITA ALITA ALITO ALITO b
‘ Use Comparison Analysis Settings 1 720
1,500 av
[s]
1250
Enter afilter gquery, then click "Apply Filter" To enter multiple filter queries, click "Advanced Filter” | Advanced Fitter |
1,000 e
IF |Samn|e v||= vH || appiy Fiter | | \
750
| Show In Table ¥ ] | Hicle Comparison Fitter ]
500 ] # Sample Target CTMean1 | CTMean2 = ACT Mea ACT Mea ACTSD 1 ACTSD 2
1 BLADDER 2 ACVR1 55715 55715 0.5175 0.5175 A
250 2 BLADDER 2 ACVR2 6.0904 6.0904 01417 01472
‘ 2 BLADDER 2 CCR2 11.98 11.88 0 0
l ﬂ 4 BLADDER 2 CD3D 7.5755 7.5755 0.8275 0.8275
[ L1 J‘L Lid i o 5 BLADDER 2 FGF21
oV Y }“4 o [i} BLADDER 2 FLT4 9.8751 9.8751 0.2284 0.2284
¥ QY} \ ¥ \5‘\\ 7 ELADDER 2 GAPDH 0.803 0.803 0.2187 0.2187
S @
& 8 BLADDER 2 GAFPDH-VIC
9 BLADDER 2 GTF2B 58208 5.8208 0.0885 0.0885
Target 10 BLADDER 2 GTF2I 3.2471 3.2471 0.0809 0.0809 %
< I | >

Publish the Data

You can publish the study data in the same way you publish experiment data. See
“Publish the Data” on page 97 for more information.

Notes
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Appendix A

“ Alternate Experiment Workflows

This appendix covers:

B Advanced Setup Workflow . . ... ... ... .. . . 204
B QuickStart Workflow . . ... .. .. .. . . 206
B Template Workflow. . .. ... ..o 208
B Export/Import Workflow .. ... ... ... .. .. . . 210

Note: For more information about any of the topics discussed in this guide, open the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR Software v2.0 by
pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Advanced Setup Workflow

When you create an experiment using Advanced Setup in the 7500 software, you can set
up the experiment according to your own design.

1. Double-click g (7500 software) or select Start » All Programs »
Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. In the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow beneath the
Design Wizard icon to expand the Set Up menu.

3. Complete the setup screens to set up a new experiment:

a. Click |=|| Experiment Properties (default), enter the experiment name, then
select the experiment properties.

b. Click [#] Plate Setup:

Experiment Type Action

Genotyping Define the SNP assays, then assign them to wells in the
reaction plate.

All other experiments Define the targets, then assign them to wells in the
reaction plate.

c. Click Add Biological Group to create biological replicates and assign
replicates to samples for each biological group in the reaction plate.

d. Click Run Method, review the reaction volume and thermal profile, then
edit as needed.

e. Click Reaction Setup, review the components and calculated volumes for
the PCR reactions, then edit as needed.

f. (Optional) Click D Materials List, review the list of materials, then order
the materials you need to prepare the reaction plate.

Notes
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4. Prepare the PCR reactions:

Experiment Type Prepare the...

Relative standard curve Template.

. Sample dilutions.
Standard dilution series.
. Reaction mix.

Reaction plate.

Standard curve

® Qoo

Comparative Cy a. Template.

Genotyping b. Samp!e dllultlons.
I | c. Reaction mix.

Presence/absence d. Reaction plate.

5. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

. Load the reaction plate into the instrument.

a
b. Start the run.

0

. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
6. Analyze the data:
. Open the experiment in the 7500 software.

a
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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QuickStart Workflow

When you create an experiment using QuickStart, you can run the reactions on the
instrument with no reaction plate setup information.

1. Prepare the PCR reactions:

Experiment Type Prepare the...

Relative standard curve Template.

. Sample dilutions.
Standard dilution series.
. Reaction mix.

Reaction plate.

Standard curve

® Qoo

Comparative Cy a. Template.

Genotyping b. Samp!e dllultlons.
c. Reaction mix.

Presence/absence d. Reaction plate.

2. QuickStart the experiment:

a. Double-click g (7500 software) or select Start » All Programs »
Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.
b. In the Home screen, click |2Q QuickStart.

c. Select the Experiment Properties tab (default), enter the experiment name,
then select the experiment properties.

d. Select the Run Method tab, review the reaction volume and thermal profile,
then edit as needed.

3. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

. Load the reaction plate into the instrument.

a
b. Start the run.

c. (Optional) Monitor the run.
d. Unload the reaction plate from the instrument.
Notes
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4. Inthe 7500 software, complete the reaction plate setup:

Experiment Type Select, then complete the...

Genotyping a. Define SNP Assays and Samples tab.
b. Assign SNP Assays and Samples tab.

All other experiments a. Define Targets and Samples tab.
b. Assign Targets and Samples tab.

5. Analyze the data:
. Open the experiment in the 7500 software.

a
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Template Workflow

You can use a template to create a new experiment. Templates allow you to create many
experiments with the same setup information.

Createa 1. Double-click g (7500 software) or select Start » All Programs »
Template Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2 and
Chapter 6) or Advanced Setup (see page 204).

3. Seclect File » Save As Template.
4. Enter a file name, select a location for the template, then click Save.

5. Click I Close.

Create an 1. In the Home screen, click \/ -
Experiment Using
a Template Note: If you do not see the Template icon, click the arrow below the Design Wizard
icon to expand the Set Up menu.

Template.

2. Locate, then select the template you created above, then click Open. A new
experiment is created using the following setup information from the template:

* Experiment properties
* Plate setup

* Run method

* Reaction setup

3. (Optional) If you want to modify the experiment, use Advanced Setup (see
page 204).

4. Click [ Save, enter a file name, then click Save to save the experiment.

Notes
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Template Workflow

5. Prepare the PCR reactions:

Experiment Type Prepare the...

Relative standard curve Template.

. Sample dilutions.
Standard dilution series.
. Reaction mix.

Reaction plate.

Standard curve

® Qoo

Comparative Cy a. Template.

Genotyping b. Samp!e dllultlons.
I | c. Reaction mix.

Presence/absence d. Reaction plate.

6. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

. Load the reaction plate into the instrument.

a
b. Start the run.

0

. (Optional) Monitor the run.

d. Unload the reaction plate from the instrument.
7. Analyze the data:
. Open the experiment in the 7500 software.

a
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Export/Import Workflow

Use the Export/Import workflow to set up a new experiment using setup data exported
from another experiment. Only reaction plate setup data are exported and imported.

Export Setup 1. Double-click g (7500 software) or select Start » All Programs »
Data Applied Biosystems » 7500 Software » <software name>

where <software name> is the current version of the 7500 software.

2. Open an existing experiment, or create a new experiment.

Note: You can create a new experiment using the Design Wizard (see Chapter 2 and
Chapter 6) or Advanced Setup (see page 204).
3. Seclect File » Export.

4. Select the Export Properties tab (default), then:
. Select Sample Setup.

a
b. Select One File in the drop-down list.

0

. Enter a name, then select a location for the export file.

o

. Select [Z] (*.txt) in the File Type drop-down list.

IMPORTANT! You cannot export *.xml files.

5. (Optional) Select the Customize Export tab, then select the appropriate options.
6. Click Start Export.

7. When prompted, click Close Export Tool.

Create an  You can import reaction plate setup data from an exported text file (*.txt) to complete the
Experiment with reaction plate setup data for your experiment.
an Exported Text
File IMPORTANT! Be sure the exported text file that you select contains only reaction plate
setup data and that the experiment types match.

1. Import the reaction plate setup data from the exported text file:

a. Using a spreadsheet application (such as Microsoft® Excel software), open an
exported text file.

b. Replace the parameters of the text file as needed. When you finish, save the
file as a tab-delimited text file.

Notes
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Export/Import Workflow

c. In the Home screen, click Advanced Setup.

Note: If you do not see the Advanced Setup icon, click the arrow below the
Design Wizard icon to expand the Set Up menu.

d. Create a new experiment or open an existing experiment.
e. Select File » Import.
f. Click Browse, locate and select the text file (*.txt), then click Select.

g. Click Start Import. The setup data from the exported text file is imported into
the open experiment.

Note: If your experiment already contains reaction plate setup information, the
software prompts you to replace the reaction plate setup with the data from the
text file. Click Yes to replace the reaction plate setup.

2. Use Advanced Setup to finish setting up your experiment (see page 204).

3. Prepare the PCR reactions:

Experiment Type Prepare the...

Relative standard curve Template.

. Sample dilutions.
Standard dilution series.
. Reaction mix.

Reaction plate.

Standard curve

Qoo

Comparative C; a. Template.

Genotyping b. Samp!e dllultlons.
c. Reaction mix.

Presence/absence d. Reaction plate.

4. Run the experiment:

IMPORTANT! While the 7500/7500 Fast instrument is performing a run, do not
create experiments, perform maintenance, or allow the computer to run antivirus
software or to enter hibernation. Performing such activities while the instrument is
running an experiment will cause gaps in data collection.

. Load the reaction plate into the instrument.

a
b. Start the run.

c. (Optional) Monitor the run.
d. Unload the reaction plate from the instrument.
Notes
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5. Analyze the data:
. Open the experiment in the 7500 software.

a
b. In the navigation pane, click Analysis.

o

If the data are not analyzed, click Analyze.

d. In the navigation pane, select an analysis screen to view the data (for example,
select QC Summary to view a quality summary of the data).

Notes
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Advanced Setup

AIF
allele

allelic
discrimination plot

amplicon

amplification

amplification
efficiency (EFF %)

amplification plot

Glossary

In the 7500 software, a feature that allows you to set up your experiment according to your
experiment design. Advanced Setup provides you with maximum flexibility in the design
and setup of your experiment.

See assay information file (AIF).
For a given target, any of the different sequences that occurs in the population.

Display of data collected during the post-PCR read. The allelic discrimination plot is a
graph of the normalized reporter signal from the allele 1 probe plotted against the
normalized reporter signal from the allele 2 probe.

A segment of DNA amplified during PCR.

Part of the instrument run in which PCR produces amplification of the target. For
quantitation experiments, fluorescence data collected during amplification are displayed in
an amplification plot, and the data are used to calculate results. For genotyping or
presence/absence experiments, fluorescence data collected during amplification are
displayed in an amplification plot, and the data can be used for troubleshooting.

Calculation of efficiency of the PCR amplification. The amplification efficiency is
calculated using the slope of the regression line in the standard curve. A slope close to
—3.32 indicates optimal, 100% PCR amplification efficiency. Factors that affect
amplification efficiency:

* Range of standard quantities — To increase the accuracy and precision of the
efficiency measurement, use a broad range of standard quantities, 5 to 6 logs
(10° to 10° fold).

* Number of standard replicates — To increase the precision of the standard quantities
and decrease the effects of pipetting inaccuracies, include replicates.

* PCR inhibitors — PCR inhibitors in the reaction can reduce amplification and alter
measurements of the efficiency.

Display of data collected during the cycling stage of PCR amplification. Can be viewed as:

» Baseline-corrected normalized reporter (ARn) vs. cycle
* Normalized reporter (Rn) vs. cycle
» Threshold cycle (Cy) vs. well
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Glossary

amplification stage

assay

Assay ID

assay information
file (AIF)

assay mix

AutoDelta

automatic baseline

automatic C;

Part of the instrument run in which PCR produces amplification of the target. The
amplification stage is called a cycling stage in the thermal profile and consists of
denaturing, primer annealing, and polymerization steps that are repeated.

For quantitation experiments, fluorescence data collected during the amplification stage are
displayed in an amplification plot, and the data are used to calculate results. For genotyping
or presence/absence experiments, fluorescence data collected during the amplification
stage are displayed in an amplification plot, and the data can be used for troubleshooting.
See also cycling stage.

In the 7500/7500 Fast system, a PCR reaction mix that contains primers to amplify a target
and a reagent to detect the amplified target.

Identifier assigned by Applied Biosystems to TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays.

Data file on a CD shipped with each assay order. The file name includes the number from
the barcode on the plate. The information in the AIF is provided in a tab-delimited format.

PCR reaction component in Applied Biosystems TagMan® Gene Expression Assays and
TagMan® SNP Genotyping Assays. The assay mix contains primers designed to amplify a
target and a TagMan® probe designed to detect amplification of the target.

In the run method, a setting to increase or decrease the temperature and/or time for a step
with each subsequent cycle in a cycling stage. When AutoDelta is enabled for a cycling
stage, the settings are indicated by an icon in the thermal profile:

e AutoDelta on: &
e AutoDelta off: A

An analysis setting in which the software calculates the baseline start and end values for the
amplification plot. You can apply the automatic baseline setting to specific wells in the
reaction plate. See also baseline.

An analysis setting in which the software calculates the baseline start and end values and
the threshold in the amplification plot. The software uses the baseline and threshold to
calculate the threshold cycle (Cy). See also threshold cycle (Cy).

baseline In the amplification plot, a line fit to the fluorescence levels during the initial stages of PCR,
when there is little change in fluorescence.
216 Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide for Relative Standard Curve

and Comparative C; Experiments



baseline-corrected
normalized reporter
(ARN)

biological replicates

blocked IPC

o
calibrator
chemistry

comparative C;
(AAC;) method

custom dye

cycle threshold

cycling stage

Glossary

The magnitude of normalized fluorescence generated by the reporter:

1. In experiments that contain data from real-time PCR, the magnitude of normalized
fluorescence generated by the reporter at each cycle during the PCR amplification. In
the ARn vs. Cycle amplification plot, ARn is calculated at each cycle as:

ARn (cycle) = Rn (cycle) — Rn (baseline), where Rn = normalized reporter

2. In genotyping experiments and presence/absence experiments, the difference in
normalized fluorescence generated by the reporter between the pre-PCR read and the
post-PCR read. In the allelic discrimination plot (genotyping experiments) and the
presence/absence plot (presence/absence experiments), ARn is calculated as:

ARn = Rn (post-PCR read) — Rn (pre-PCR read), where Rn = normalized reporter
See also normalized reporter (Rn).

Reactions that contain identical components and volumes, but evaluate separate samples of
the same biological source (for example, samples from three different mice of the same
strain, or separate extractions of the same cell line or tissue sample). See also technical
replicates.

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks
amplification of the internal positive control (IPC). In the 7500 software, the task for the
IPC target in wells that contain [PC blocking agent. See also negative control-blocked IPC
wells.

See threshold cycle (Cy).
See reference sample.
See reagents.

Method for determining relative target quantity in samples. With the comparative C (AACy)
method, the 7500 software measures amplification of the target and of the endogenous
control in samples and in a reference sample. Measurements are normalized using the
endogenous control. The software determines the relative quantity of target in each sample
by comparing normalized target quantity in each sample to normalized target quantity in the
reference sample.

Dye that is not supplied by Applied Biosystems. Custom dyes may be adapted for use in
experiments on the 7500/7500 Fast system. When using custom dyes, the custom dye
should be added to the Dye Library and a custom dye calibration performed.

See threshold cycle (Cy).

In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification
stage. For cycling stages, you can enable AutoDelta settings. See also amplification stage.
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Glossary

data collection

delta Rn (ARnN)
derivative reporter
(-Rn’)

Design Wizard

diluent

Diluted Sample
Concentration (10X
for Reaction Mix)

dilution factor
dissociation curve
EFF%

endogenous control

endpoint read

experiment

A process during the instrument run in which an instrument component detects
fluorescence data from each well of the reaction plate. The instrument transforms the signal
to electronic data, and the data are saved in the experiment file. In the 7500 software, a data
collection point is indicated by an icon in the thermal profile:

* Data collection on:

* Data collection off:
See baseline-corrected normalized reporter (ARn).

The negative first-derivative of the normalized fluorescence generated by the reporter
during PCR amplification. In the derivative reporter (—Rn”) vs. temperature melt curve, the
derivative reporter signal is displayed in the y-axis.

A feature in the 7500 software that helps you set up your experiment by guiding you through
best practices as you enter your experiment design.

A reagent used to dilute a sample or standard before adding it to the PCR reaction. The
diluent can be water or buffer.

In the 7500 software, a field displayed on the Sample Dilution Calculations tab of the
Reaction Setup screen. For this field, enter the sample concentration you want to use to add
to the reaction mix for all samples in the experiment. “10X for Reaction Mix” indicates that
the software assumes the sample or standard component of the reaction mix is at a 10X
concentration. For example, if the diluted sample concentration is 50.0 ng/uL (10X), the
final sample concentration in the reaction is 5 ng/uL (1X).

See serial factor.
See melt curve.
See amplification efficiency (EFF%).

A target or gene that should be expressed at similar levels in all samples you are testing.
Endogenous controls are used in relative standard curve and comparative C; (AACy)
experiments to normalize fluorescence for the target you are quantifying. Housekeeping
genes can be used as endogenous controls. See also housekeeping gene.

See post-PCR read.

Refers to the entire process of performing a run using the 7500/7500 Fast system, including
setup, run, and analysis. The types of experiments you can perform using the
7500/7500 Fast systems:

* Quantitation - standard curve

* Quantitation - relative standard curve

* Quantitation - comparative C; (AACy)

* Melt curve

* Genotyping

* Presence/absence
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experiment name

experiment type

forward primer

holding stage

housekeeping gene

internal positive
control (IPC)

inventoried assays

IPC

IPC blocking agent
IPC+
made-to-order

assays

manual baseline

Glossary

Entered during experiment setup, the name that is used to identify the experiment.
Experiment names cannot exceed 100 characters and cannot include any of the following
characters: forward slash (/), backslash (\), greater than sign (>), less than sign (<), asterisk
(*), question mark (?), quotation mark ("), vertical line (|), colon (:), or semicolon (;).

The type of experiment you are performing using the 7500/7500 Fast system:

+ Standard curve

» Comparative C; (AACy)

+ Relative standard curve

* Melt curve (not available in the Design Wizard)
* Genotyping

* Presence/absence

The experiment type you select affects the setup, run, and analysis.

Oligonucleotide that flanks the 5" end of the amplicon. The reverse primer and the forward
primer are used together in PCR reactions to amplify the target.

In the thermal profile, a stage that includes one or more steps. You can add a holding stage
to the thermal profile to activate enzymes, to inactivate enzymes, or to incubate a reaction.

A gene that is involved in basic cellular functions and is constitutively expressed.
Housekeeping genes can be used as endogenous controls. See also endogenous control.

In presence/absence experiments, a short synthetic DNA template that is added to PCR
reactions. You can use the IPC to distinguish between true negative results (that is, the target
is absent in the samples) and negative results caused by PCR inhibitors, incorrect assay
setup, or reagent or instrument failure.

TagMan® Gene Expression Assays and TagMan® SNP Genotyping Assays that have been
previously manufactured, passed quality control specifications, and stored in inventory.

In presence/absence experiments, abbreviation for internal positive control (IPC). In the
7500 software, the task for the IPC target in wells that contain the IPC and do not contain
IPC blocking agent. See also internal positive control (IPC).

Reagent added to PCR reactions to block amplification of the internal positive control
(IPC).

See negative control-IPC wells.
TagMan® Gene Expression Assays or TagMan® SNP Genotyping Assays that are
manufactured at the time of order. Only assays that pass manufacturing quality control

specifications are shipped.

An analysis setting in which you enter the baseline start and end values for the amplification
plot. You can apply the manual baseline setting to specific wells in the reaction plate.

manual C; An analysis setting in which you enter the threshold value and select whether to use
automatic baseline or manual baseline values. The software uses the baseline and the
threshold values to calculate the threshold cycle (Cy).
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Glossary

melt curve

melt curve stage
melting temperature
(Tm)
multicomponent
plot

negative control

(NC)

negative control-
blocked IPC wells

negative control-
IPC wells

no amplification
control (NAC)

no template control
(NTC)

nonfluorescent
quencher-minor

groove binder (NFQ-
MGB)

normalized quantity

normalized reporter
(Rn)

omit well

outlier

220

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the
melting temperature (Tm) of the target or can identify nonspecific PCR amplification. In
the 7500 software, you can view the melt curve as normalized reporter (Rn) vs. temperature
or as derivative reporter (—Rn") vs. temperature. Also called dissociation curve.

In the thermal profile, a stage with a temperature increment to generate a melt curve.

In melt curve experiments, the temperature at which 50% of the DNA is double-stranded
and 50% of the DNA is dissociated into single-stranded DNA. The Tm is displayed in the
melt curve.

A plot of the complete spectral contribution of each dye for the selected well(s) over the
duration of the PCR run.

In the 7500 software, the task for targets or SNP assays in wells that contain water or buffer
instead of sample. No amplification of the target should occur in negative control wells.
Previously called no template control (NTC).

In presence/absence experiments, wells that contain IPC blocking agent instead of sample
in the PCR reaction. No amplification should occur in negative control-blocked IPC wells
because the reaction contains no sample and amplification of the IPC is blocked. Previously
called no amplification control (NAC).

In presence/absence experiments, wells that contain IPC template and buffer or water
instead of sample. Only the IPC template should amplify in negative control-IPC wells
because the reaction contains no sample. Previously called IPC+.

See negative control-blocked IPC wells.

See negative control (NC).

Molecules that are attached to the 3’ end of TagMan® probes. When the probe is intact, the
nonfluorescent quencher (NFQ) prevents the reporter dye from emitting fluorescence.
Because the NFQ does not fluoresce, it produces lower background signals, resulting in
improved precision in quantitation. The minor groove binder (MGB) increases the melting
temperature (Tm) without increasing probe length. It also allows the design of shorter
probes.

Quantity of target divided by the quantity of endogenous control.

Fluorescence from the reporter dye normalized to the fluorescence of the passive reference.

An action that you perform before reanalysis to omit one or more wells from analysis.
Because no algorithms are applied to omitted wells, omitted wells contain no results.

For a set of data, a datapoint that is significantly smaller or larger than the others.
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passive reference

plate layout

point

positive control

post-PCR read

pre-PCR read

primer mix

primer/probe mix

pure dye

quantitation method

quantity

quencher

Glossary

A dye that produces fluorescence. Because the passive reference signal should be consistent
across all wells, it is used to normalize the reporter dye signal to account for non-PCR
related fluorescence fluctuations caused by minor well-to-well differences in concentrations
or volume. Normalization to the passive reference signal allows for high data precision.

An illustration of the grid of wells and assigned content in the reaction plate. In the
7500/7500 Fast system, the grid contains 8 rows and 12 columns.

In the 7500 software, you can use the plate layout as a selection tool to assign well contents,
to view well assignments, and to view results. The plate layout can be printed, included in
a report, exported, and saved as a slide for a presentation.

One standard in a standard curve. The standard quantity for each point in the standard curve
is calculated based on the starting quantity and serial factor.

In genotyping experiments, a DNA sample with a known genotype, homozygous or
heterozygous. In the 7500 software, the task for the SNP assay in wells that contain a sample
with a known genotype.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs after amplification. In genotyping experiments, fluorescence data collected during
the post-PCR read are displayed in the allelic discrimination plot and used to make allele
calls. In presence/absence experiments, fluorescence data collected during the post-PCR
read are displayed in the presence/absence plot and used to make detection calls. Also called
endpoint read.

Used in genotyping and presence/absence experiments, the part of the instrument run that
occurs before amplification. The pre-PCR read is optional but recommended. Fluorescence
data collected during the pre-PCR read can be used to normalize fluorescence data collected
during the post-PCR read.

PCR reaction component that contains the forward primer and reverse primer designed to
amplify the target.

PCR reaction component that contains the primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

See custom dye and system dye.

In quantitation experiments, the method used to determine the quantity of target in the
samples. In 7500/7500 Fast systems, there are three types of quantitation methods: standard
curve, relative standard curve, and comparative Cy (AACy).

In quantitation experiments, the amount of target in the samples. Absolute quantity can refer
to copy number, mass, molarity, or viral load. Relative quantity refers to the fold-difference
between normalized quantity of target in the sample and normalized quantity of target in the
reference sample.

A molecule attached to the 3’ end of TagMan® probes to prevent the reporter from emitting
fluorescence while the probe is intact. With TagMan® reagents, a nonfluorescent quencher-
minor groove binder (NFQ-MGB) can be used as the quencher. With SYBR® Green
reagents, no quencher is used.
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Glossary

QuickStart

R2 value

ramp

ramp speed

raw data plot

reaction mix

reagents

real-time PCR

reference sample

refSNP ID

A feature in 7500/7500 Fast systems that allows you to run an experiment without entering
plate setup information.

Regression coefficient calculated from the regression line in the standard curve. The R?
value indicates the closeness of fit between the standard curve regression line and the
individual C; data points from the standard reactions. A value of 1.00 indicates a perfect fit
between the regression line and the data points.

The rate at which the temperature changes during the instrument run. Except for the melt
curve step, the ramp is defined as a percentage. For the melt curve step, the ramp is defined
as a temperature increment. In the graphical view of the thermal profile, the ramp is
indicated by a diagonal line.

Speed at which the temperature ramp occurs during the instrument run. Available ramp
speeds include fast and standard.

* For optimal results using the fast ramp speed, Applied Biosystems recommends using
TagMan® Fast reagents in your PCR reactions.

* For optimal results using the standard ramp speed, Applied Biosystems recommends
using standard reagents in your PCR reactions.

IMPORTANT! TagMan Fast reagents are not supported for genotyping or
presence/absence experiments.

A plot of raw fluorescence (not normalized) for each optical filter.

A solution that contains all components to run the PCR reaction, except for the template
(sample, standard, or control).

The PCR reaction components you are using to amplify the target and to detect
amplification. Types of reagents used on the 7500/7500 Fast systems:

+ TagMan® reagents
+ SYBR® Green reagents
* Other reagents

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used
to calculate results for quantitation experiments or to troubleshoot results for genotyping or
presence/absence experiments.

In relative standard curve and comparative C; (AAC;) experiments, the sample used as the
basis for relative quantitation results. Also called the calibrator.

Identifies the reference SNP (refSNP) cluster ID. Generated by the Single Nucleotide
Polymorphism Database of Nucleotide Sequence Variation (dbSNP) at the National Center
for Biotechnology Information (NCBI). The refSNP ID can be used to search the Applied
Biosystems Store for an Applied Biosystems SNP Genotyping Assay. Also called an rs
number.
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regression
coefficients

regression line

reject well

relative standard

curve method

replicate group
replicates

reporter

reverse primer

reverse
transcriptase

Glossary

Values calculated from the regression line in standard curves, including the R? value, slope,
and y-intercept. You can use the regression coefficients to evaluate the quality of results
from the standards. See also standard curve.

In standard curve and relative standard curve experiments, the best-fit line from the
standard curve. Regression line formula:

Cr=m[log (Qty)] +b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also regression coefficients.

An action that the software performs during analysis to remove one or more wells from
further analysis if a specific flag is applied to the well. Rejected wells contain results
calculated up to the point of rejection.

Method for determining relative target quantity in samples. With the relative standard curve
method, the 7500 software measures amplification of the target and of the endogenous
control in samples, in a reference sample, and in a standard dilution series. Measurements
are normalized using the endogenous control. Data from the standard dilution series are
used to generate the standard curve. Using the standard curve, the software interpolates
target quantity in the samples and in the reference sample. The software determines the
relative quantity of target in each sample by comparing target quantity in each sample to
target quantity in the reference sample.

A set of identical reactions in an experiment.

See technical replicates or biological replicates.

Fluorescent dye used to detect amplification. If you are using TagMan® reagents, the
reporter dye is attached to the 5" end. If you are using SYBR® Green reagents, the reporter

dye is SYBR® Green dye.

An oligonucleotide that flanks the 3" end of the amplicon. The reverse primer and the
forward primer are used together in PCR reactions to amplify the target.

An enzyme that converts RNA to cDNA. Reverse transcriptase is added to the PCR reaction
to perform 1-step RT-PCR.

Rn See normalized reporter (Rn).

ROX™ dye A dye supplied by Applied Biosystems and precalibrated on the 7500/7500 Fast systems.
ROX dye is used as the passive reference.

rs number See refSNP ID.

run method Definition of the reaction volume and the thermal profile for the 7500/7500 Fast instrument
run.

sample The template that you are testing.
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Glossary

Sample DNA (10X)

Sample Library

Sample or Standard
(10X)

sample/SNP assay
reaction

sample/target
reaction

serial factor

series

slope

SNP

SNP assay

SNP Assay Library

region of interest
(ROI) calibration

In the 7500 software, a reaction component displayed on the Reaction Mix Calculations tab
of the Reaction Setup screen. The software assumes the sample DNA is added to the
reaction mix at a 10X concentration. For example, if the reaction volume is 20 puL, the
calculated volume of sample for 1 reaction is 2 uL.

In the 7500 software, a collection of samples. The Sample Library contains the sample
name and the sample color.

In the 7500 software, a reaction component displayed on the Reaction Mix Calculations tab
of the Reaction Setup screen. The software assumes the sample or standard is added to the
reaction mix at a 10X concentration. For example, if the reaction volume is 20 pL, the
calculated volume of sample or standard for 1 reaction is 2 uL.

In genotyping experiments, the combination of which sample to test and which SNP assay
to perform in one PCR reaction. Each PCR reaction can contain only one sample and one
SNP assay.

In quantitation experiments, the combination of which sample to test and which target to
detect and quantify in one PCR reaction. In the Design Wizard, you can detect and quantify
only one target in one PCR reaction. Use Advanced Setup to detect and quantify more than
one target in one PCR reaction.

In the 7500 software, a numerical value that defines the sequence of quantities in the
standard curve. The serial factor and the starting quantity are used to calculate the standard
quantity for each point in the standard curve. For example, if the standard curve is defined
with a serial factor of 1:10 or 10X, the difference between any 2 adjacent points in the curve
is 10-fold.

See standard dilution series.

Regression coefficient calculated from the regression line in the standard curve. The slope
indicates the PCR amplification efficiency for the assay. A slope of —3.32 indicates 100%
amplification efficiency. See also amplification efficiency (EFF%) and regression line.

Abbreviation for single nucleotide polymorphism. The SNP can consist of a base difference
or an insertion or deletion of one base.

Used in genotyping experiments, a PCR reaction that contains primers to amplify the SNP
and two probes to detect different alleles.

In the 7500 software, a collection of SNP assays to add to genotyping experiments. The SNP
assays in the library contain the SNP assay name, SNP assay color, and for each allele, the
allele name or base(s), reporter, quencher, and allele colors. The SNP assays in the library
may also contain the assay ID and comments about the SNP assay.

Type of 7500/7500 Fast system calibration in which the system maps the positions of the
wells in the sample block. ROI calibration data are used so that the software can associate
increases in fluorescence during a run with specific wells in the reaction plate.

stage In the thermal profile, a group of one or more steps. There are three types of stages: holding
stage (including pre-PCR read and post-PCR read), cycling stage (also called amplification
stage), and melt curve stage.
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standard

standard curve

standard curve
method

standard dilution
series

standard quantity

starting quantity

Glossary

Sample that contains known standard quantities. Standard reactions are used in quantitation
experiments to generate standard curves. See also standard curve and standard dilution
series.

In standard curve and relative standard curve experiments:

» The best-fit line in a plot of the C; values from the standard reactions plotted against
standard quantities. See also regression line.

* A set of standards containing a range of known quantities. Results from the standard
curve reactions are used to generate the standard curve. The standard curve is defined
by the number of points in the dilution series, the number of standard replicates, the
starting quantity, and the serial factor. See also standard dilution series.

Method for determining absolute target quantity in samples. With the standard curve
method, the 7500 software measures amplification of the target in samples and in a standard
dilution series. Data from the standard dilution series are used to generate the standard
curve. Using the standard curve, the software interpolates the absolute quantity of target in
the samples. See also standard and standard curve.

In standard curve and relative standard curve experiments, a set of standards containing a
range of known quantities. The standard dilution series is prepared by serially diluting
standards. For example, the standard stock is used to prepare the first dilution point, the first
dilution point is used to prepare the second dilution point, and so on. In the 7500 software,
the volumes needed to prepare a standard dilution series are calculated by the number of
dilution points, the number of standard replicates, the starting quantity, the serial factor, and
the standard concentration in the stock. See also standard curve.

A known quantity in the PCR reaction.

* In standard curve experiments, the quantity of target in the standard. In the 7500
software, the units for standard quantity can be for mass, copy number, viral load, or
other units for measuring the quantity of target.

* Inrelative standard curve experiments, a known quantity in the standard. Standard
quantity can refer to the quantity of cDNA or the quantity of standard stock in the
PCR reaction. The units are not relevant for relative standard curve experiments
because they cancel out in the calculations.

When defining a standard curve in the 7500 software, corresponds to the highest or lowest
quantity.

step A component of the thermal profile. For each step in the thermal profile, you can set the
ramp rate (ramp increment for melt curve steps), hold temperature, hold time (duration),
and you can turn data collection on or off for the ramp or the hold parts of the step. For
cycling stages, a step is also defined by the AutoDelta status.

SYBR® Green PCR reaction components that consist of two primers designed to amplify the target and

reagents SYBR® Green dye to detect double-stranded DNA.
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Glossary

system dye

TagMan® reagents

target

target color

Target Library

task

technical replicates

Dye supplied by Applied Biosystems and precalibrated on the 7500/7500 Fast system.
Before you use system dyes in your experiments, make sure the system dye calibration is
current in the Instrument Maintenance Manager.

System dyes of the 7500/7500 Fast system include:
+ FAM"™ dye
+ JOE™ dye
« NED" dye
« ROX™ dye
+ SYBR® Green dye
« TAMRA™ dye
+ VIC® dye
* CY3dye
+ CYS5dye
+ TEXAS RED® dye

PCR reaction components that consist of primers designed to amplify the target and a
TagMan® probe designed to detect amplification of the target.

The nucleic acid sequence that you want to amplify and detect.

In the 7500 software, a color assigned to a target to identify the target in the plate layout and
analysis plots.

In the 7500 software, a collection of targets to add to experiments. The targets in the library
contain the target name, reporter, quencher, and target color. The target in the library may
also contain comments about the target.

In the 7500 software, the type of reaction performed in the well for the target or SNP assay.
Available tasks:

» Unknown

* Negative Control

* Standard (standard curve and relative standard curve experiments)
* Positive control (genotyping experiments)

+ [PC (presence/absence experiments)

* Blocked IPC (presence/absence experiments)

Identical reactions that contain identical components and volumes and evaluate the same
sample.

See also biological replicates.
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template

thermal profile

threshold

threshold cycle (C,)

Tm

unknown

unknown-IPC wells

Glossary

In the Design Wizard of the 7500 software (and in QuickStart for quantitation experiments),
the type of nucleic acid to add to the PCR reaction. The recommended template varies
according to experiment type:

Quantitation experiments (standard curve, relative standard curve, and comparative
C;) — cDNA (complementary cDNA), RNA, or gDNA (genomic DNA)

For quantitation experiments, the template type selection affects the run method,
reaction setup, and materials list.

Genotyping experiments — Wet DNA (gDNA or cDNA) or dry DNA (gDNA or
cDNA)

For genotyping experiments, the template type selection affects the reaction setup.
Presence/absence experiments - DNA

For presence/absence experiments, Applied Biosystems recommends adding DNA
templates to the PCR reactions.

Part of the run method that specifies the temperature, time, ramp, and data collection points
for all steps and stages of the 7500/7500 Fast instrument run.

1.

In amplification plots, the level of fluorescence above the baseline and within the
exponential growth region The threshold can be determined automatically (see
automatic Cy) or can be set manually (see manual Cy).

In presence/absence experiments, the level of fluorescence above which the 7500
software assigns a presence call.

The PCR cycle number at which the fluorescence meets the threshold in the amplification

plot.

See melting temperature (Tm).

In the 7500 software, the task for the target or SNP assay in wells that contain the sample
you are testing:

In quantitation experiments, the task for the target in wells that contain a sample with
unknown target quantities.

In genotyping experiments, the task for the SNP assay in wells that contain a sample
with an unknown genotype.

In presence/absence experiments, the task for the target in wells that contain a sample
in which the presence of the target is not known.

In presence/absence experiments, wells that contain a sample and internal positive control

(IPC).
y-intercept In the standard curve, the value of y where the regression line crosses the y-axis. The
y-intercept indicates the expected threshold cycle (C;) for a sample with quantity equal to 1.
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Numerics
1-step RT-PCR 10, 25, 26, 36, 42, 118, 126, 130
2-step RT-PCR 10, 14, 15, 25,26, 117, 118
7500/7500 Fast system

consumables 4

data collection 2

filters 3, 110, 186
reagents 11

A

Advanced Setup 12, 13, 25, 33, 63, 117, 118, 123, 148,
204

alternate experiment workflows. See workflows.
amplification efficiency 30, 31, 84, 178

Amplification Plot screen
monitor during a run 72
view after arun 85, 166, 200

amplification plot, typical 90, 171
AMPNC flag 104, 180

analysis screens
Amplification Plot screen 85, 166, 200
Compare Analysis Settings screen 202
Gene Expression Plot screen 93, 162, 196
Multicomponent Plot screen 107, 182, 200
Multiple Plots screen 81, 161, 201
navigation tips 80, 160
QC Summary screen 103, 179, 201
Raw Data Plot screen 109, 185
Standard Curve screen 82
Well Table 93, 162

analysis settings
advanced 101, 177
baseline 101, 177
compare 202
CT 101, 177
flag 101, 177
relative quantitation 101, 177
threshold 101, 177
view 100, 176, 202
analyze experiment
analyze 78, 158
for more information 84,92, 96, 102, 104, 106, 109,
110, 165, 173, 178, 180, 182, 184, 186
guidelines 80, 84, 90, 96, 101, 104, 106, 109, 110,
159, 165, 171, 177, 180, 182, 184, 186
omit wells 105, 181
publish the data 174
view Amplification Plot screen 85, 166
view analysis settings 100, 176

Index

view Gene Expression Plot screen 93, 162
view Multicomponent Plot screen 107, 182
view Multiple Plots screen 81, 161

view QC Summary screen 103, 179

view Raw Data Plot screen 109, 185

view Standard Curve screen 82

view Well Table 93, 162

workflow 76

analyze study
analyze 195
for more information 192, 199
guidelines 199
omit wells 199, 200
view Amplification Plot screen 200
view analysis settings 202
view Compare Analysis Settings screen 202
view Experiment Data 195
view Gene Expression Plot screen 196
view Multicomponent Plot screen 200
view Multiple Plots screen 201
view QC Summary 201

Applied Biosystems
contacting Xi
customer feedback on documentation xi
Technical Support xi

Applied Biosystems 7500/7500 Fast Real-Time PCR
System. See 7500/7500 Fast system.

assumptions for using this guide viii

B

BADROX flag 104, 180

baseline
correct values 90, 171
examples 92, 173
manually adjust 101, 177

biohazardous waste, handling xix
biological hazard guidelines xxi
biological replicate groups
add to experiment 32, 33, 122
add to study 192

BLFAIL flag 104, 180

C

CAUTION, description xii
chemical safety xvii, xviii
chemical waste safety xix

column
CtMean 95, 164, 198
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ACr Mean 164, 198
AC; SD 164

AC; SE 198

AAC 198

AAC; SD 164

Flag 198

Normalized Qty Mean 95
Normalized Qty Std Err 95
Omit 95, 164, 198

RQ 95, 164, 198

RQ Max 95, 164, 198
RQ Min 95, 164, 198
Sample 95, 164, 198
Target 95, 164, 198

comparative CT example experiment

analyze 156

description 15

design 112, 189, 195

name 114

prepare 138

workflow 17, 18
comparative CT experiments

about 8

compared to relative standard curve experiments 9
comparative CT study

analyze 195

design 189, 190, 192

properties 190

workflow 18, 156
comparative method of calculation 188
Compare Analysis Settings screen 202
compare, analysis settings 202
consumables

Also see materials required 4

supported 4
conventions

safety xii
conventions used in this guide viii
create new

experiment 21, 113

study 189
Ct Mean column 95, 164, 198
CTFAIL flag 104, 180
Custom assays 42, 130
customer feedback, on Applied Biosystems

documents xi

D

DANGER, description xii
data
about data collection 2
example experiment 12, 78, 158
example study 188
publish 174
ACy Mean column 164, 198

ACy SD column 164

AC; SE column 198

AACt column 198

AAC experiment. See comparative C experiment
AAC+ SD column 164

Define Replicates screen 192

design experiment

create new 21, 113

define experiment properties 22, 114

define methods and materials 24, 116

finish Design Wizard 46, 134

for more information 23, 26, 28, 31, 33, 34, 36, 42,
46, 48, 115, 118, 120, 123, 124, 126, 130,
134, 136

guidelines 23, 25, 28, 30, 32, 34, 36, 42, 46, 48,
115,117, 120, 122, 124, 126, 130, 134, 136

order materials 43, 131

review reaction setup 36, 127

set up relative quantitation settings 34, 124

set up run method 35, 125

set up samples 31, 121

set up standards 29

set up targets 26, 119

workflow 20, 112

design study
create new 189
define replicates 192
define study properties 190
for more information 192
guidelines 191, 194

Design Wizard
Experiment Properties screen 22, 114
finish 46, 134
Materials List screen 43, 131
Methods & Materials screen 24, 116
Reaction Setup screen 36, 127
Relative Quantitation Settings screen 34, 124
Run Method screen 35, 125
Samples screen 31, 121
Standards screen 29
Targets screen 26, 119

deviation, standard 91, 172
documentation, related ix

E

electrical safety xx

electromagnetic compatibility standards.
See EMC standards

EMC standards xxii

endogenous control
component of experiment 7, 8
Relative Quantitation Settings screen 34, 124
selecting 28, 120
setting multiple endogenous controls 101, 177
ergonomics, safety xxi
example experiment, run 66, 152
Experiment Properties screen 22, 114
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EXPFAIL flag 104, 180 Amplification Plot screen 72
Export/Import 13, 210 Run Method screen 73
moving and lifting, safety xvi
F moving parts, safety xx
MSDSs

Fast reaction plates, about 6 description xvii

Flag column 198 obtaining xvii
flags ) ) MSDSs, obtaining xi
analysis settings 101, 177 MTP flag 104, 180

in comparative CT experiments 180

in standard curve experiments 104 Multicomponent Plot screen 107, 182, 200

Multiple Plots screen 81, 161, 201

G multiplex PCR 10, 26, 118
Gene Expression Plot screen 93, 162, 196 N
guidelines S
analysis 80, 84, 90, 96, 101, 104, 106, 109, 110, navigation tips
159, 165, 171, 177, 180, 182, 184, 186, 199 display multiple plots 81, 161
chemical safety xviii select wells 80, 160
chemical waste disposal xix negative control, component of experiment 8§
chemical waste safety xix NOAMP flag 104, 180

design 23, 25, 28, 30, 32, 34, 36,42, 46,48, 115, NOISE flag 104, 180

117, 120, 122, 124, 126, 130, 134, 136, Normalized Qty Mean column 95

191, 194 :
preparation 54, 57, 60, 63, 141, 143, 145, 148 Normalized Qty Std Err column 95
run 71 NOSIGNAL flag 104, 180
notification settings 69
H
hazard icons. See safety symbols, on instruments o
hazard symbols. See safety symbols, on instruments OFFSCALE flag 104, 180
hazards. See safety Omit column 95, 164, 198
Help system, accessing xi omit wells 105, 181, 199, 200
High-Capacity cDNA Reverse Transcription Kits 52, online Help. See Help system
140 order materials 43, 131
HIGHSD flag 104, 180 other fluorescent-based reagents 12
OUTLIERRG flag 104, 180
I outliers. See omit wells.
IMPORTANT, description  xii overvoltage category (rating) xx
installation category xx
instrument operation, safety xvi P
Inventoried assays 42, 130 physical hazard safety xx
prepare experiment
L for more information 53, 54, 60, 64, 141, 143, 146,
149
library 36, 126 guidelines 54, 57, 60, 63, 141, 143, 145, 148
load reaction plate 68 reaction mix
prepare 58, 144
M reaction plate 60, 146
sample dilutions 53, 142
Made to Order assays 42, 130 standard dilution series 55
Materials List screen 43, 131 template 51, 139
materials required 51, 54, 55, 58, 61, 139, 142, 144, workflow 50, 138
146 prepare for run 67, 153
Methods & Materials screen 24, 116 print reaction setup instructions 41, 129
monitor run publish data 174
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Q

QC Summary screen 103, 179, 201
QuickStart 13, 206

R

radioactive waste, handling xix
ramp speed 24, 25, 116, 117
Raw Data Plot screen 109, 185

reaction mix
calculated volumes 37, 39, 128
volumes 58, 144

reaction plate
layout 14, 15, 46, 134
load 68
prepare 60, 146
standard versus Fast 6
unload from the instrument 74
Reaction Setup screen 36, 127
reagents
other fluorescent-based 12
SYBR Green 11
TagMan 11

reference sample

component of experiment 7, 8

Relative Quantitation Settings screen 34, 124
Relative Quantitation Settings screen 34, 124

relative standard curve example experiment
analyze 76
description 14
design 20
name 22
prepare 50
workflow 17, 18
relative standard curve experiments
about 7
compared to comparative CT experiments 9

repetitive motion, safety xxi

replicate, component of experiment 7, 8
results, interpreting 77, 157

RQ column 95, 164, 198

RQ Max column 95, 164, 198

RQ Min column 95, 164, 198

run experiment
alerts 74
enable notification settings 69
for more information 74
guidelines 71
monitor 72
prepare for 67, 153
start 71
workflow 66

Run Method library 36, 126
Run Method screen 35, 125

monitor during a run 73 study
about 188
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safety
before operating the instrument xvi
biological hazards xxi
chemical xvii
chemical waste xix
conventions Xii
electrical xx
ergonomic Xxi
guidelines xviii, Xix
instrument operation xvi
moving and lifting instrument xvi
moving parts XX
moving/lifting xvi
physical hazard xx
repetitive motion xxi
standards xxii
workstation xxi
safety labels, on instruments xiv
safety standards xxii
safety symbols, on instruments xiii
Sample column 95, 164, 198
sample dilutions
calculated volumes 40, 53, 129, 142
prepare 53, 142
Sample screen 31, 121
samples
component of experiment 7, 8
design guidelines 32, 122
dilutions 53, 142
prepare template 51, 139
sample reactions (unknowns) 62, 147
setup 31, 121
select wells 80, 160
settings, compare 202
singleplex PCR 10, 26, 118
SPIKE flag 104, 180
standard deviation, effect of threshold on 91, 172
standard dilution series
calculated volumes 38, 39
component of experiment 7
prepare 55
standard reaction plates, about 6
standard vs. fast plates 6
standards
component of experiment 7
design guidelines 30
diluting 55
EMC xxii
safety xxii
setup 29
Set Up Standards check box 26, 28
standard reactions 62

Standards screen 29
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analyze 195 omit 105, 181, 199, 200
create 189 selecting 80, 160
design 189, 190, 192 standard 32, 47, 60, 122, 135, 146
properties 190 unknown 32, 47, 60, 122, 135, 146
workflow 18, 156 workflows
Study Properties screen 190 Advanced Setup 204
SYBR Green reagents 3, 11, 25, 26, 28, 42, 110, 117, example experiment 17, 18
118, 120, 130 Export/Import 13, 210

QuickStart 13, 206
Template 13, 208

T workstation safety xxi

symbols, safety xiii

TaqMan reagents 3, 11, 25, 26, 28, 42, 110, 117, 118,
120, 130
Target column 95, 164, 198

targets
design guidelines 28, 120
setup 26, 119

Targets screen 26, 119
Technical Support, contacting xi
Template 13, 208
template. See samples.
text conventions viii
thermal cycling parameters
for plates added to a study 191
THOLDFAIL flag 104, 180
threshold
correct values 90, 171
examples 91, 172
manually adjust 101, 177
training, information on xi
troubleshooting
adjust baseline 101, 177
adjust threshold 101, 177
flags 104, 180
omit wells 105, 181, 199, 200
view analysis settings 100, 176, 202
view Multicomponent Plot screen 107, 182, 200
view QC Summary screen 103, 179, 201
view Raw Data Plot screen 109, 185

U

unload instrument 74
user attention words, described viii
using this guide

as a tutorial 12

with your own experiments 13

w

WARNING, description xii
waste disposal, guidelines xix
Well Table 93, 162

wells
negative control 32, 47, 60, 122, 135, 146
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